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Product comparison
Table 1-1 Product models
Model

Features

HP Color LaserJet CM6040 MFP

●

100-sheet multipurpose input tray (Tray 1)

●

40 pages per minute (ppm)

●

Two 500-sheet input trays

●

Automatic document feeder (ADF) that holds up to
50 pages

●

HP Jetdirect embedded print server for connecting to a
10/100Base-TX network

●

512 megabytes (MB) of random access memory (RAM)

●

Duplexer

●

Hard drive

●

100-sheet multipurpose input tray (Tray 1)

●

40 ppm

●

Four 500-sheet input trays

●

Automatic document feeder (ADF) that holds up to
50 pages

●

HP Jetdirect embedded print server for connecting to a
10/100Base-TX network

●

512 megabytes (MB) of random access memory (RAM)

●

Duplexer

●

Hard drive

●

Analog fax

●

100-sheet multipurpose input tray (Tray 1)

●

30 ppm

●

Two 500-sheet input trays

●

Automatic document feeder (ADF) that holds up to
50 pages

●

HP Jetdirect embedded print server for connecting to a
10/100Base-TX network

●

512 megabytes (MB) of random access memory (RAM)

●

Duplexer

●

Hard drive

●

100-sheet multipurpose input tray (Tray 1)

●

30 ppm

●

Four 500-sheet input trays

HP Color LaserJet CM6040f MFP

HP Color LaserJet CM6030 MFP

HP Color LaserJet CM6030f MFP
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Table 1-1 Product models (continued)
Model
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Features
●

Automatic document feeder (ADF) that holds up to
50 pages

●

HP Jetdirect embedded print server for connecting to a
10/100Base-TX network

●

512 megabytes (MB) of random access memory (RAM)

●

Duplexer

●

Hard drive

●

Analog fax

Product comparison
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Product features
Table 1-2 Features
Speed and throughput

Resolution

Memory

User interface

Languages and fonts

Print cartridges/image
drums (4 of each)

4
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●

Print up to 40 ppm (HP Color LaserJet CM6040) or 30 ppm (HP Color LaserJet CM6030)
on letter-size paper.

●

Less than 11 seconds to print the first page

●

Recommended maximum monthly print volume of 15,000 pages (HP Color LaserJet
CM6040) or 10,000 pages (HP Color LaserJet CM6030)

●

An 835 megahertz (MHz) microprocessor

●

Duplex at speed

●

600 dots per inch (dpi) with Image Resolution Enhancement technology 4800 for optimum
overall imaging

●

1200 x 600 dpi for detailed line work and small text

●

512 MB of random-access memory (RAM), expandable to 768 MB by using 200pin small outline dual inline memory modules (SODIMM) that support 128 or 256 MB
of RAM.

●

Memory Enhancement technology (MEt) automatically compresses data to use RAM more
efficiently.

●

HP Easy Select Control Panel

●

An embedded Web server to gain access to support and order supplies (for networkconnected products)

●

HP Easy Printer Care software (a Web-based status and troubleshooting tool)

●

Internet-enabled supply-ordering capabilities through HP Easy Printer Care software and
embedded Web server

●

HP Printer Control Language (PCL) 6

●

HP Universal Printer Driver (UPD) PCL 5

●

HP UPD postscript (PS)

●

Printer Management Language

●

80 scalable TrueType PS typefaces

●

Two-part toner/imaging system

●

Black print cartridges print up to 19,500 pages at 5% coverage

●

Color print cartridges print up to 21,000 pages at 5% coverage

●

Image drums print up to 35,000 pages at 5% coverage

●

Authentic HP print cartridge detection

●

Automatic toner strip remover

ENWW

Table 1-2 Features (continued)
Paper-handling

●

Input
◦

Tray 1 (multipurpose tray): A multipurpose tray for paper, transparencies, labels,
envelopes and other paper types. See Supported paper types on page 100 for a list
of paper types. The tray holds up to 100 sheets of paper, 50 transparencies, or
10 envelopes. See Supported paper and print media sizes on page 97.

◦

Tray 2, 3, 4, and 5: 500-sheet trays. These trays automatically detect common paper
sizes and allow printing on custom-size paper. Tray 2 supports up to 279 x 432 mm
(11 x 17 inches) and A3 paper sizes, and Trays 3,4, and 5 support sizes up to 305 x
457 mm (12 x 18 inches), and SRA3. See Supported paper and print media sizes
on page 97 for a list of supported paper sizes. For a list of supported paper types,
see Supported paper types on page 100.

◦

Automatic document feeder (ADF): Holds up to 50 sheets of paper.

◦

ADF duplex scanning: The ADF has an automatic duplexer for scanning two-sided
documents.

◦

Duplex printing: Provides automatic two-sided printing (printing on both sides of the
paper).
The paper size range for automatic duplex printing is 175 mm to 320 mm (6.9 to 12.6
inches) x 210 mm to 457 mm (8.3 to 18 inches). The media weight range is 60–220
g/m² (16-58 lb).

●

Supported operating
systems

Connectivity

ENWW

Output
◦

Standard output bin: The standard output bin is located underneath the scanner on
the top of the product. This bin can hold up to 500 sheets of paper. The product
provides a sensor that indicates when the bin is full.

◦

Optional 3-bin stapler/stacker: Provides job separation in multiple output bins,
convenient stapling (up to 50-sheet jobs), job offset capability, and additional output
capacity. The stacker has three bins: a 100-sheet bin, a 500-sheet bin, and a 1000sheet bin.

◦

Optional booklet maker finisher: Provides convenient stapling (up to 50-sheet jobs),
saddle-stitching (up to 15-sheet booklets), single-sheet v-folding, job separation and
offset capability, as well as additional output capacity. The booklet maker finisher has
three bins: two 1000-sheet bins and one bin that can hold up to 25 saddle-stitched
booklets.

◦

ADF output bin: The ADF output bin is underneath the ADF input tray. The bin holds
up to 50 sheets of paper, and the product automatically stops when this bin is full.

●

Windows 2000®

●

Windows XP®

●

Windows Server 2003®

●

Windows Vista™

●

Macintosh OS

●

Local area network (LAN) connector (RJ-45) for the embedded HP Jetdirect print server

●

One enhanced input/output (EIO) slot

●

USB 2.0 connection

●

Optional analog fax card

●

A Foreign Interface Harness (FIH) connection (AUX) for connecting other devices

●

Optional HP Digital Sending Software (DSS)

Product features

5

Table 1-2 Features (continued)
Environmental features

Security features

Copying and sending
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●

Sleep setting saves energy.

●

High content of recyclable components and materials.

●

Secure Disk Erase

●

Security lock (optional)

●

Job retention

●

User PIN authentication for stored jobs

●

DSS authentication

●

IPv6 security

●

Modes for text, graphics, and mixed text and graphics formats

●

Job-interrupt feature

●

Multiple pages per sheet

●

Control panel animations (for example, jam recovery)

●

Scan and send to e-mail
◦

Local address book for e-mail and fax

◦

LDAP addressing

●

Send to folder

●

Automatic duplex (two-sided) scanning

ENWW

Quick Reference Job Aids
Quick Reference Job Aids provide additional step-by-step procedures for using this product. Access the
Quick Reference Job Aids from the product CD or at www.hp.com/support/cljcm6030mfp or
www.hp.com/support/cljcm6040mfp.
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Quick Reference Job Aids
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Product walkaround
Front view
HP Color LaserJet CM6030 and CM6040 MFP Series

1

2

3

4

10
5
9

6
8

7

1

Control panel

2

Automatic Document Feeder (ADF) top cover

3

ADF input tray for copy/scan/fax originals

4

ADF output bin

5

Right-door (provides access to the transfer unit, transfer roller, and fuser unit)

6

On/Off switch

7

Lower right door

8

HP Color LaserJet CM6030 MFP and HP Color LaserJet CM6040 MFP: Trays 2 and 3
HP Color LaserJet CM6030f MFP and HP Color LaserJet CM6040f MFP: Trays 2, 3, 4 and 5

8

9

Front cover (provides access to print cartridges and image drums)

10

Output bin
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Back view

ENWW

1

Interface ports and formatter

2

Lock lever for additional input bins

Product walkaround
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Interface ports
The product has five ports for connecting to a computer or a network. The ports are at the left, rear
corner of the product.

1
2
3
4
5
6
7
1

Foreign interface harness (FIH)

2

Fax connection (when installed)

3

Scanner cable

4

Access port for Kensington lock

5

USB 2.0 port

6

EIO expansion slot

7

Network port

Serial number and model number location
The model number and serial number are listed on identification labels located on the rear of the printer.
The serial number contains information about the country/region of origin, the printer version, production
code, and the production number of the printer.
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Model name

Model number

HP Color LaserJet CM6030 MFP

CE664A

HP Color LaserJet CM6030f MFP

CE665A

HP Color LaserJet CM6040 MFP

Q3938A

HP Color LaserJet CM6040f MFP

Q3939A

Product walkaround
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Control panel

●

Use the control panel

●

Navigate the Administration menu

●

Information menu

●

Default Job Options menu

●

Time/Scheduling menu

●

Management menu

●

Initial Setup menu

●

Device Behavior menu

●

Print Quality menu

●

Troubleshooting menu

●

Resets menu

●

Service menu
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Use the control panel
The control panel has a VGA touchscreen that provides access to all device functions. Use the buttons
and numeric keypad to control jobs and the device status. The LEDs indicate overall device status.

Control-panel layout
The control panel includes a touchscreen graphical display, job-control buttons, a numeric keypad, and
three light-emitting diode (LED) status lights.

1

2

3

4

10
9

5

8

6

7

14

1

Touchscreen graphical display

Use the touchscreen to open and set up all device functions.

2

Numeric keypad

Allows you to type numeric values for number of copies required and other
numeric values.

3

Reset button

Resets the job settings to factory or user-defined default values.

4

Sleep button

If the device is inactive for a long period of time, it automatically enters a
sleep mode. To place the device into sleep mode or to reactivate the device,
press the Sleep button.

5

Stop button

Stops the active job and opens the Job Status screen.

6

Start button

Begins a copy job, starts digital sending, or continues a job that has been
interrupted.

7

Attention light

The Attention light indicates that the device has a condition that requires
intervention. Examples include an empty paper tray or an error message
on the touchscreen.

8

Ready light

The Ready light indicates that the device is ready to begin processing any
job.

9

Data light

The Data light indicates that the device is receiving data.

10

Contrast-adjustment dial

Turn the dial to adjust the contrast of the touchscreen display for your
viewing angle.

Chapter 2 Control panel

ENWW

Home screen
The home screen provides access to the device features, and it indicates the current status of the device.
NOTE: Depending on how the device has been configured, the features that appear on the home
screen can vary.

2

3 4

5
6

1

9
1

ENWW

Features
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Depending on how the system administrator has configured the device, the features that appear
in this area can include any of the following items:
●

Copy

●

Fax

●

E-mail

●

Secondary E-mail

●

Job Status

●

Network Folder

●

Job Storage

●

Workflow

●

Supplies Status

●

Administration

2

Device status line

The status line provides information about the overall device status. Various buttons appear in
this area, depending on the current status. For a description of each button that can appear in
the status line, see Buttons on the touchscreen on page 16.

3

Copy type

Shows whether copies are color.

4

Copy count

The copy count box indicates the number of copies that the device is set to make.

5

Help button

Touch the Help button to open the embedded help system.

6

Scroll bar

Touch the up or down arrows on the scroll bar to see the complete list of available features.

7

Sign Out

Touch Sign Out to sign out of the device if you have signed in for access to restricted features.
After you sign out, the device restores all options to the default settings.

8

Network Address

Touch Network Address to find information about the network connection.

9

Date and time

The current date and time appear here. The system administrator can select the format that
the device uses to show the date and time, for example 12-hour format or 24-hour format.

Use the control panel
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Buttons on the touchscreen
The status line on the touchscreen provides information about the status of the device. Various buttons
can appear in this area. The following table describes each button.
Home button. Touch the home button to go to the Home screen from any other screen.

Start button. Touch the Start button to begin the action for the feature that you are using.
NOTE: The name of this button changes for each feature. For example, in the Copy feature, the button
is named Start Copy.
Stop button. If the device is processing a print or fax job, the Stop button appears instead of the Start
button. Touch the Stop button to halt the current job. The device prompts you to cancel the job or to resume
it.
Error button. The error button appears whenever the device has an error that requires attention before
it can continue. Touch the error button to see a message that describes the error. The message also has
instructions for solving the problem.
Warning button. The warning button appears when the device has a problem but can continue
functioning. Touch the warning button to see a message that describes the problem. The message also
has instructions for solving the problem.
Help button. Touch the help button to open the built-in online Help system. For more information, see
Control-panel help system on page 16.

Control-panel help system
The device has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help button
in the upper-right corner of the screen.
For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.
For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.
or warning
button to open a message
If the device alerts you of an error or warning, touch the error
that describes the problem. The message also contains instructions to help solve the problem.
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Navigate the Administration menu
From the Home screen, touch Administration to open the menu structure. You might need to scroll to
the bottom of the Home screen to see this feature.
The Administration menu has several sub-menus, which are listed on the left side of the screen. Touch
the name of a menu to expand the structure. A plus sign (+) next to a menu name means that it contains
sub-menus. Continue opening the structure until you reach the option that you want to configure. To
return to the previous level, touch Back.
To exit the Administration menu, touch the Home button

in the upper-left corner of the screen.

The device has built-in Help that explains each of the features that are available through the menus.
Help is available for many menus on the right-hand side of the touchscreen. Or, to open the global Help
system, touch the Help button
in the upper-right corner of the screen.
The tables in the sections that follow indicate the overall structure of each menu under the Administration
menu.

ENWW
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Information menu
Administration > Information
Use this menu to print information pages and reports that are stored internally on the device.
Table 2-1 Information menu
Menu item

Sub-menu item

Configuration/Status
Pages

Fax Reports

Values

Description

Administration Menu
Map

Print

Shows the basic structure of the
Administration menu and current
administration settings.

Configuration/status
Pages

Print

A set of configuration pages that show the
current device settings.

Supplies Status
Page

Print

Shows the status of supplies such as
cartridges, maintenance kits, and staples.

Usage Page

Print

Shows information about the number of
pages that have been printed on each paper
type and size.

Color Usage Job Log

Print

A directory page that contains job-by-job
color usage information. Page content
includes the user name, application name,
and number of black-only pages and color
pages.

File Directory

Print

A directory page that contains information for
any mass-storage devices, such as flash
drives, memory cards, or hard disks, that are
installed in this device.

Fax Activity Log

Print

Contains a list of the faxes that have been
sent from or received by this device.

Print

A detailed report of the last fax operation,
either sent or received.

Fax Call Report

Sub-menu item

Fax Call Report

Thumbnail on Report Yes

Choose whether or not to include a thumbnail
of the first page of the fax on the call report.

No (default)
When to Print Report

Never auto print
Print after any fax job
Print after fax send jobs
Print after any fax error (default)
Print after send errors only
Print after receive errors only

18

Billing Codes Report

Print

A list of billing codes that have been used for
outgoing faxes. This report shows how many
sent faxes were billed to each code.

Blocked Fax List

Print

A list of phone numbers that are blocked from
sending faxes to this device.

Speed Dial List

Print

Shows the speed dials that have been set up
for this device.

Chapter 2 Control panel
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Table 2-1 Information menu (continued)
Menu item

Sub-menu item

Sample Pages/Fonts

ENWW

Sub-menu item

Values

Description

Demonstration Page

Print

Printout of a page highlighting the print
capabilities of the product.

RGB Samples

Print

Printout of color samples for different RGB
values. The samples act as a guide for color
matching.

CMYK Samples

Print

Printout of color samples for different CMYK
values. The samples act as a guide for color
matching.

PCL Font List

Print

A list of printer control language (PCL) fonts
that are currently available on the device.

PS Font List

Print

A list of PostScript (PS) fonts that are
currently available on the device.

Information menu
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Default Job Options menu
Administration > Default Job Options
Use this menu to define the default job options for each function. These are used if the user does not
specify other options when creating the job.

Default Options for Originals
Administration > Default Job Options > Default Options For Originals
Table 2-2 Default Options for Originals menu
Menu item

Values

Description

Paper Size

Select a paper size from the list.

Select the paper size that is most often used for copy or scan
originals.

Number of Sides

1

Select whether copy or scan originals are most often single-sided or
double-sided.

2
Orientation

Portrait
Landscape

Optimize Text/Picture

Manually Adjust
Text
Printed Picture

Select the orientation that is most often used for copy or scan
originals. Select Portrait if the short edge is at the top or select
Landscape if the long edge is at the top.
Optimize the output for a particular type of original: text, pictures, or
a mixture of both.
If you select Manually Adjust, specify the mix of text and pictures that
is used most often.

Photograph
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Image adjustment
Administration > Default Job Options > Image Adjustment
Table 2-3 Image Adjustment menu
Menu item

Values

Description

Darkness

Select a value.

Select the level of density (darkness) for the output.

Background Cleanup

Adjust the value within the range.

Increase the Background Removal setting to remove faint images
from the background or to remove a light background color.

Sharpness

Adjust the value within the range. Adjust the Sharpness setting to clarify or soften the image.

ENWW
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Default Copy Options
Administration > Default Job Options > Default Copy Options
Table 2-4 Default Copy Options menu
Menu item

Sub-menu item

Values

Description

Number of Copies

Type the number of
copies. The factory
default setting is 1.

Set the default number of copies for a copy job.

Number of Sides

1

Set the default number of sides for copies.

2
Color/Black

Auto detect

Choose whether the default copy mode is color or
black.

Color
Black (default)
Staple/Collate

Staple

None (default)

Set up options for stapling and collating sets of copies.

One left angled

If Collate is selected, the device prints a complete copy
before starting on the next copy. Otherwise, the device
prints the first page of all copies before printing the
second page, and so on.

Two left
Two top
One right angled
Two right
Collate

The staple and collate feature may not be present in
your product. These features depend on the optional
output accessory installed.

Off
On (default)

Output Bin

<Binname>

Select the default output bin for copies.
This option is available only if an optional output
accessory is installed.

Edge-To-Edge

Normal (recommended)
(default)
Edge-To-Edge Output

Auto Include Margins

Off (default)

If the original document is printed close to the edges,
use the Edge-To-Edge feature to avoid shadows along
the edges. Combine this feature with the Reduce/
Enlarge feature to ensure that the entire page appears
on the copies.
This feature automatically reduces the image size
during scanning so the margins are included.

On
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Default Fax Options
Administration > Default Job Options > Default Fax Options
Table 2-5 Fax Send menu
Menu item

Sub-menu item

Resolution

Values

Description

Standard (100x200dpi)
(default)

Set the resolution for sent documents. Higher
resolution images have more dots per inch (dpi), so
they show more detail. Lower resolution images have
fewer dots per inch and show less detail, but the file
size is smaller.

Fine (200x200dpi)
Superfine (300x300dpi)
Fax Header

Prepend (default)

Select the position of the fax header on the page.

Overlay

Select Prepend to print the fax header above the fax
content and move the fax content down on the page.
Select Overlay to print the fax header over the top of
the fax contents without moving the contents down.
Using this option could prevent a single-page fax from
flowing onto another page.

Table 2-6 Fax Receive menu
Menu item

Sub-menu item

Values

Description

Fax Forwarding

Fax Forwarding

Off (default)

To forward received faxes to another fax device, select
Fax Forwarding and Custom. Then type the number of
the other fax device into the Fax Forwarding Number
field. When you select this menu item for the first time,
you are prompted to set up a PIN. Type that PIN every
time you use this menu. This is the same PIN that is
used to access the Fax Printing menu.

Custom

Create PIN
Stamp Received Faxes

Enabled
Disabled (default)

Fit to Page

Enabled (default)
Disabled

Add the date, time, senders phone number, and page
number to each page of the faxes that this device
receives.
Shrink faxes that are larger than Letter-size or A4-size
so that they can fit onto a Letter-size or A4-size page.
If it this feature set to Disabled, faxes larger than Letter
or A4 will flow across multiple pages.

Fax Paper Tray

Select from the list of trays.
The default setting is
Automatic.

Select the tray that holds the size and type of paper
that you want to use for incoming faxes.

Output Bin

<Binname>

Select the default output bin, if applicable, to use for
faxes.

ENWW
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Default E-mail Options
Administration > Default Job Options > Default E-mail Options
Menu item

Values

Description

Document File Type

PDF (default)

Select the file format for the e-mail.

JPEG
TIFF
M-TIFF
Output Quality

High (large file)

Selecting higher quality for output increases the size of the
output file.

Medium (default)
Low (small file)
Resolution

300 DPI

Select the resolution. Use a lower setting to create smaller
files.

200 DPI
150 DPI (default)
75 DPI
Color/Black

Color scan (default)

Specify whether the e-mail will be in black or in color.

Black/white scan
TIFF Version

TIFF 6.0 (default)

Specify the TIFF version to use when saving scanned files.

TIFF (Post 6.0)
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Default Send to Folder Options
Administration > Default Job Options > Default Send To Folder Options
Menu item

Values

Description

Color/Black

Color scan

Specify whether the file will be in black or in color.

Black/white scan (default)
Document File Type

PDF (default)

Select the file format for the file.

M-TIFF
TIFF
JPEG
TIFF version

TIFF 6.0 (default)

Specify the TIFF version to use when saving scanned files.

TIFF (post 6.0)
Output Quality

High (large file)

Selecting higher quality for output increases the size of the
output file.

Medium (default)
Low (small file)
Resolution

75 DPI

Select the resolution. Use a lower setting to create smaller
files.

150 DPI (default)
200 DPI
300 DPI
400 DPI
600 DPI

ENWW
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Default Print Options
Administration > Default Job Options > Default Print Options
Table 2-7 Default Print Options menu
Menu item

Values

Description

Copies Per Job

Type a value.

Set the default number of copies for print jobs.

Default Paper Size

(List of supported sizes)

Select a paper size.

Millimeters

Configure the default paper size that is used when the
user selects Custom as the paper size for a print job.

Default Custom Paper
Size

Sub-menu item

Unit of measure

Inches
X Dimension

Configure the width measurement for the Default
Custom Paper Size.

Y Dimension

Configure the height measurement for the Default
Custom Paper Size.

Output Bin

<binname>

Select the default output bin for print jobs. If optional
trays are installed, output bin options vary.

Print Sides

1-sided

Select whether print jobs are single-sided or doublesided by default.

2-sided
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Time/Scheduling menu
Administration > Time/Scheduling
Use this menu to set options for setting the time and for setting the device to enter and exit sleep mode.
NOTE:

Values shown with "(default)" are the factory-default values. Some menu items have no default.

Table 2-8 Time/Scheduling menu
Menu item

Sub-menu item

Date/Time

Date Format

Sub-menu item

Values

Description

YYYY/MMM/DD
(default)

Use this feature to set the current date and
time, and to set the date format and time
format that are used to time-stamp outgoing
faxes.

MMM/DD/YYYY
DD/MMM/YYYY
Date

Month
Day
Year

Time Format

12 hour (AM/PM)
(default)
24 hour

Time

Hour
Minute
AM
PM
1 Minute (default)

Sleep Delay

20 minutes

Use this feature to select the time interval that
the device should remain inactive before
entering Sleep Mode.

30 minutes
45 minutes
1 hour (60 minutes)
90 minutes
2 hours
4 hours
Wake Time

Monday

Off (default)

Tuesday

Custom

Wednesday
Thursday

Select Custom to set a wake time for each
day of the week. The device exits sleep mode
according to this schedule. Using a sleep
schedule helps conserve energy and
prepares the device for use so that users do
not have to wait for it to warm up.

Friday
Saturday
Sunday

ENWW
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Table 2-8 Time/Scheduling menu (continued)
Menu item

Sub-menu item

Sleep Time

Sub-menu item

Values

Description

Monday

Off (default)

Tuesday

Custom

Use this feature to set a sleep time for each
day of the week for periods when the device
will not likely be in use (for example, at a
certain time each evening). Setting a sleep
time makes the device automatically go into
a low-power mode. Select a day and then
select Custom to set up a custom sleep time
schedule.

Wednesday
Thursday
Friday
Saturday
Sunday
FAX Printing
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Create PIN

If you have concerns about the security of
private faxes, use this feature to store faxes
rather than having them automatically print by
creating a printing schedule. When you select
this menu item for the first time, you are
prompted to set up a PIN. Type that PIN every
time you use this menu.
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Management menu
Administration > Management
Use this menu to set up global device-management options.
NOTE:

Values shown with "(default)" are the factory-default values. Some menu items have no default.

Table 2-9 Management menu
Menu item

Sub-menu item

Network Address Button

Display

Values

Description
Use this feature to display the Network Address button
on the Home screen.

Hide (default)
Stored Job Management

Quick Copy Job Storage
Limit

Select the maximum
number of jobs to store

Quick Copy Job Held
Timeout

Off (default)

Use this menu to view and manage any jobs that are
stored on the device.

1 Hour
4 Hours
1 Day
1 Week
Sleep mode

Disable

Use this feature to customize the sleep mode settings
for this device.

Use Sleep Delay (default)
Select Use Sleep Delay to set the device to enter sleep
mode after the delay that is specified in the Time/
Scheduling menu.
Manage Supplies

Replace Supplies

Stop at low
Stop at out (default)
Override at out 1
Override at out 2

This menu sets the product behavior for when a print
cartridge, fuser kit, or transfer kit is low. Choose Stop
at low to stop printing when a supply reaches a low
condition. Choose Stop at out to allow the product to
continue printing until a color print cartridge is empty.
Choose Override at out 1 to allow the product to
continue printing when the cartridges are empty or
when the other supplies are worn out. The product
stops printing when the toner collection units are full.
Using this option could reduce print quality.
Choose Override at out 2 to allow the product to keep
printing when the cartridges are empty; when other
supplies are worn out; and when the waste toner
collection units are full. Using this option can damage
the device.

Supply Low/Order
Threshold

Select a value in the
range. The default is 5%.

Use this menu to carry out administrative supply
management tasks such as changing the threshold
when supplies should be ordered.

Color Supply Out

Stop (default)

This menu sets the product behavior when a color
supply is empty. When Auto-continue black is selected,
the product will continue printing using black toner only.

Auto-continue black

ENWW
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Table 2-9 Management menu (continued)
Menu item

Sub-menu item

Values

Description

Restrict Color Use

Color printing access

Enable Color (default)

This item allows the administrator to disable or restrict
color printing. To use the Color If Allowed setting, set
up user permissions and/or application permissions in
the embedded Web server, HP Easy Printer Care
software, or Web Jetadmin.

Color If Allowed
Disable Color
Color copying access

Enable Color (default)

This item allows the administrator to disable or restrict
color copying.

Disable Color
Color/Black Mix

Automatic (default)
Mostly color pages
Mostly black pages

This item controls how the engine switches from color
mode to monochrome mode for maximum
performance and print cartridge life.
Choose Automatic to reset the product to the factory
default setting.
Choose Mostly color pages if nearly all of your print
jobs are color with high page coverage.
Choose Mostly black pages if you print mostly
monochrome jobs or a combination of color and
monochrome jobs.
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Initial Setup menu
Administration > Initial Setup
NOTE:

Values shown with "(default)" are the factory-default values. Some menu items have no default.

Networking and I/O
Administration > Initial Setup > Networking and I/O
Table 2-10 Networking and I/O
Menu item

Sub-menu item

I/O Timeout

Embedded Jetdirect

Values

Description

Select a value in the
I/O timeout refers to the elapsed time before a print job
range. The factory default fails. If the stream of data that the device receives for
setting is 15 seconds.
a print job gets interrupted, this setting indicates how
long the device will wait before it reports that the job
has failed.
See Table 2-11 Jetdirect menus on page 31 for the list of options.

Table 2-11 Jetdirect menus
Menu item

Sub-menu item

TCP/IP

Enable

Sub-menu item

Values and Description
Off: Disable the TCP/IP protocol.
On (default): Enable the TCP/IP protocol.

Host Name

IPV4 Settings

An alphanumeric string, up to 32 characters, used to
identify the device. This name is listed on the
HP Jetdirect configuration page. The default host name
is NPIxxxxxx, where xxxxxx is the last six digits of the
LAN hardware (MAC) address.
Config Method

Specifies the method that TCP/IPv4 parameters will be
configured on the HP Jetdirect print server.
Bootp: Use BootP (Bootstrap Protocol) for automatic
configuration from a BootP server.
DHCP: Use DHCP (Dynamic Host Configuration
Protocol) for automatic configuration from a DHCPv4
server. If selected and a DHCP lease exists, DHCP
Release and DHCP Renew menus are available to set
DHCP lease options.
Auto IP: Use automatic link-local IPv4 addressing. An
address in the form 169.254.x.x is assigned
automatically.
Manual: Use the Manual Settings menu to configure
TCP/IPv4 parameters.

Default IP

Specify the IP address to default to when the print
server is unable to obtain an IP address from the
network during a forced TCP/IP reconfiguration (for
example, when manually configured to use BootP or
DHCP).
Auto IP: A link-local IP address 169.254.x.x is set.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Values and Description
Legacy: The address 192.0.0.192 is set, consistent
with older HP Jetdirect devices.

DHCP Release

This menu appears if Config Method was set to
DHCP and a DHCP lease for the print server exists.
No (default): The current DHCP lease is saved.
Yes: The current DHCP lease and the leased IP
address are released.

DHCP Renew

This menu appears if Config Method was set to
DHCP and a DHCP lease for the print server exists.
No (default): The print server does not request to renew
the DHCP lease.
Yes: The print server requests to renew the current
DHCP lease.

IPV6 Settings

Primary DNS

Specify the IP address (n.n.n.n) of a Primary DNS
Server.

Secondary DNS

Specify the IP address (n.n.n.n) of a Secondary
Domain Name System (DNS) Server.

Enable

Use this item to enable or disable IPv6 operation on the
print server.
Off: IPv6 is disabled.
On (default): IPv6 is enabled.

Address

Manual Settings: Use this item to manually set IPv6
addresses on the print server.
Enable: Select this item and choose On to enable
manual configuration, or Off to disable manual
configuration.
Address: Use this item to type a 32 hexadecimal digit
IPv6 node address that uses the colon hexadecimal
syntax.

DHCPV6 Policy

Router Specified: The stateful auto-configuration
method to be used by the print server is determined by
a router. The router specifies whether the print server
obtains its address, its configuration information, or
both from a DHCPv6 server.
Router Unavailable: If a router is not available, the print
server should attempt to obtain its stateful
configuration from a DHCPv6 server.
Always: Whether or not a router is available, the print
server always attempts to obtain its stateful
configuration from a DHCPv6 server.
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Primary DNS

Use this item to specify an IPv6 address for a primary
DNS server that the print server should use.

Secondary DNS

Use this item to specify an IPv6 address for a
secondary DNS server that the print server should use.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item
Proxy Server

Sub-menu item

Values and Description
Specifies the proxy server to be used by embedded
applications in the device. A proxy server is typically
used by network clients for Internet access. It caches
Web pages, and provides a degree of Internet security,
for those clients.
To specify a proxy server, enter its IPv4 address or
fully-qualified domain name. The name can be up to
255 octets.
For some networks, you may need to contact your
Independent Service Provider (ISP) for the proxy
server address.

IPX/SPX

Proxy Port

Type the port number used by the proxy server for
client support. The port number identifies the port
reserved for proxy activity on your network, and can be
a value from 0 to 65535.

Enable

Off: Disable the IPX/SPX protocol.
On (default): Enable the IPX/SPX protocol.

Frame Type

Selects the frame-type setting for your network.
Auto: Automatically sets and limits the frame type to
the first one detected.
EN_8023, EN_II, EN_8022, and EN_SNAP: Frametype selections for Ethernet networks.

AppleTalk

Enable

Off: Disable the AppleTalk protocol.
On (default): Enable the AppleTalk protocol.

DLC/LLC

Enable

Off: Disable the DLC/LLC protocol.
On (default): Enable the DLC/LLC protocol.

ENWW
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Security

Print Sec Page

Sub-menu item

Values and Description
Yes (default): Prints a page that contains the current
security settings on the HP Jetdirect print server.
No: A security settings page is not printed.

Secure Web

For configuration management, specify whether the
embedded Web server will accept communications
using HTTPS (Secure HTTP) only, or both HTTP and
HTTPS.
HTTPS Required (default): For secure, encrypted
communications, only HTTPS access is accepted. The
print server will appear as a secure site.
HTTP/HTTPS optional: Access using either HTTP or
HTTPS is permitted.

IPSEC

Specify the Firewall status on the print server.
Keep: Firewall status remains the same as currently
configured.
Disable: Firewall operation on the print server is
disabled.

Reset Security

Specify whether the current security settings on the
print server will be saved or reset to factory defaults.
No: The current security settings are maintained.
Yes: Security settings are reset to factory defaults.

Diagnostics

Embedded Tests

This menu provides tests to help diagnose network
hardware or TCP/IP network connection problems.
Embedded tests help to identify whether a network fault
is internal or external to the device. Use an embedded
test to check hardware and communication paths on
the print server. After you select and enable a test and
set the execution time, you must select Execute to
initiate the test.
Depending on the execution time, a selected test runs
continuously until either the device is turned off, or an
error occurs and a diagnostic page is printed.
LAN HW Test

CAUTION: Running this embedded test will erase
your TCP/IP configuration.
This test performs an internal loopback test. An internal
loopback test will send and receive packets only on the
internal network hardware. There are no external
transmissions on your network.
Select Yes to choose this test, or No to not choose it.

HTTP Test

This test checks operation of HTTP by retrieving
predefined pages from the device, and tests the
embedded Web server.
Select Yes to choose this test, or No to not choose it.

SNMP Test
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This test checks operation of SNMP communications
by accessing predefined SNMP objects on the device.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Values and Description
Select Yes to choose this test, or No to not choose it.

Data Path Test

This test helps to identify data path and corruption
problems on an HP postscript level 3 emulation device.
It sends a predefined PS file to the device, However,
the test is paperless; the file will not print.
Select Yes to choose this test, or No to not choose it.

Select All Tests

Use this item to select all available embedded tests.
Select Yes to choose all tests. Select No to select
individual tests.

Execution Time [H]

Use this item to specify the length of time (in hours) that
an embedded test will be run. You can select a value
from 1 to 60 hours. If you select zero (0), the test runs
indefinitely until an error occurs or device is turned off.
Data gathered from the HTTP, SNMP, and Data Path
tests is printed after the tests have completed.

Execute

No: Do not initiate the selected tests.
Yes: Initiate the selected tests.

Ping Test

ENWW

This test is used to check network communications.
This test sends link-level packets to a remote network
host, then waits for an appropriate response. To run a
ping test, set the following items:
Dest Type

Specify whether the target device is an IPv4 or IPv6
node.

Dest IPv4

Type the IPv4 address.

Dest IPv6

Type the IPv6 address.

Packet Size

Specify the size of each packet, in bytes, to be sent to
the remote host. The minimum is 64 (default) and the
maximum is 2048.

Timeout

Specify the length of time, in seconds, to wait for a
response from the remote host. The default is 1 and
the maximum is 100.

Count

Specify the number of ping test packets to send for this
test. Select a value from 1 to 100. To configure the test
to run continuously, select 0.

Print Results

If the ping test was not set for continuous operation,
you can choose to print the test results. Select Yes to
print results. If you select No (default), results are not
printed.

Execute

Specify whether to initiate the ping test. Select Yes to
initiate the test, or No to not run the test.

Initial Setup menu
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Ping Results

Link Speed

Values and Description
Use this item to view the ping test status and results
using the control panel display. You can select the
following items:

Packets Sent

Shows the number of packets (0 - 65535) sent to the
remote host since the most recent test was initiated or
completed.

Packets Received

Shows the number of packets (0 - 65535) received from
the remote host since the most recent test was initiated
or completed.

Percent Lost

Shows the percent of ping test packets that were sent
with no response from the remote host since the most
recent test was initiated or completed.

RTT Min

Shows the minimum detected roundtrip- time (RTT),
from 0 to 4096 milliseconds, for packet transmission
and response.

RTT Max

Shows the maximum detected roundtrip- time (RTT),
from 0 to 4096 milliseconds, for packet transmission
and response.

RTT Average

Shows the average round-trip-time (RTT), from 0 to
4096 milliseconds, for packet transmission and
response.

Ping In Progress

Shows whether a ping test is in progress. Yes indicates
a test in progress, and No indicates that a test
completed or was not run.

Refresh

When viewing the ping test results, this item updates
the ping test data with current results. Select Yes to
update the data, or No to maintain the existing data.
However, a refresh automatically occurs when the
menu times out or you manually return to the main
menu.
The link speed and communication mode of the print
server must match the network. The available settings
depend on the device and installed print server. Select
one of the following link configuration settings:
CAUTION: If you change the link setting, network
communications with the print server and network
device might be lost.
Auto (default): The print server uses auto-negotiation
to configure itself with the highest link speed and
communication mode allowed. If auto-negotiation fails,
either 100TX HALF or 10TX HALF is set depending on
the detected link speed of the hub/switch port. (A
1000T half-duplex selection is not supported.)
10T Half: 10 Mbps, half-duplex operation.
10T Full: 10 Mbps, Full-duplex operation.
100TX Half: 100 Mbps, half-duplex operation.
100TX Full: 100 Mbps, full-duplex operation.
100TX Auto: Limits auto-negotiation to a maximum link
speed of 100 Mbps.
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Table 2-11 Jetdirect menus (continued)
Menu item

Sub-menu item

Sub-menu item

Values and Description
1000TX Full: 1000 Mbps, full-duplex operation.

Print Protocols
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Use this item to print a page that lists the configuration
of the following protocols: IPX/SPX, Novell NetWare,
AppleTalk, DLC/LLC.
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Fax Setup
Administration > Initial Setup > Fax Setup
Table 2-12 Fax Setup menu
Menu item

Sub-menu item

Required Settings

Country/Region
Date/Time

Sub-menu item

Values

Description

(Countries/regions
listed)

Configure the settings that are legally
required for outgoing faxes.

Disabled

Use this feature to enable or disable PC Fax
Send. PC Fax Send enables users to send
faxes through the device from their
computers if they have the Send Fax driver
installed on their PC.

Date Format
Date
Time Format
Time

Fax Header
Information

Phone Number
Company Name

PC Fax Send

Enabled (default)
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Table 2-12 Fax Setup menu (continued)
Menu item

Sub-menu item

Fax Send Settings

Fax Dial Volume

Sub-menu item

Values

Description

Off

Use this feature to set the volume of the tones
that you hear while the device dials the fax
number.

Low (default)
High
Error Correction
Mode

Enabled (default)
Disabled

JBIG Compression

Enabled (default)
Disabled

When Error Correction Mode is enabled and
an error occurs during fax transmission, the
device sends or receives the error portion
again.
JBIG compression reduces fax-transmission
time, which can result in lower phone
charges. However, using JBIG compression
sometimes causes compatibility problems
with older fax machines. If this occurs, turn off
JBIG compression.

Maximum Baud Rate

Select a value from
Use this feature to set the maximum baud
the list. The default is rate for receiving faxes. This can be used as
33.6K.
a diagnostic tool for troubleshooting fax
problems.

TCF T.30 Delay
Timer

Default (default)
Custom

TCF Extend

Default (default)
Custom

Dialing Mode

Tone (default)

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.
This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.
Select whether the device should use tone or
pulse dialing.

Pulse
Redial On Busy

The range is between
0 and 9. The factory
default is 3 times.

Type the number of times the device should
attempt to redial if the line is busy.

Redial On No Answer

Never (default)

Use this feature to specify the number of
times the device should attempt to dial if the
recipient fax number does not answer.

Once
Twice
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NOTE: Twice is available in locations other
than the United States and Canada.
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Table 2-12 Fax Setup menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

Redial Interval

The range is between
1 and 5 minutes. The
factory default is 5
minutes.

Use this feature to specify the number of
minutes between dialing attempts if the
recipient number is busy or not answering.

Detect Dial Tone

Enabled

Use this feature to specify whether the device
should check for a dial tone before sending a
fax.

Disabled (default)
Dialing Prefix

Off (default)
Custom

Billing Codes

Off (default)
Custom

Use this feature to specify a prefix number
that must be dialed when sending faxes from
the device.
When billing codes are enabled, a prompt
appears that asks the user to enter the billing
code for an outgoing fax.
The range is between 1 and 16 digits. The
default is 1 digit.

Fax Receive Settings

Rings To Answer

The range varies by
location. The factory
default is 2 rings.

Use this feature to specify the number of rings
that must occur before the fax modem
answers.

Ring Interval

Default (default)

This setting is used to adjust for some PBX
ring signals. Change this setting only when
directed by an HP technical support agent.

Custom
Ring Frequency

Default (default)

Ringer Volume

Custom

This setting should be left at the default value
and only changed when directed by an HP
technical support agent. Adjustment
procedures associated with this setting are
beyond the scope of this guide.

Off

Set the volume for the fax ring-tone.

Low (default)
High
Blocked Fax
Numbers

Add Blocked
Numbers

Type the fax number
to add.

Remove Blocked
Numbers

Select a fax number
to remove.

Clear All Blocked
Numbers

No (default)

Use this feature to add or delete numbers
from the blocked fax list. The blocked fax list
can contain up to 30 numbers. When the
device receives a call from one of the blocked
fax numbers, it deletes the incoming fax. It
also logs the blocked fax in the activity log
along with job-accounting information.

Yes
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E-mail Setup
Administration > Initial Setup > E-mail Setup
Use this menu to enable the e-mail feature and to configure basic e-mail settings.
NOTE: To configure advanced e-mail settings, use the embedded Web server. For more information,
see Embedded Web server on page 183.
Table 2-13 E-mail Setup menu
Menu item

Values

Description

Address Validation

On (default)

This option enables the device to check e-mail syntax when you type
an e-mail address. Valid e-mail addresses require the "@" sign and
a ".".

Off
Find Send Gateways
SMTP Gateway

Search the network for SMTP gateways that the device can use to
send e-mail.
Enter a value.

Test Send Gateway

Specify the IP address of the SMTP gateway that is used to send email from the device.
Test the configured SMTP gateway to see if it is functional.

Send Setup menu
Administration > Initial Setup > Send Setup
Table 2-14 Send Setup menu
Menu item

Values

Description

Fax Number Confirmation

Disable (default)

When fax number confirmation is enabled, you are prompted to enter
the fax number twice to verify that it has been typed correctly.

Enable
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Device Behavior menu
Administration > Device Behavior
Table 2-15 Device Behavior menu
Menu item

Sub-menu item

Sub-menu item

Values

Description

Language

Select the language
from the list.

Select a different language for control-panel
messages. When you select a new language,
the keyboard layout might also change.

Key Press Sound

On (default)

Use this feature to specify whether you hear
a sound when you touch the screen or press
buttons on the control panel.

Off
Inactivity Timeout

Warning/Error
Behavior

Clearable Warnings

Type a value
between 10 and 300
seconds. The factory
default is 60
seconds.

Specify the amount of time that elapses
between any activity on the control panel and
the device resetting to the default settings.

On

Set the amount of time that a clearable
warning appears on the control panel.

Job (default)
Continuable Events

Auto continue (10
seconds) (default)

Configure the device behavior when the
device encounters certain errors.

Touch OK to
continue
Jam Recovery

Auto (default)

Configure how the device handles pages that
are lost during a jam.

Off
On
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

Tray Behavior

Use Requested Tray

Sub-menu item

Values

Description

Exclusively (default)

Control how the device handles jobs that
have specified a specific input tray.

First
Manually Feed
Prompt

Always (default)
Unless Loaded

PS Defer Media

Enabled (default)

Specify how a prompt should appear when
the type or size for a job does not match the
specified tray and the device pulls from the
multipurpose tray instead.
Select either the PostScript (PS) or HP
paper-handling model.

Disabled
Use Another Tray

Enabled (default)
Disabled

Size/Type Prompt

Display (default)
Do not display

Duplex Blank Pages

Auto (default)

Turn on or off the control-panel prompt to
select another tray when the specified tray is
empty.
Control whether the tray configuration
message appears whenever a tray is opened
or closed.
Control how the device handles two-sided
jobs (duplexing).

Yes
Image Rotation

Left to Right
Right to Left
Alternate

Image rotation allows users to put paper in
the input tray using the same orientation
regardless of whether there is a finisher
installed.
NOTE: The image rotation set in this menu
will be applied any time a job does not
request stapling or when the requested
stapling could not be applied because of
unsupported media or when the stapler is
unavailable.
Select Left to Right to rotate the image as if it
were going to be bound on the left. This
setting is appropriate for print jobs where
reading from left to right is the cultural norm.
This is the default setting.
Select Right to Left to rotate the image as if it
were going to be bound on the right. This
setting is usually appropriate for print jobs
where reading from right to left is the cultural
norm.
Select Alternate to use a different loading
orientation that might work better with
preprinted forms that are used on legacy
products.

Multifunc Finisher

Operation Mode

Mailbox

or

Stacker

MBM-3 Bin Stapler

Function Separator

ENWW

This menu appears when the HP 3-bin
Stapler/Stacker Accessory or the HP Booklet
Maker/Finisher Accessory is attached.
Allows you to set the default operation mode.
Mailbox assigns a user or group of users to
each output bin. Stacker treats all of the
output bins as a single large bin. When one
bin gets full, jobs are automatically routed to
the next bin. Function Separator specifies a
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description
default bin for specific types of jobs such as
faxes or copies (stapler/stacker only).

Staples

None
One Left Angled

Sets the default staple selection for
documents sent to the device when no staple
value is specified.

One Right Angled
Two Left
Two Right
Two Top
Staples Out

Stop
Continue

Offset

Off
On

A4/Letter Staple

Normal
Alternate 1
Alternate 2

Sets the default behavior when a job
specifies stapling and the stapler is out of
staples. Stop stops printing if the stapler runs
out of staples. Continue allows a job to
continue printing even when the device is out
of staples.
Turns the job offset feature on or off. When
job offset is on, each copy of a job is shifted
to one side in the output bin in order to keep
each copy separate from the others.
Controls the speed of the print engine to
prevent paper jams by using the stapler
buffer.
NOTE: The stapler buffer may or may not
be used depending on the selected media
type or on the sensed media type, if
Autosense Mode is enabled.
If the Normal setting is enabled, the engine
speed will be normal by using the stapler
buffer whenever possible.
If the Alternate 1 setting is enabled, and the
engine is in Autosense Mode, the engine
slows down to prevent jams. If the product is
NOT in Autosense Mode, the engine
performs at normal speed, using the stapler
buffer whenever possible.
If the Alternate 2 setting is enabled, the
engine always slows down to prevent jams,
never using the stapler buffer.

Fold LTR-R & A4 - R

–4.0 mm

Adjusts the fold line for Letter and A4 size
paper (booklet maker only).

–3.5 mm
–3.0 mm
–2.5 mm
–2.0 mm
–1.5 mm
–1.0 mm
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

–0.5 mm
0.0 mm
0.5 mm
1.0 mm
1.5 mm
2.0 mm
2.5 mm
3.0 mm
3.5 mm
4.0 mm
Fold Legal & JISB4

–4.0 mm

Adjusts the fold line for Legal and JIS B4 size
paper (booklet maker only).

–3.5 mm
–3.0 mm
–2.5 mm
–2.0 mm
–1.5 mm
–1.0 mm
–0.5 mm
0.0 mm
0.5 mm
1.0 mm
1.5 mm
2.0 mm
2.5 mm
3.0 mm
3.5 mm
4.0 mm
Fold 11X17 & A3

–4.0 mm

Adjusts the fold line for Legal and 11x17 and
A3 size paper (booklet maker only).

–3.5 mm
–3.0 mm
–2.5 mm
–2.0 mm
–1.5 mm
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

–1.0 mm
–0.5 mm
0.0 mm
0.5 mm
1.0 mm
1.5 mm
2.0 mm
2.5 mm
3.0 mm
3.5 mm
4.0 mm
General Copy
Behavior

Scan Ahead

Enabled (default)
Disabled

Auto Print Interrupt

Enabled
Disabled (default)

Turn on no-wait scanning. With Scan Ahead
enabled, the pages in the original document
are scanned to disk and held until the device
becomes available.
When this feature is enabled, copy jobs can
interrupt print jobs that are set to print multiple
copies.
The copy job is inserted into the print queue
at the end of one copy of the print job. After
the copy job is complete, the device
continues printing the remaining copies of the
print job.

Copy Interrupt

Enabled
Disabled (default)

Alternative
Letterhead Mode

Off (default)
On

46

Chapter 2 Control panel

When this feature is enabled, a copy job that
is currently printing can be interrupted when
a new copy job is started. You are prompted
to confirm that you want to interrupt the
current job.
This option allows loading of letterhead or
preprinted paper the same way for all copy
jobs, whether copying to one side of the
paper or to both sides of the paper.
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

General Printing
Behavior

Override A4/Letter

Sub-menu item

Values

Description

No

When this feature is enabled, the job prints
on letter-size paper when an A4 job is sent
but no A4-size paper is loaded in the device
(or prints on A4 paper when a letter-size job
is sent but no letter-size paper is loaded).
This option also overrides A3 with ledger-size
paper and ledger with A3-size paper.

Yes (default)

Manual Feed

Enabled
Disabled (default)

Courier Font

Regular (default)

When this feature is enabled, the user can
select manual feed from the control panel as
the paper source for a job.
Select which version of the Courier font you
want to use.

Dark
Wide A4

Enabled
Disabled (default)

Print PS Errors

Enabled
Disabled (default)

Print PDF Errors

Enabled

Change the printable area of A4-size paper.
If you enable this option, eighty 10-pitch
characters can be printed on a single line of
A4 paper.
Select whether a PostScript (PS) error page
is printed when the device encounters a PS
error.
Select whether a PDF error page is printed
when the device encounters a PDF error.

Disabled (default)
Personality

Auto (default)

Select the printer language that the device
should use.

PCL
PDF
PS
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Normally, you should not change the
language. If you change the setting to a
specific language, the device does not
automatically switch from one language to
another unless specific software commands
are sent to the device.
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Table 2-15 Device Behavior menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

PCL

Form Length

Type a value
between 5 and 128
lines. The factory
default is 60 lines.

PCL is a set of printer commands that
Hewlett-Packard developed to provide
access to printer features.

Orientation

Portrait (default)
Landscape

Select the orientation that is most often used
for print jobs. Select Portrait if the short edge
is at the top or Landscape if the long edge is
at the top.

Font Source

Select the source
from the list.

Select the font source for the user-soft default
font.

Font Number

Type the font
number. The range
is between 0 and
999. The factory
default is 0.

Specify the font number for the user soft
default font by using the source that is
specified in the Font Source menu item. The
device assigns a number to each font and
lists it on the PCL font list (available from the
Administration menu).

Font Pitch

Type a value
between 0.44 and
99.99. The factory
default is 10.00.

If Font Source and Font Number indicate a
contour font, use this feature to select a
default pitch (for a fixed-spaced font).

Symbol Set

PC-8 (default)

Select any one of several available symbol
sets from the control panel. A symbol set is a
unique grouping of all the characters in a font.

(50 additional
symbol sets from
which to choose)
Append CR to LF

No (default)
Yes

Suppress Blank
Pages

No (default)
Yes

Media Source
Mapping

Standard (default)
Classic
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Configure whether a carriage return (CR) is
appended to each line feed (LF) encountered
in backwards-compatible PCL jobs (pure
text, no job control).
This option is for users who are generating
their own PCL, which could include extra
form feeds that cause blank pages to be
printed. When Yes is selected, form feeds are
ignored if the page is blank.
Select and maintain input trays by number
when you are not using the device driver, or
when the software program has no option for
tray selection.
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Print Quality menu
Administration > Print Quality
Table 2-16 Print Quality menu
Menu item

Sub-menu item

Values

Description

Adjust Color

Highlights

Cyan Density. Magenta
Density. Yellow Density.
Black Density

Adjust the darkness or lightness of highlights on a
printed page. Lower values represent lighter highlights
on a printed page, and higher values represent darker
highlights on a printed page.

+5 to –5. Default is 0.
Midtones

Cyan Density. Magenta
Density. Yellow Density.
Black Density

Adjust the darkness or lightness of midtones on a
printed page. Lower values represent lighter midtones
on a printed page, and higher values represent darker
midtones on a printed page.

+5 to –5. Default is 0.
Shadows

Cyan Density. Magenta
Density. Yellow Density.
Black Density

Adjust the darkness or lightness of shadows on a
printed page. Lower values represent lighter shadows
on a printed page, and higher values represent darker
shadows on a printed page.

+5 to –5. Default is 0.
Restore Color Values
Set Registration

Test Page

Sets all the density values back to the factory default
settings.
Print

Shift the margin alignment to center the image on the
page from top to bottom and from left to right. You can
also align the image on the front with the image printed
on the back.
Print a test page for setting the registration.

Source

All trays

Select the source input tray for printing the Set
Registration page.

Tray <X>: <contents>
(choose a tray)
Adjust Tray <X>

Shift from -20 to 20 along
the X or Y axes. 0 is the
default.
X1 Shift
X2 Shift
Y Shift

Print Modes

ENWW

<Paper Type>

Perform the alignment procedure for each tray.
When it creates an image, the device scans across the
page from side to side as the sheet feeds from top to
bottom into the device.
The scan direction is referred to as X. X1 is the scan
direction for the first side of a 2-sided page. X2 is the
scan direction for the second side of a 2-sided page.
The feed direction is referred to as Y.
Configure which mode is associated with which paper
type.

Print Quality menu
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Table 2-16 Print Quality menu (continued)
Menu item

Sub-menu item

Values

Description

Auto Sense Mode

Tray 1 sensing

Full Sensing (default for
Tray 1)

When Full Sensing is selected, the product recognizes
light, plain, heavy, glossy, and tough paper and
overhead transparencies. When Expanded Sensing is
selected, the device recognizes normal paper,
overhead transparencies, glossy paper, and tough
paper. When Transparency Only is selected, the device
recognizes only overhead transparency and nonoverhead transparency types.

Expanded Sensing
(default for Trays 2-5)
Transparency Only

Tray 2-5 Sensing

Expanded Sensing
Transparency Only
(default)

Optimize

Paper Curl

Normal
Reduced

Pre-rotation

Off (default)
On

Fuser Temp

Normal (default)
Alternate 1
Alternate 2
Alternate 3

Tray 1

Normal (default)
Alternate

Gloss Mode

Normal (default)
High
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When Expanded Sensing is selected, the device
recognizes normal paper, overhead transparencies,
glossy paper, and tough paper. When Transparency
Only is selected, the device recognizes only overhead
transparency and non-overhead transparency types.
To help reduce paper curl, set this option to Reduced.
This decreases full speed to 10 PPM (instead of 40
ppm) and 3/4 speed to 7.5 ppm (instead of 30 ppm).
Turn this feature On if horizontal streaks appear on
pages. Using this feature increases the warm-up time
for the device.
If you are seeing a faint image of the page repeated at
the bottom of the page or on the following page, you
should first make sure the Paper Type and Print Mode
settings are correct for the type of paper you are using.
If you continue to see ghost images on your print jobs,
set the Fuser Temp feature to one of the Alternate
settings . Try the Alternate 1 setting first and see if it
solves the problem. If you continue to see the problem,
try Alternate 2 and then Alternate 3. With the Alternate
2 and Alternate 3 settings you may see an extra delay
between jobs.
If you are seeing marks on the back side of the paper
when printing from Tray 1, set the mode to Alternate.
This increases the frequency of the cleaning cycle.
Chosen when stable high gloss is required. Set this
feature to High for glossy print jobs, such as photos, if
you notice the gloss finish decreasing after the first
page is printed. This setting reduces the performance
for all paper types.
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Table 2-16 Print Quality menu (continued)
Menu item

Sub-menu item

Values

Description

Light Media

Auto (default)

Prevents the fuser from wrapping with light paper. Set
this feature to On if you are frequently seeing Fuser
Delay Jam or Fuser Wrap Jam messages, especially
when printing on lightweight paper or on jobs with
heavy toner coverage.

On

Environment

Normal (default)
Low Temp

Line Voltage

Normal (default)
100V

Cleaning frequency

Normal (default)
Alternate

D-Blade bias

Normal (default)
Alternate

Waste Bin

Normal (default)
Alternate

Discharge Brush

Off (default)
On

Background

Off (default)
On

Heavy Mode

30 PPM (default)
24 PPM

Tracking Control

Off (default)

Optimizes performance in extreme low temperature
environments. Set this feature to Low Temp if the
product is operating in a low-temperature environment
and you are having problems with print quality such as
blisters in the printed image.
Optimizes performance in low-voltage conditions. Set
this feature to 100V if the product is operating in a lowvoltage environment and you are having problems with
print quality such as blisters in the printed image.
Set this feature to Alternate if you are seeing defects in
the printed output that repeat at 38 mm (1.5 inch)
intervals. This feature increases the frequency at which
the C roller is cleaned. Setting this feature to
Alternate might also reduce printing speed and
increase the frequency of consumable replacement.
Set this feature to Alternate if you are seeing short white
vertical lines in the printed output. The Alternate setting
might also cause dark spots in the printed output, so be
sure to test this setting on a few print jobs.
Try setting this feature to Alternate if you are seeing
lengthwise toner streaks in your printed output,
especially in jobs with low toner coverage.
Enable this feature in low temperature and low humidity
environments if you are seeing specks of toner
scattered on double-sided jobs using light-weight paper
and longer than ten pages.
Turn this feature On if pages are printing with a shaded
background. Using this feature might reduce gloss
levels.
The default setting is 30 PPM. Select the 24 PPM option
to reduce the speed and improve fusing on heavy
paper.
Improves color stability by adjusting the bias voltage.
This setting should remain On.

On

Resolution

Restore Optimize

Select this setting to return all the settings in the
Optimize menu to the factory default settings.

Image REt 4800

Select Image REt 4800 to produces fast, high-quality
printing that is appropriate for most print jobs

1200X600dpi
Select 1200X600dpi to produce the highest-quality
printing available, but it may slow print speed. This
setting may be useful for jobs that contain very thin lines
or fine graphics.
Color REt

Enabled (default)
Disabled
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Enable or disable Resolution Enhancement technology
(REt), which produces print output with smooth angles,
curves, and edges.

Print Quality menu
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Table 2-16 Print Quality menu (continued)
Menu item

Sub-menu item

Values

Description

Process Cleaning Page

Process

Use this feature to create and process a cleaning page
for cleaning excess toner off the pressure roller in the
fuser. The process takes up to 2.5 minutes.

Quick Calibration

Calibrate

Performs partial product calibrations.

Full Calibration

Calibrate

Performs all product calibrations.

Delay Calibration At
Wake/Power On

No

This menu controls the timing of the calibration when
the printer wakes up or is turned on.

Calibration/Cleaning

Yes (default)
●

Select No to have the printer calibrate immediately
when it wakes up or is turned on. The device will
not print any jobs until it finishes calibrating.

●

Select Yes to enable a device that is asleep to
accept print jobs before it calibrates. The device
only accepts new jobs for a short time. It may start
calibrating before it has printed all the jobs it has
received.

NOTE: For the best results, allow the device to
calibrate before printing. Print jobs performed before
calibration may not be of the highest quality.
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Troubleshooting menu
Administration > Troubleshooting
NOTE: Many of the menu items under the Troubleshooting menu are for advanced troubleshooting
purposes.
Table 2-17 Troubleshooting menu
Menu item

Sub-menu item

Sub-menu item

Values

Description

Event Log

Print

This shows the event codes and their
corresponding engine cycles on the controlpanel display.

Calibrate Scanner

Calibrate

Use this feature to compensate for offsets in
the scanner imaging system (carriage head)
for ADF and flatbed scans.
You might need to calibrate the scanner if it
is not capturing the correct sections of
scanned documents.

PQ Troubleshooting
Fax T.30 Trace

Print
Print T.30 Report
When to Print Report

Never auto print
(default)

Print various diagnostic pages that help solve
print-quality problems.
Print or configure the fax T.30 trace report. T.
30 is the standard that specifies
handshaking, protocols, and error correction
between fax machines.

Print after any fax job
Print after fax send
jobs
Print after any fax
error
Print after send
errors only
Print after receive
errors only
Fax Transmit Signal
Loss

A value between 0
and 30. The default is
0.

Set loss levels to compensate for phone-line
signal loss. Do not modify this setting unless
requested to do so by an HP service
representative because it could cause the fax
to stop functioning.

Fax V.34

Normal (default)

Disable V.34 mode if several fax failures have
occurred or if phone line conditions require it.

Off
Fax Speaker Mode

Normal (default)
Diagnostic

Diagnostic Page
Disable Cartridge
Check
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Print

A technician can use this feature technician
to evaluate and diagnose fax issues by
listening to the sounds of fax modulations.
Print a diagnostic page that includes color
swatches and the EP parameters table.
Use this item to enter a mode where a
cartridge (or color pair of cartridge and drum)
can be removed to determine which particular

Troubleshooting menu
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Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description
color is the source of a problem. In this mode,
all consumable-related errors are ignored.

Paper Path Sensors
Paper Path Test

Initiate a test of the paper-path sensors.
Test Page

Print

Generate a test page for testing the paperhandling features. Define the path for the test
in order to test specific paper paths.

Source

All trays

Specify whether the test page is printed from
all trays or from a specific tray.

Tray 1
Tray 2
(Additional trays are
shown, if applicable.)
Destination

All bins

Select the output option for the test page.
Send the test page to all output bins or only
to a specific bin.

Duplex

Off (default)

Select whether the duplexer should be
included in the test.

On
Copies
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Range: 1-500,
Default is 1.

Select how many pages should be sent from
the specified source as part of the test.

ENWW

Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

Finishing Paper Path
Test

Staples

Finishing Options

Choose from a list of
available options.

Test the paper-handling features on the
finisher.
Select the option that you want to test.

Destination Bin
Media Size

Letter

Select the paper size for the test.

A4
Media Type

Select from a list of
types.

Select the paper type for the test.

Copies

Range: 2-30,
Default=2

Select the number of copies to include in the
test.

Duplex

Off

Select whether to use the duplexer in the test.

On

Stack

Test Page

Print

Print a test page to use for the test.

Destination Bin

Select from a list of
bins.

Select the options that you want to use to test
the stacker.

Media Size

Letter
Legal
A4
Executive (JIS)
8.5 x 13

Media Type

Select from a list of
bins.

Select the type of media to use for the
Finishing Paper Path Test.

Copies

1

Select the number of copies to include in the
Finishing Paper Path Test.

10
50
100
500
Duplex

Off

Select whether to use the duplexer in the
Finishing Paper Path Test.

On
Test Page
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Print

Print a test page to use for the test.

Troubleshooting menu
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Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

Booklet Maker

Media Size

Letter

Select the options that you want to use to test
the booklet maker.

Legal
A4
Executive (JIS)
8.5 x 13
Media Type

Select from a list of
bins.

Select the type of media to use for the
Finishing Paper Path Test.

Copies

1

Select the number of copies to include in the
Finishing Paper Path Test.

10
50
100
500
Duplex

Off

Select whether to use the duplexer in the
Finishing Paper Path Test.

On
Test Page

Print

Manual Sensor Test

Component Test

Print a test page to use for the test.
This item performs tests to determine
whether the paper-path sensors are
operating correctly.

Transfer Motors
Belt Only
Image Drum Motors
Black Laser Scanner

Exercise individual parts independently to
isolate noise, leaking, or other issues. To start
the test, select one of the components. The
test runs the number of times specified in the
Repeat option. You might be prompted to
remove parts from the device during the test.
Press the Stop button to abort the test.

Cyan Laser Scanner
Magenta Laser
Scanner
Yellow Laser
Scanner
Fuser Motor
Fuser Pressure
Release Motor
Black Alienation
Motor
Cyan Alienation
Motor
Magenta Alienation
Motor
Yellow Alienation
Motor
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Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

ITB Contact/
Alienation
Tray 2 Pickup Motor
Tray 2 Pickup
Solenoid
Tray 3 Pickup Motor
Tray 3 Pickup
Solenoid
Tray 4 Pickup Motor
Tray 4 Pickup
Solenoid
Tray 5 Pickup Motor
Tray 5 Pickup
Solenoid
Duplexer Reverse
Motor
Duplexer Feed Motor
Duplexer ReFeed
Motor
Paper Transport
Motor
Repeat

Once (Default)

Determines the number of times the test runs.

Continuous
Print/Stop Test

Color Band Test

Continuous value
from 0 to 60,000
milliseconds.
Default: 0

Isolate faults by stopping the device during
the print cycle and observing where in the
process the image degrades. To run the test,
specify a stop time. The next job that is sent
to the device stops at the specified time in the
process.

Test Page

Print

Prints a page that helps identify arcing in the
high-voltage power supplies.

Copies

Continuous value
from 1 to 30.

Specify the number of copies to print for the
Color Band test

Default: 1
Scanner Tests

Lower Lamp
Sensors

A service technician can use this menu item
to diagnose potential problems with the
device scanner.

ADF Input Motor
ADF Input Reverse
Flatbed Motor
ADF Read Motor
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Table 2-17 Troubleshooting menu (continued)
Menu item

Sub-menu item

Sub-menu item

Values

Description

ADF Read Motor
Reverse
ADF Duplex
Solenoid
ADF LED Indicator
Control Panel

LEDs
Display

Verify that the components of the control
panel are functioning correctly.

Buttons
Touchscreen
Finisher Tests

Manual Sensor Test
Component Test
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Resets menu
Administration > Resets
Table 2-18 Resets menu
Menu item

Values

Description

Clear Local Address Book

Clear

Use this feature to clear all addresses from the address books that
are stored on the device.

Clear Fax Activity Log

Yes

Use this feature to clear all events from the Fax Activity Log.

No (default)
Restore Factory Telecom Setting Restore

Use this option to restore the following settings to their factory default
settings: Transmit Signal Loss, V34, Maximum Baud Rate, Speaker
Mode.

Restore Factory Settings

Restore

Use this feature to restore all device settings to their factory defaults.

Reset Supplies

New Document Feeder Kit (Yes/
No)

Notify the device that a new document-feeder kit has been
installed.

ENWW
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Service menu
Administration > Service
The Service menu is locked and requires a PIN for access. This menu is intended for use by authorized
service personnel.
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Software for Windows

●

Supported operating systems for Windows

●

Supported printer drivers for Windows

●

HP Universal Print Driver (UPD)

●

Select the correct printer driver for Windows

●

Priority for print settings

●

Change printer-driver settings for Windows

●

Remove software for Windows

●

Supported utilities for Windows

●

Software for other operating systems
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Supported operating systems for Windows
The product supports the following Windows operating systems:
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●

Windows XP (32-bit and 64-bit)

●

Windows Server 2003 (32-bit and 64-bit)

●

Windows 2000

●

Windows Vista (32-bit and 64-bit)
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Supported printer drivers for Windows
●

HP PCL 6

●

HP postscript emulation Universal Print Driver (HP UPD PS)

●

HP PCL 5 UPD Universal Print Driver (HP UPD PCL 5)

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.
NOTE:

ENWW

For more information about the UPD, see www.hp.com/go/upd.

Supported printer drivers for Windows
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HP Universal Print Driver (UPD)
The HP Universal Print Driver (UPD) for Windows is a single driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.
The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.
NOTE:

For more information about the UPD, see www.hp.com/go/upd.

UPD installation modes
Traditional mode

Dynamic mode
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●

Use this mode if you are installing the driver from a CD for a single computer.

●

When installed with this mode, UPD operates like traditional printer drivers.

●

If you use this mode, you must install UPD separately for each computer.

●

Use this mode if you are installing the driver for a mobile computer, so you can
discover and print to HP products in any location.

●

Use this mode if you are installing UPD for a workgroup.

●

To use this mode, download UPD from the Internet. See www.hp.com/go/
upd.
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Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). Check the installation notes and readme files on the device CD for
additional software and languages.
HP PCL 6 driver description
●

Recommended for printing in all Windows environments

●

Provides the overall best speed, print quality, and product-feature support for most users

●

Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows
environments

●

Might not be fully compatible with third-party and custom software programs that are based on
PCL 5

HP postscript level 3 emulation driver description
●

Recommended for printing with Adobe® software programs or with other highly graphics-intensive
software programs

●

Provides support for printing from postscript level 3 emulation needs, or for postscript flash font
support

●

Performs slightly faster than the PCL 6 driver when using Adobe software programs

HP PCL 5 Universal Print Driver description
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●

Recommended for general office printing in Windows environments

●

Compatible with previous PCL versions and older HP LaserJet products

●

The best choice for printing from third-party or custom software programs

●

The best choice when operating with mixed environments, which require the product to be set to
PCL 5 (UNIX, Linux, mainframe)

●

Designed for use in corporate Windows environments to provide a single driver for use with multiple
printer models

●

Preferred when printing to multiple printer models from a mobile Windows computer

Select the correct printer driver for Windows
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Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:
NOTE:
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The names of commands and dialog boxes might vary depending on your software program.

●

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

●

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

●

Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

●

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

●

Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.
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Change printer-driver settings for Windows
Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1.

On the File menu in the software
program, click Print.

1.

1.

2.

Select the driver, and then click
Properties or Preferences.

The steps can vary; this procedure is
most common.

2.
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Windows XP and Windows
Server 2003 (using the default
Start menu view): Click Start, and
then click Printers and Faxes.

Windows XP and Windows
Server 2003 (using the default
Start menu view): Click Start, and
then click Printers and Faxes.

-or-

-or-

Windows 2000, Windows XP, and
Windows Server 2003 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

Windows 2000, Windows XP, and
Windows Server 2003 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

-or-

-or-

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

Right-click the driver icon, and then
select Printing Preferences.

2.

Right-click the driver icon, and then
select Properties.

3.

Click the Device Settings tab.

Change printer-driver settings for Windows
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Remove software for Windows
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1.

Click Start, and then click All Programs.

2.

Click HP, and then click HP Color LaserJet CM6030 or HP Color LaserJet CM6040 MFP.

3.

Click Uninstall HP Color LaserJet CM6030 or HP Color LaserJet CM6040 MFP, and then follow
the onscreen instructions to remove the software.

Chapter 3 Software for Windows
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Supported utilities for Windows
HP Web Jetadmin
HP Web Jetadmin is a browser-based management tool for HP Jetdirect-connected printers within your
intranet, and it should be installed only on the network administrator’s computer.
To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit www.hp.com/go/webjetadmin.
When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Web browser (such as Microsoft® Internet Explorer 4.x or Netscape Navigator 4.x or later)
by navigating to the HP Web Jetadmin host.

Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. This information appears in a Web browser, such as Microsoft Internet
Explorer, Netscape Navigator, Apple Safari, or Firefox.
The embedded Web server resides on the device. It is not loaded on a network server.
The embedded Web server provides an interface to the device that anyone who has a networkconnected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the device in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see Information pages on page 178.)
For a complete explanation of the features and functionality of the embedded Web server, see
Embedded Web server on page 183.

HP Easy Printer Care
HP Easy Printer Care software is a program that you can use for the following tasks:
●

Check the product status

●

Check the supplies status and use HP SureSupply to shop online for supplies

●

Set up alerts

●

View product usage reports

●

View product documentation

●

Gain access to troubleshooting and maintenance tools

●

Use HP Proactive Support to routinely scan your printing system and to prevent potential problems.
HP Proactive Support can update software, firmware, and HP printer drivers.

You can view HP Easy Printer Care software when the product is directly connected to your computer
or when it is connected to a network.
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Supported operating systems

Supported browsers

●

Microsoft® Windows 2000

●

Microsoft Windows XP, Service Pack 2 (Home and
Professional editions)

●

Microsoft Windows Server 2003

●

Microsoft Windows Vista™

●

Microsoft Internet Explorer 6.0 or 7.0

To download HP Easy Printer Care software , go to www.hp.com/go/easyprintercare. This Web site also
provides updated information about supported browsers and a list of HP products that support HP Easy
Printer Care software.
For more information about using HP Easy Printer Care software, see HP Easy Printer Care
on page 180.
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Software for other operating systems
OS

Software

UNIX

For HP-UX and Solaris networks, go to www.hp.com/support/go/jetdirectunix_software to
install model scripts using the HP Jetdirect printer installer (HPPI) for UNIX.
For the latest model scripts, go to www.hp.com/go/unixmodelscripts.

Linux
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For information, go to www.hp.com/go/linuxprinting.

Software for other operating systems
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Use the product with Macintosh

●

Software for Macintosh

●

Use features in the Macintosh printer driver
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Software for Macintosh
Supported operating systems for Macintosh
The device supports the following Macintosh operating systems:
●

Mac OS X V10.2.8, V10.3, V10.4, V10.5 and later

NOTE: For Mac OS X V10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported printer drivers for Macintosh
The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.
The PPDs, in combination with the Apple PostScript printer drivers, provide access to device features.
Use the Apple PostScript printer driver that comes with the computer.

Remove software from Macintosh operating systems
To remove the software from a Macintosh computer, drag the PPD files to the trash can.

Priority for print settings for Macintosh
Changes to print settings are prioritized depending on where the changes are made:
NOTE:

The names of commands and dialog boxes might vary depending on your software program.

●

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here might override settings changed
anywhere else.

●

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

●

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

●

Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

Change printer-driver settings for Macintosh
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Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1.

On the File menu, click Print.

1.

On the File menu, click Print.

Mac OS X V10.2.8

2.

Change the settings that you want
on the various menus.

2.

Change the settings that you want
on the various menus.

1.

In the Finder, on the Go menu, click
Applications.

3.

On the Presets menu, click Save
as and type a name for the preset.

2.

Open Utilities, and then open Print
Center.

3.

Click on the print queue.
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Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

These settings are saved in the
Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print.

4.

On the Printers menu, click
Configure.

5.

Click the Installable Options
menu.

NOTE: Configuration settings might
not be available in Classic mode.
Mac OS X V10.3 or Mac OS X V10.4
1.

From the Apple menu, click System
Preferences and then Print &
Fax.

2.

Click Printer Setup.

3.

Click the Installable Options
menu.

Mac OS X V10.5
1.

From the Apple menu, click System
Preferences and then Print &
Fax.

2.

Click Options & Supplies.

3.

Click the Driver menu.

4.

Select the driver from the list, and
configure the installed options.

Software for Macintosh computers
HP Printer Utility
Use the HP Printer Utility to set up product features that are not available in the printer driver.
You can use the HP Printer Utility when the product uses a universal serial bus (USB) cable or is
connected to a TCP/IP-based network.
Open the HP Printer Utility
Open the HP Printer Utility in Mac OS X V10.2.8
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1.

Open the Finder, and then click Applications.

2.

Click Library, and then click Printers.

3.

Click hp, and then click Utilities.

4.

Double-click HP Printer Selector to open the HP Printer Selector.

5.

Select the product that you want to configure, and then click Utility.

Software for Macintosh
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Open the HP Printer Utility in Mac OS X V10.3 and V10.4
1.

Open the Finder, click Applications, click Utilities, and then double-click Printer Setup Utility.

2.

Select the product that you want to configure, and then click Utility.

Open the HP Printer Utility in Mac OS X V10.5
▲

From the Printer menu, click Printer Utility.
-orFrom the Print Queue, click the Utility icon.

HP Printer Utility features
The HP Printer Utility consists of pages that you open by clicking in the Configuration Settings list.
The following table describes the tasks that you can perform from these pages.
Item

Description

Configuration Page

Prints a configuration page.

Supplies Status

Shows the device supplies status and provides links for online supplies-ordering.

HP Support

Provides access to technical assistance, online supplies ordering, online registration, and
recycling and return information.

File Upload

Transfers files from the computer to the device.

Upload Fonts

Transfers font files from the computer to the device.

Firmware Update

Transfers updated firmware files from the computer to the device.

Duplex Mode

Turns on the automatic two-sided printing mode.

Economode & Toner Density

Turns on the Economode setting to conserve toner, or adjusts toner density.

Resolution

Changes the resolution settings, including the REt setting.

Lock Resources

Locks or unlocks storage products, such as a hard disk.

Stored Jobs

Manages print jobs that are stored on the device hard disk.

Trays Configuration

Changes the default tray settings.

IP Settings

Changes the device network settings and provides access to the embedded Web server.

Bonjour Settings

Provides the ability to turn on or off Bonjour support or change the device service name
that is listed on a network.

Additional Settings

Provides access to the embedded Web server.

E-mail Alerts

Configures the device to send e-mail notices for certain events.

Supported utilities for Macintosh
Embedded Web server
The device is equipped with an embedded Web server, which provides access to information about
device and network activities. For more information, see Embedded Web server sections
on page 184.
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Use features in the Macintosh printer driver
Print
Create and use printing presets in Macintosh
Use printing presets to save the current printer driver settings for reuse.
Create a printing preset
1.

On the File menu, click Print.

2.

Select the driver.

3.

Select the print settings.

4.

In the Presets box, click Save As..., and type a name for the preset.

5.

Click OK.

Use printing presets
1.

On the File menu, click Print.

2.

Select the driver.

3.

In the Presets box, select the printing preset that you want to use.

NOTE:

To use printer-driver default settings, select Standard.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.
1.

On the File menu, click Print.

2.

Open the Paper Handling menu.

3.

In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4.

If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).
1.

On the File menu, click Print.

2.

Select the driver.

3.

Open the Cover Page menu, and then select whether to print the cover page Before Document
or After Document.

4.

In the Cover Page Type menu, select the message that you want to print on the cover page.
NOTE:
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To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.
1.

On the File menu, click Print.

2.

Open the Watermarks menu.

3.

Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4.

Next to Pages, select whether to print the watermark on all pages or on the first page only.

5.

Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6.

Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.
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1.

On the File menu, click Print.

2.

Select the driver.

3.

Open the Layout menu.

4.

Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

5.

Next to Layout Direction, select the order and placement of the pages on the sheet.

6.

Next to Borders, select the type of border to print around each page on the sheet.

Chapter 4 Use the product with Macintosh

ENWW

Print on both sides of the page (duplex printing)
Use automatic duplex printing
1.

Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:
●

For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

●

For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

2.

On the File menu, click Print.

3.

Open the Layout menu.

4.

Next to Two-Sided, select either Long-Edge Binding or Short-Edge Binding.

5.

Click Print.

Print on both sides manually
1.

Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:
●

For tray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

●

For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m2 (28-lb bond).
2.

On the File menu, click Print.

3.

On the Finishing menu, select Manually Print on 2nd Side.

4.

Click Print. Follow the instructions in the pop-up window that appears on the computer screen
before replacing the output stack in tray 1 for printing the second half.

5.

Go to the printer, and remove any blank paper that is in tray 1.

6.

Insert the printed stack face-up with the bottom edge feeding into the printer first in tray 1. You
must print the second side from tray 1.

7.

If prompted, press the appropriate control-panel button to continue.

Set the stapling options
If a finishing device that has a stapler is installed, you can staple documents.

ENWW

1.

On the File menu, click Print.

2.

Open the Finishing menu.

3.

In the Stapling Options drop-down list, select the stapling option that you want to use.

Use features in the Macintosh printer driver

79

Store jobs
You can store jobs on the product so you can print them at any time. You can share stored jobs with
other users, or you can make them private.
1.

On the File menu, click Print.

2.

Open the Job Storage menu.

3.

In the Job Storage: drop-down list, select the type of stored job.

4.

For the Stored Job, Private Job, and Private Stored Job types of stored jobs, enter a name for
the stored job in the box next to Job Name:.
Select which option to use if another stored job already has that name.

5.

●

Use Job Name + (1 - 99) appends a unique number to the end of the job name.

●

Replace Existing File overwrites the existing stored job with the new one.

If you selected Stored Job or Private Job in step 3, type a 4-digit number in the box next to PIN
To Print (0000 - 9999). When other people attempt to print this job, the product prompts them to
enter this PIN number.

Set the color options
Use the Color Options pop-up menu to control how colors are interpreted and printed from software
programs.
1.

On the File menu in the software program, click Print.

2.

Select the driver.

3.

Open the Color Options pop-up menu.

4.

Click Show Advanced Options.

5.

Adjust the individual settings for text, graphics, and photographs.

Use the Services menu
If the product is connected to a network, use the Services menu to obtain product and supply-status
information.
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1.

On the File menu, click Print.

2.

Open the Services menu.
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3.

4.
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To open the embedded Web server and perform a maintenance task, do the following:
a.

Select Device Maintenance.

b.

Select a task from the drop-down list.

c.

Click Launch.

To go to various support Web sites for this device, do the following:
a.

Select Services on the Web.

b.

Select Internet Services, and select an option from the drop-down list.

c.

Click Go!.

Use features in the Macintosh printer driver
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Connect the product

●

USB connection

●

Network connection
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USB connection
This product supports one USB 2.0 device connection. The USB port is located on the back of the
product. You must use an A-to-B type USB cable that is no longer than 2 meters (6.56 feet). The USB
2.0 port can be used to connect directly to the product and to upgrade firmware.
Figure 5-1 USB connection

1

84

USB 2.0 port
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Network connection
All product models include an embedded HP Jetdirect print server, which supports connection to a
network using the local area network (LAN) connector (RJ-45) on the back of the product. For more
information about configuring the product on a network see Network configuration on page 87
Figure 5-2 Network connection
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1

Network cable

2

Network port

Network connection
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Network configuration

●

Benefits of a network connection

●

Supported network protocols

●

Configuring network settings

●

Network utilities
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Benefits of a network connection
Connecting the product to a network provides a number of benefits:
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●

All network users can share the same product.

●

You can manage the product remotely, from any computer on the network, by using the embedded
Web server (EWS).

●

You can use the HP Easy Printer Care software to view supply usage on all HP products connected
to the network. This makes it easy to centrally manage ordering replacement cartridges and other
supplies.

●

For large enterprise businesses, you can also manage the product remotely by using HP Web
Jetadmin.

Chapter 6 Network configuration
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Supported network protocols
The product supports the TCP/IP network protocol, the most widely used and accepted networking
protocol. Many networking services utilize this protocol. For more information, see TCP/IP
on page 90. The following table lists the supported networking services and protocols.
Table 6-1 Printing
Service name

Description

port9100 (Direct Mode)

Printing service

Line printer daemon (LPD)

Printing service

Table 6-2 Network device discovery
Service name

Description

SLP (Service Location Protocol)

Device-discovery protocol, used to help find and configure
network devices. Used primarily by Microsoft-based programs.

Bonjour

Device-discovery protocol, used to help find and configure
network devices. Used primarily by Apple Macintosh-based
programs.

Table 6-3 Messaging and management
Service name

Description

HTTP (Hyper Text Transfer Protocol)

Allows Web browsers to communicate with embedded Web
server.

EWS (embedded Web server)

Allows a user to manage the product through a Web browser.

SNMP (Simple Network Management Protocol)

Used by network applications for product management. SNMP
v1 and standard MIB-II (Management Information Base)
objects are supported.

Table 6-4 IP addressing
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Service name

Description

DHCP (Dynamic Host Configuration Protocol)

For automatic IP address assignment. The DHCP server
provides the product with an IP address. Generally, no user
intervention is required for the product to obtain an IP address
from a DHCP server.

BOOTP (Bootstrap Protocol)

For automatic IP address assignment. The BOOTP server
provides the product with an IP address. Requires the
administrator to input a product's MAC hardware address on
the BOOTP server for the product to obtain an IP address from
that server.

Auto IP

For automatic IP address assignment. If neither a DHCP
server nor a BOOTP server is present, the product uses this
service to generate a unique IP address.

Supported network protocols
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Configuring network settings
You might need to configure certain network parameters on the product. You can configure these
parameters from the installation software, the product control panel, the embedded Web server, or
management software, such as HP Web Jetadmin.
For more information about supported networks and network configuration tools, see the HP Jetdirect
Print Servers Administrator’s Guide. The guide comes with printers in which an HP Jetdirect print server
is installed.

TCP/IP
Similar to a common language that people use to communicate with each other, TCP/IP (Transmission
Control Protocol/Internet Protocol) is a suite of protocols designed to define the way computers and
other devices communicate with each other over a network.

Internet Protocol (IP)
When information is sent across the network, the data is broken down into small packets. Each packet
is sent independently. Each packet is encoded with IP information, such as the IP address of the sender
and receiver. IP packets can be routed over routers and gateways: devices that connect a network with
other networks.
IP communications require no connection. When IP packets are sent, they might not arrive at their
destination in the correct sequence. However, higher-level protocols and programs place the packets
in the correct sequence, so IP communications are efficient.
Each node or device that communicates on the network requires an IP address.

Transmission Control Protocol (TCP)
TCP breaks the data into packets and recombines them on the receiving end by providing a connectionoriented, reliable, and guaranteed delivery service to another node on the network. When data packets
are received at their destination, TCP calculates a checksum for each packet to verify that the data is
not corrupt. If the data in the packet has been corrupted during transmission, TCP discards the packet
and requests that the packet be resent.

IP address
Every host (workstation or node) on an IP network requires a unique IP address for each network
interface. This address is used to identify both the network and specific hosts that are located on that
network. It is possible for a host to query a server for a dynamic IP address each time the product boots
up (for example, using DHCP and BOOTP).
An IP address contains four bytes of information, divided into sections that each contain one byte. The
IP address has the following format:
xxx.xxx.xxx.xxx
CAUTION: When assigning IP addresses, always consult the IP address administrator. Setting the
wrong address can disable other equipment operating on the network or interfere with communications.

Configure IP parameters
TCP/IP configuration parameters can be configured manually, or they can be automatically downloaded
by using DHCP or BOOTP each time the product is turned on.
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When turned on, a new product that is unable to retrieve a valid IP address from the network
automatically assigns itself a default IP address. The IP address for the product is listed on the product
Configuration page and the Network report. See Information pages on page 178.
Dynamic Host Configuration Protocol (DHCP)
DHCP allows a group of devices to use a set of IP addresses that are maintained by a DHCP server.
The product sends a request to the server, and if an IP address is available, the server assigns it to that
product.
BOOTP
BOOTP is a bootstrap protocol used to download configuration parameters and host information from
a network server.
The client broadcasts a boot request packet that contains the product hardware address. The server
answers with a boot reply packet that contains the information that the product needs for configuration.

Subnets
When an IP network address for a particular network class is assigned to an organization, no provision
is made for more than one network being present at that location. Local network administrators use
subnets to partition a network into several different subnetworks. Splitting a network into subnets can
result in better performance and improved use of limited network address space.
Subnet mask
The subnet mask is a mechanism used to divide a single IP network into several different subnetworks.
For a given network class, a portion of an IP address that would normally be used to identify a node is
used, instead, to identify a subnetwork. A subnet mask is applied to each IP address to specify the
portion used for subnetworks, and the portion used to identify the node.

Gateways
Gateways (routers) are used to connect networks together. Gateways are devices that act as translators
between systems that do not use the same communication protocols, data formatting, structures,
languages, or architectures. Gateways repackage the data packets and change the syntax to match
that of the destination system. When networks are divided into subnets, gateways are required to
connect one subnet to another.
Default gateway
The default gateway is the IP address of the gateway or router that moves packets between networks.
If multiple gateways or routers exist, then the default gateway is typically the address of the first, or
nearest, gateway or router. If no gateways or routers exist, then the default gateway will typically assume
the IP address of the network node (such as the workstation or product).
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Configure TCP/IPv4 parameters
If your network doesn't provide automatic IP addressing through DHCP, BOOTP, RARP, or another
method, you might need to enter the following parameters manually before you can print over the
network:
●

IP address (4 bytes)

●

Subnet mask (4 bytes)

●

Default gateway (4 bytes)

Input or change the IP address
You can view the current IP address of the device from the control-panel Home screen by touching
Network Address.
Use the following procedure to change the IP address manually.
1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch TCP/IP.

6.

Touch IPV4 Settings.

7.

Touch Config Method.

8.

Touch Manual.

9.

Touch Save.

10. Touch Manual Settings.
11. Touch IP Address.
12. Touch the IP Address text box.
13. Use the touchscreen keypad to type the IP address.
14. Touch OK.
15. Touch Save.

Set the subnet mask
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1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch TCP/IP.
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6.

Touch IPV4 Settings.

7.

Touch Config Method.

8.

Touch Manual.

9.

Touch Save.

10. Touch Manual Settings.
11. Touch Subnet Mask.
12. Touch the Subnet Mask text box.
13. Use the touchscreen keypad to type the subnet mask.
14. Touch OK.
15. Touch Save.

Set the default gateway
1.

Scroll to and touch Administration.

2.

Scroll to and touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect.

5.

Touch TCP/IP.

6.

Touch IPV4 Settings.

7.

Touch Config Method.

8.

Touch Manual.

9.

Touch Save.

10. Touch Manual Settings.
11. Touch Default Gateway.
12. Touch the Default Gateway text box.
13. Use the touchscreen keyboard to type the default gateway.
14. Touch OK.
15. Touch Save.

Configure TCP/IPv6 parameters
For information about configuring the device for a TCP/IPv6 network, see the HP Jetdirect Print Servers
Administrator's Guide.
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Network utilities
The product can be used with several utilities that make it easy to monitor and manage the product on
a network.
●

HP Web Jetadmin: See HP Web Jetadmin on page 69.

●

Embedded Web server: See Embedded Web server on page 69.

●

HP Easy Printer Care software: See HP Easy Printer Care on page 69.

Other components and utilities
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Windows

Macintosh OS

●

Software installer — automates the printing system
installation

●

●

Online Web registration

Chapter 6 Network configuration

The HP Printer Utility — change device settings, view
status, and set up printer-event notification from a Mac.
This utility is supported for Mac OS X V10.2 and later.
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Paper and print media

●

Understand paper and print media use

●

Supported paper and print media sizes

●

Supported paper types

●

Special paper or print media guidelines

●

Load paper and print media

●

Configure trays

●

Choose an output location
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Understand paper and print media use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:
●

Poor print quality

●

Increased jams

●

Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laserjets or multiuse. Do not
use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend the
use of other brands of media because HP cannot control their quality.
It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.
CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Supported paper and print media sizes
NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before
printing.
Table 7-1 Supported paper and print media sizes
Size

Dimensions

Tray 1

Tray 2

Trays 3, 4, 5

Letter

216 x 279 mm (8.5 x 11 in)

1

1

Letter Rotated

279 x 216 mm (11 x 8.5 in)

1

1

Legal

216 x 356 mm (8.5 x 14 in)

1

1

A4

210 x 297 mm (8.27 x 11.69 in)

1

1

A4 Rotated

297 x 210 mm (11.69 x 8.27 in)

1

1

Executive

184 x 267 mm (7.24 x 10.51 in)

1

1

Statement

139.7 x 215.9 mm (5.5 x 8.5 in)

8.5 x 13

216 x 330 mm (8.5 x 13 in)

A3

297 x 420 mm (11.69 x 16.54 in)

1

1

A5

148 x 210 mm (5.83 x 8.27 in)

1

1

A6

105 x 148 mm (4.13 x 5.83 in)

11 x 17

279 x 432 mm (11 x 17 in)

1

1

12 x 18

305 x 457 mm (12 x 18 in)

B4 (JIS)

257 x 364 mm (10.12 x 14.33 in)

1

1

RA3

305 x 430 mm (12 x 16.93 in)

SRA3

320 x 450 mm (12.6 x 17.7 in)

B5 (JIS)

182 x 257 mm (7.17 x 10.12 in)

1

1

8k

270 x 390 mm (10.63 x 15.35 in)

16k

195 x 270 mm (7.68 x 10.63 in)

Custom

98.55 x 139.70 mm to 320 x 457.2 mm
(3.9 x 5.5 to 12.6 x 18 in)3

Custom

148 x 210 mm to 297 x 432 mm (5.8 x 8.2 to
11.7 x 17 in)2

Custom

148 x 210 mm to 320 x 457.2 mm (5.8 x 8.2 to
12.6 x 18 in)

1

Tray automatically detects paper size.

2

Standard sizes within the custom range for Tray 2 are: 8.5 x 13, RA4, SRA4, 8K (270 x 390), 16K (195 x 270)

3

Standard sizes within the custom range for Trays 3, 4, and 5 are: 8.5 x 13, RA4, SRA4, 8K (270 x 390), 16K (195 x 270), RA3,
SRA3 , and 12 x 18

Table 7-2 Supported envelopes and postcards
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Size

Dimensions

Envelope #9

98 x 225 mm (3.88 x 8.88 in)

Tray 1

Trays 2, 3, 4, 5

Supported paper and print media sizes
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Table 7-2 Supported envelopes and postcards (continued)
Size

Dimensions

Tray 1

Envelope #10

105 x 241 mm (4.13 x 9.49 in)

Envelope DL

110 x 220 mm (4.33 x 8.66 in)

Envelope C5

162 x 229 mm (6.93 x 9.84 in)

Envelope B5

176 x 250 mm (6.7 x 9.8 in)

Envelope C6

162 x 114 mm (6.4 x 4.5 in)

Envelope
Monarch

98 x 191 mm (3.9 x 7.5 in)

Trays 2, 3, 4, 5

Double Post Card 148 x 200 mm (5.83 x 7.87 in)
US Index Cards
1

102 x 152 mm (4 x 6 in) and 127 x 203 mm (5 x 8 in)

Weights greater than 160 g/m2 may not perform well, but will not harm the product.

The following paper sizes are supported with the optional HP 3-bin Stapler/Stacker and HP Booklet
Maker/Finisher accessories.
Table 7-3 Supported paper and print media sizes for the optional HP 3-bin Stapler/Stacker and HP Booklet Maker/
Finisher accessories
Size

Dimensions

Letter

216 x 279 mm
(8.5 x 11 in)

Letter Rotated

279 x 216 mm
(11 x 8.5 in)

1

1

Legal

216 x 356 mm
(8.5 x 14 in)

1

1

A4

210 x 297 mm
(8.27 x 11.69 in)

A4 Rotated

297 x 210 mm
(11.69 x 8.27 in)

1

1

Executive

184 x 267 mm
(7.24 x 10.51 in)

8.5 x 13

216 x 330 mm
(8.5 x 13 in)

A3

297 x 420 mm
(11.69 x 16.54 in)

1

1

A5

148 x 210 mm
(5.83 x 8.27 in)

A6

105 x 148 mm
(4.13 x 5.83 in)

Statement

140 x 216 mm
(5.5 x 8.5 in)

11 x 17
(Ledger)

279 x 432 mm
(11 x 17 in)

1

1
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Angled
staple (leftangled)

Angled
staple (rightangled)

Two staples
(top or side)

Folding

Saddle stitch
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Table 7-3 Supported paper and print media sizes for the optional HP 3-bin Stapler/Stacker and HP Booklet Maker/
Finisher accessories (continued)
Size

Dimensions

12 x 18

305 x 457 mm
(12 x 18 in)

B4 (JIS)

257 x 364 mm
(10.12 x 14.33 in)

RA3

305 x 430 mm
(12 x 16.93 in)

SRA3

320 x 450 mm
(12.6 x 17.7 in)

B5 (JIS)

257 x 182 mm
(10.12 x 7.17 in)

B6 (JIS)

128 x 182 mm
(5.04 x 7.2 in)

8K

270 x 390 mm
(10.63 x 15.35 in)

16K

195 x 270 mm
(7.68 x 10.63 in)

Envelope 9#

98.4 x 225.4 mm
(3.88 x 8.88 in)

Envelope 10#

104.77 x 241.3 mm
(4.12 x 9.5 in)

Envelope DL

110 x 220 mm
(4.33 x 8.66 in)

Envelope C5

162 x 229 mm
(6.38 x 9.02 in)

Envelope B5

176 x 250 mm
(6.93 x 9.84 in)

Envelope C6

114 x 162 mm
(4.49 x 6.38 in)

Envelope
Monarch

98.42 x 190.5 mm
(3.88 x 7.5 in)

Double Post
Card

148 x 200 mm
(5.83 x 7.87 in)

4 x 6 Index
Card

102 x 152 mm (4 x 6 in)

5 x 8 Index
Card

127 x 203 mm (5 x 8 in)

Custom Size

98.55 x 139.70 mm to
320 x 457.2 mm
(3.9 x 5.5 to
12.6 x 18 in)
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Stacking2

Angled
staple (leftangled)

Angled
staple (rightangled)

Two staples
(top or side)

Folding

1

1

Booklet maker only

2

Stacking uses bins 1, 2, and 3 in the stapler/stacker, or bins 1 and 2 in the booklet maker.

Saddle stitch

1

Supported paper and print media sizes
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Supported paper types
Table 7-4 Tray 1 paper information
Type

Specifications

Quantity

Driver settings

Paper orientation

Paper and cardstock,
standard sizes

Range:

Maximum stack height:
10 mm (0.6 in)

Plain or unspecified

Load preprinted or
prepunched paper
facing down, with the
top edge leading into
the tray, or toward the
back of the product

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Equivalent to 100
sheets of 75 g/m2 (20
lb) bond.

Envelopes

Less than 60 g/m2 (16
lb) bond to 90 g/m2 (24
lb) bond

Up to 10 envelopes

Envelope

Short edge leading,
flap toward the front of
the product, facing up

Labels

Maximum 0.23 mm
(0.009 in) thick

Maximum stack height:
10 mm (0.6 in)

Labels

Side to be printed on
facing down

Transparencies

Minimum 0.13 mm
(0.005 in) thick

Maximum stack height:
10 mm (0.6 in)

Transparencies

Side to be printed on
facing down

Heavy

0.13 mm (0.005 in)
thick

Maximum stack height:
10 mm (0.6 in)

Light glossy, glossy, or
heavy glossy

Side to be printed on
facing down

Glossy

Range:

Maximum stack height:
10 mm (0.6 in)

Light glossy, glossy, or
heavy glossy

Side to be printed on
facing down

75 g/m2 (20 lb) bond to
220 g/m2 (58 lb) bond
Photo media

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height:
10 mm (0.6 in)

Side to be printed on
facing down

Cut sheet paper

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height:
10 mm (0.6 in)

Side to be printed on
facing down

Tough paper

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height:
10 mm (0.6 in)

Side to be printed on
facing down

Table 7-5 Trays 2, 3, 4, and 5 paper information
Type

Specifications

Quantity

Settings

Paper orientation

Paper and cardstock,
standard sizes

Range:

500 sheets of 75 g/m2
(20 lb) bond.

Plain or unspecified

Load preprinted or
prepunched paper
facing up, with the top
toward the back of the
tray or toward the righthand side of the tray.

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Labels

Maximum 0.13 mm
(0.005 in) thick

Maximum stack height: Labels
54 mm (2.1 in)

Side to be printed on
facing up

Transparencies

Minimum 0.13 mm
(0.005 in) thick

Maximum stack height: Transparencies
54 mm (2.1 in)

Side to be printed on
facing up

Heavy

0.13 mm (0.005 in) thick

Maximum stack height: Light glossy, glossy, or Side to be printed on
54 mm (2.1 in)
heavy glossy
facing up

Glossy

75 g/m2 (20 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height: Light glossy, glossy, or Side to be printed on
54 mm (2.1 in)
heavy glossy
facing up
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Table 7-5 Trays 2, 3, 4, and 5 paper information (continued)
Type

Specifications

Quantity

Settings

Paper orientation

Photo media

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height: Light glossy, glossy, or
54 mm (2.1 in)
heavy glossy

Side to be printed on
facing up

Cut sheet paper

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height: Plain or unspecified
54 mm (2.1 in)

Side to be printed on
facing up

Tough paper

60 g/m2 (16 lb) bond to
220 g/m2 (58 lb) bond

Maximum stack height: HP Tough Paper
54 mm (2.1 in)

Side to be printed on
facing up

Trays 2, 3, 4, and 5 capacity: 54 mm (2.126 in) height or 500 sheets of paper, whichever is less.
Supported media types include: Cut sheet paper, labels, OHT, glossy paper, glossy film, photo media,
and tough paper. Basis Weight: 60-220 g/m2 (16-58 lb).
Duplex printing: Provides automatic two-sided printing (printing on both sides of the paper). The paper
size range for automatic duplex printing is 175 to 320 mm (6.9 to 12.6 in) x 210 to 457 mm (8.3 to 18
in). The media weight range is 60 to 220 g/m2 (16 to 58 lb)
NOTE: HP Color Laser Presentation Paper, Glossy (Q2546A) is not supported with this product. Using
this type of paper can cause a fuser jam that might require the replacement of the fuser. Two
recommended alternatives are HP Color LaserJet Presentation Paper, Soft Gloss (Q6541A) and HP
Color LaserJet Brochure Paper, Glossy (Q6611A, Q6610A).
NOTE: For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/
sbso/product/supplies.
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Special paper or print media guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.
CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this
technology could damage your printer.
Media type

Do

Envelopes

●

Store envelopes flat.

●

Use envelopes where the seam
extends all the way to the corner of
the envelope.
●

●

Do not

Use peel-off adhesive strips that
are approved for use in laser
printers.

●

Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.
Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

●

Do not use self-stick adhesives or
other synthetic materials.

●

Use only labels that have no
exposed backing between them.

●

Do not use labels that have wrinkles
or bubbles, or are damaged.

●

Use Labels that lie flat.

●

Do not print partial sheets of labels.

●

Use only full sheets of labels.

●

Use only transparencies that are
approved for use in laser printers.

●

Do not use transparent print media
not approved for laser printers.

●

Place transparencies on a flat
surface after removing them from
the product.

Letterhead or preprinted forms

●

Use only letterhead or forms
approved for use in laser printers.

●

Do not use raised or metallic
letterhead.

Heavy paper

●

Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

●

Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper

●

Use only glossy or coated paper
that is approved for use in laser
printers.

●

Do not use glossy or coated paper
designed for use in inkjet products.

Labels

Transparencies
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Load paper and print media
You can load different media in the trays and then request media by type or size by using the control
panel.

Load Tray 1
CAUTION:

To avoid jams, never add or remove paper from Tray 1 during printing.

1.

Open Tray 1.

2.

Set the side guides to the correct width, and pull out the tray extensions to support paper.

3.

Load paper in the tray with the side to be printed on face down and the top of the paper or nonpostage end facing the back of the printer.
NOTE: For Letter Rotated and A4 Rotated sizes, place the side to be printed on face down, with
the bottom of the page facing into the printer.
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4.

Make sure the stack fits under the tabs on the guides and does not exceed the load-level indicators.

5.

Adjust the side guides so that they lightly touch the paper stack but do not bend it.
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Print envelopes
If your software does not automatically format an envelope, specify Landscape for page orientation in
your software program or printer driver. Use the following guidelines to set margins for return and
destination addresses on Commercial #10 or DL envelopes:
Address type

Left margin

Top margin

Return

15 mm (0.6 in)

15 mm (0.6 in)

Destination

102 mm (4 in)

51 mm (2 in)

For envelopes of other sizes, adjust the margin settings accordingly.

Load trays 2, 3, 4, or 5
Trays 2, 3, 4, and 5 each hold up to 500 sheets of standard paper or a 54 mm (2.13-inch) stack of labels
or other thick paper.

Load standard-sized media into trays 2, 3, 4, or 5
The product automatically detects the following standard sizes of media in these 500-sheet trays: Letter,
Letter rotated, Legal, Executive, 11x17, A3, A4, A4 rotated, A5, B4 (JIS), and B5 (JIS).
CAUTION: Do not print envelopes or unsupported sizes of paper from the 500-trays. Print on these
types of paper only from Tray 1.
1.

Slide the tray from the product.

NOTE: Do not open the input tray while it is in use. Doing so can cause jams in the product.
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2.

Adjust the paper width guide by squeezing the adjustment latch and sliding the guide to the size
of the paper being used.

3.

Adjust the paper length guide by squeezing the adjustment latch and sliding the guide to the size
of the paper being used.
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4.

Load paper into the tray face up. Check the paper to verify the guides lightly touch the stack, but
do not bend it.
NOTE: To prevent jams, do not overfill the input tray. Be sure the top of the stack is below the
tray full indicator.

NOTE: For best performance, fill the tray completely without splitting the ream of paper. Splitting
the ream can cause a multifeed problem. The capacity of the paper tray can vary. For example, if
you are using 75 g/m2 (20 lb) paper, the tray holds a full ream of 500 sheets. If the media is heavier,
the tray will not hold a full ream. Do not overfill the tray.
NOTE: If the tray is not adjusted correctly, an error message might appear or the media might
jam.
5.

Slide the tray into the product. The control panel shows the tray’s paper type and size. If the
configuration is not correct, touch Modify on the control panel and select the correct configuration.
If the configuration is correct, touch OK.

Load undetectable standard-sized media into Tray 2, 3, 4, and 5
The following undetectable standard-sized media is supported in the 500-sheet trays:
●

Executive (JIS) (8.5 x 13)

●

12 x 18 (Trays 3, 4, or 5 only)

●

B4 (ISO)

●

RA3 (Trays 3, 4, or 5 only)
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●

SRA3 (Trays 3, 4, or 5 only)

●

B5 (ISO)

CAUTION: Do not print envelopes or unsupported sizes of paper from the 500-sheet trays. Print on
these types of paper only from Tray 1. Do not overfill the input tray or open it while it is in use. Doing so
can cause paper jams.

Load custom-size media into tray 2, 3, 4, or 5
To use custom media, change the size setting on the control panel to Custom and set the unit of
measure, X dimension, and Y dimension. See Configure a tray to match print job settings
on page 114 for more information.
1.

Slide open the tray from the product.

2.

Load the print media as described in steps 2 through 4 of the “Load detectable (standard-size)
media into Tray 2, 3, 4, or 5” section. Then proceed to step 3 in this procedure.

3.

Slide the tray into the product. The control panel shows the tray type and size configuration. To
specify specific custom dimensions, or if the type is not correct, touch Modify when the control
panel prompts to change the size or type.

X

Y
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4.

Select Custom, and then select the Unit of measure, X dimension and Y dimension for the custom
paper size.

5.

Select the paper type and then touch Save.

6.

If the configuration is correct, touch Save.
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Load large size paper into Tray 3, 4, or 5
Use the following instructions if you are loading 11x17, RA3, SRA3, or 12 x 18-sized paper into Tray 3,
4, or 5.
1.

Slide open Tray 3, 4, or 5.

2.

Adjust the paper width guide by squeezing the adjustment latch and sliding the guide to the size
of the paper being used.

3.

Load the paper into the tray.

4.

Move the paper stop lever to the correct position for the paper being used.

5.

●

For SRA3-sized paper, rotate the lever all the way to the left.

●

For A3- or 11x17-sized paper, rotate the lever down into the center position.

●

For RA3- or 12x18-sized paper, rotate the lever all the way to the right.

Slide the tray into the product. The control panel shows the tray’s media type and size. If the
configuration is not correct, touch Modify and configure the tray to the correct type and size. If the
configuration is correct, touch OK.

Load letterhead, pre-printed, or pre-punched paper
To correctly print or copy on letterhead, pre-printed, or pre-punched paper, you need to make sure you
load the paper correctly into the tray. You might also need to adjust the Image Rotation setting on the
product control panel. The Image Rotation setting is used to adjust for languages that read from left to
right (the default) or from right to left.
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For more information regarding this subject see the Quick Reference Job Aids on the User CD that came
with the product, or visit www.hp.com/support/cljcm6030mfp/manuals or www.hp.com/support/
cljcm6040mfp/manuals

Change the Image Rotation setting
1.

At the control panel home screen, scroll down and touch Administration.

2.

Scroll down and touch Device Behavior.

3.

Scroll down and touch Tray Behavior.

4.

Scroll down and touch Image Rotation.

5.

Touch the correct Image Rotation option. The default setting is Left to right.

6.

Touch OK.

Choose the correct orientation for loading letterhead, pre-printed, or pre-punched paper
The tables below should be used as a guide for loading letterhead, pre-printed, or pre-punched paper.
The first table shows the tray-loading orientation when Image Rotation is set to Left to right, which
indicates that the language reads left to right. The second table shows the tray-loading orientation when
Image Rotation is set to Right to left, which indicates that the language reads right to left. The tables
also contain the following information:
●

The paper type: letterhead, pre-printed or pre-punched.

●

The paper tray: Tray 1 or Trays 2 through 5.

●

Image orientation: Portrait (1) or Landscape (2).

1

●
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2

One-sided or two-sided (duplex) printing.
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●

Stapling: The optional stapler/stacker or booklet maker output accessory must be attached in order
to staple print or copy jobs. The staple location can be one left, one angled staple located in upper
left corner; or two left, two staples located on left long edge. For more information about stapling,
see Use the stapler on page 126

●

The arrow in the paper graphic indicates the direction the paper will feed into the printer. The paper
graphic indicates the direction the paper should be placed in the paper tray. The default is to load
the paper so that the long edge feeds first. This results in the most efficient printing and copying.

Table 7-6 Load letterhead, pre-printed, or pre-punched paper — Image Rotation = Left to right
Duplex mode

Staple location
options

Letterhead or Preprinted – Tray 1

Portrait

1- sided

One left, two left

Letterhead or Preprinted – Tray 1

Portrait

2-sided

One left, two left

Letterhead or Preprinted – Tray 1

Landscape

1-sided

One left, two left

Letterhead or Preprinted – Tray 1

Landscape

2-sided

One left, two left

Letterhead or Preprinted – Trays 2-5

Portrait

1-sided

One left, two left

How to load for
long-edge feed

HP Laserjet

How to load for
short-edge feed

HP Laserjet

Image orientation

HP Laserjet
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Table 7-6 Load letterhead, pre-printed, or pre-punched paper — Image Rotation = Left to right (continued)
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Image orientation

Duplex mode

Staple location
options

Letterhead or Preprinted – Trays 2-5

Portrait

2-sided

One left, two left

Letterhead or Preprinted – Trays 2-5

Landscape

1-sided

One left, two left

Letterhead or Preprinted – Trays 2-5

Landscape

2-sided

One left, two left

Pre-punched –
Tray 1

Portrait

1-sided or 2-sided

One left, two left

Pre-punched –
Tray 1

Landscape

1-sided or 2-sided

One left, two left

Pre-punched –
Trays 2-5

Portrait

1-sided or 2-sided

One left, two left

Pre-punched –
Trays 2-5

Landscape

1-sided or 2-sided

One left, two left

How to load for
long-edge feed

How to load for
short-edge feed

HP Laserjet
HP Laserjet

Paper type and
tray
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Table 7-7 Load letterhead, pre-printed, or pre-punched paper — Image Rotation = Right to left
Staple location
options

Letterhead or Preprinted – Tray 1

Portrait

1-sided

One right, two right

Letterhead or Preprinted – Tray 1

Landscape

2-sided

One right, two right

Letterhead or Preprinted – Trays 2-5

Portrait

2-sided

One right, two right

Letterhead or Preprinted – Trays 2-5

Landscape

1-sided

One right, two right

Pre-punched –
Tray 1

Portrait

1-sided or 2-sided

One right, two right

Pre-punched –
Tray 1

Landscape

1-sided or 2-sided

One right, two right

Pre-punched –
Trays 2-5

Portrait

1-sided or 2-sided

One right, two right

Pre-punched –
Trays 2-5

Landscape

1-sided or 2-sided

One right, two right

How to load for
long-edge feed

HP Laserjet

HP Laserjet

Duplex mode
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HP Laserjet
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HP Laserjet

Paper type and
tray

ENWW

NOTE: For more information regarding this subject see the Job Aids on the User CD that came with
the product, or visit www.hp.com/support/cljcm6030mfp/manuals or www.hp.com/support/
cljcm6040mfp/manuals
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Configure trays
The product automatically prompts you to configure a tray for type and size in the following situations:
●

When you load paper into the tray

●

When you specify a particular tray or media type for a print job through the printer driver or a
software program and the tray is not configured to match the print-job’s settings

The following message appears on the control panel:Tray <x> [type] [size] To change size or type,
touch “Modify”. To accept, touch “OK”.
NOTE: The prompt does not appear if you are printing from Tray 1 and Tray 1 is configured for Any
Custom and Any Type.
NOTE: If you have used other HP LaserJet product models, you might be accustomed to configuring
Tray 1 to First mode or Cassette mode. On HP Color LaserJet CM6040 Series, setting Tray 1 size to
Any Custom is equivalent to First mode. Setting size for Tray 1 to a setting other than Any Custom is
equivalent to Cassette mode.

Configure a tray when loading paper
1.

Load paper in the tray. Close the tray if you are using Tray 2, 3, 4, or 5.

2.

The tray configuration message appears.

3.

Touch OK to accept the detected size and type, or touch Modify to choose a different paper size
or type.

4.

Select the correct size and type and then touch OK.
NOTE: The product automatically detects most paper sizes in Trays 2, 3, 4, and 5.

Configure a tray to match print job settings
1.

In the software program, specify the source tray, the paper size, and the paper type.

2.

Send the job to the product.
If the tray needs to be configured, the Load Tray x <Type> <Size> message appears.

3.

Load the tray with the specified type and size of paper, and then close the tray.
To specify a custom size, Modify.

4.

When the Tray <x> Size=<Size> message appears, touch OK to confirm the size.

5.

When the Tray<x> Type=<Type> message appears, touch OK to confirm the type and continue
with the job.

Automatic media type sensing (auto sense mode)
The automatic media type sensor functions only when that tray is configured to Any Type or Plain type.
Configuring a tray to any other type, such as Bond or Glossy, deactivates the media sensor in that tray.
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The HP Color LaserJet CM6030 and CM6040 MFP Series can automatically classify many paper types
into one of the following categories:
●

Plain

●

Transparency

●

Glossy

●

Extra-heavy glossy

●

Glossy film

●

Heavy

For more control, a specific type must be selected in the job or configured in a tray.

Auto sense settings
Full sensing (default for Tray 1)
●

The product recognizes light, plain, heavy, glossy, and tough paper and overhead transparencies.

●

Each time the product begins a print job, it stops the first page to sense the type.

●

This is the slowest mode.

Expanded sensing (default for Trays 2, 3, 4, and 5)
●

Each time the product begins a print job, it stops the first page to sense the type.

●

The product assumes that the second and all subsequent pages are of the same media type as
the first page.

●

This is the second-fastest mode, and is useful for using stacks of the same media type.

Transparency only
●

The product does not stop any pages for sensing but distinguishes between transparencies
(Transparency mode) and paper (Normal mode).

●

This is the fastest mode and is useful for high-volume printing in Normal mode.

For more information about setting these options, see Print Quality menu on page 49

Select the paper by source, type, or size
In the Microsoft Windows operating system, three settings affect how the printer driver tries to pull media
when you send a print job. Source, Type, and Size settings appear in the Page Setup, Print, or Print
Properties dialog boxes in most software programs. Unless you change these settings, the product
automatically selects a tray using the default settings.

Source
To print by Source select a specific tray for the product to pull from. If you select a tray that is configured
for a type or size that does not match your print job, the product prompts you to load the tray with the
type or size of print media for your print job before printing it. When you load the tray, the product begins
printing.
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Type and Size
Printing by Type or Size means that you want the product to pull from the tray that is loaded with the
correct type and size of media. Selecting media by type rather than source is similar to locking out trays
and helps protect special media from accidental use. For example, if a tray is configured for letterhead
and you select plain paper, the product will not pull the letterhead from that tray. Instead, it will pull from
a tray that has plain paper loaded and is configured for plain paper on the product control panel. Selecting
media by Type and Size results in significantly better print quality for heavy paper, glossy paper, and
transparencies. Using the wrong setting might result in unsatisfactory print quality. Always print by Type
for special print media, such as labels or transparencies. Print by Size for envelopes, if possible.
●

To print by Type or Size, select the Type or Size from the Page Setup dialog box, the Print dialog
box, or the Print Properties dialog box, depending on the software program.

●

If you often print on a certain type or size of media, configure a tray for that type or size. Then,
when you select that type or size as you print a job, the product automatically pulls media from the
tray that is configured for that type or size.
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Choose an output location
Standard output bins
The product has an ADF output bin and the standard output bin for printed pages.

2
1

1

Standard output bin

2

ADF output bin (for copy originals)

When you scan or copy documents by using the ADF, the originals are automatically delivered to the
ADF output bin. Copies made from the scanner glass are delivered to the standard output bin or the
output bin(s) on the stapler/stacker or the 3-bin mailbox.
When you send print jobs to the product from a computer, the output is to the standard output bin or the
output bin(s) on the stapler/stacker or the 3-bin mailbox.

Optional output accessories
An optional 3 bin stapler/stacker or booklet-maker finisher accessory can be installed with the product.
When an accessory is installed, an output accessory bridge is also added on top of the product in order
to route the print jobs to the accessory output bins.
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3-bin stapler/stacker features
Table 7-8 3-bin stapler/stacker features
Job offset

Each copy of a job is shifted to one side in the output bin in order to keep each copy separate
from the others. (Supported paper sizes: A3, A4, A4 rotated, A5, B4, B5, Ledger, Legal, Letter,
Letter rotated, Statement.)

Three operation modes

Mailbox Mode assigns each bin to a user or group of users. Stacker Mode uses all three output
bins for all print jobs — when one bin is full, jobs are routed to the next bin. Function Separator
Mode sends copies to bin 1, faxes to bin 2, and print jobs to bin 3.

Stapler

Built-in stapler staples jobs up to 50 sheets in size or 30 stapled jobs. Pages can be stapled
in one position at the front, in one position at the back, or at two positions at the side or top.

Large-capacity output bins

The stacker has three bins: a 100-sheet bin, a 500-sheet bin, and a 1000-sheet bin.

Booklet maker finisher features
Table 7-9 Booklet-maker finisher features
Booklet-making

The booklet-making feature staples and folds print jobs of 2 to 15 pages into a booklet.

Folding

Single-sheet print jobs can be automatically folded in the center.

Job offset

Each copy of a job is shifted to one side in the output bin in order to keep each copy separate
from the others. (Supported paper sizes: A3, A4, A4 rotated, A5, B4, B5, Ledger, Legal, Letter,
Letter rotated, Statement.)

Two operation modes

Mailbox Mode assigns each bin to a user or group of users, and Stacker Mode uses both
output bins for all print jobs — when the top bin is full, jobs are routed to the next bin.

Stapler

Built-in stapler staples jobs up to 50 sheets in size or 30 stapled jobs. Pages can be stapled
in one position at the front, in one position at the back, or at two positions at the side or top.

Large-capacity output bins

The stacker has three bins: two 1000-sheet bins and one bin that can hold up to 25 saddlestitched booklets.

Accessory walkaround
Figure 7-1 3-bin stapler/stacker accessory

2

1

1

3

4

5

Output bins

118 Chapter 7 Paper and print media

ENWW

2

Front door

3

Stapler unit

4

Top cover

5

Connection cable

Figure 7-2 Booklet-maker finisher accessory
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4

5

6

7

2

1

1

Booklet bin guide

2

Booklet output bin

3

Stacking output bins

4

Front door

5

Stapler units

6

Top cover

7

Connection cable

Use the booklet-making feature
You can create booklets from the print driver or by copying an original document.
Before creating a booklet, set the booklet bin guide for the size of paper being used:
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●

Closed: 11x17, Legal, A3, or B4

●

Open: Letter Rotated, A4 Rotated
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Create a booklet from the print driver
1.

On the File menu of your software program, click Print.

2.

Select HP Color LaserJet CM6030 or CM6040 MFP.

3.

Click Properties, and then click Booklet Printing.

4.

Set the Paper source, Paper sizes, Paper type, Orientation, Booklet Layout, Print document
on, andStaple settings, and then click OK.

5.

Click OK to print.

Create a booklet from a copy
Documents can be copied from the automatic document feeder (ADF) or by placing the document on
the scanner glass.
1.

From the control panel, touch Copy.

2.

Scroll to and touch Booklet Format.

3.

Touch Booklet on.

4.

For Original Sides touch 1-sided or 2-sided.

5.

Touch OK and then touch Start.
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Configure the accessory operation mode
Select the operating mode at the control panel
You can set the operating mode for the stapler/stacker or the booklet maker at the product control panel.
1.

At the control panel, touch Administration, and then touch Device behavior.

2.

Touch MBM-3 bin stapler or Multifunction finisher.

3.

Touch Operation mode, and then select the operation mode that you want to use.
●

When Mailbox Mode is used, each bin is assigned to a user or group of users. Every time a
user sends a print job, the job is routed to the assigned bin.

●

When Stacker Mode is used and the optional 3-bin stapler/stacker is installed, the three bins
act as a single bigger bin. When one bin gets full, jobs are automatically routed to the next
bin. When Stacker Mode is used and the booklet maker finisher is installed, the two upper
bins act as a single bin, and the third bin is reserved for booklets.

●

When Function Separator (3-bin stapler/stacker only) mode is used, each bin is assigned to
a specific kind of job. Usually this designation is bin 1 for copies, bin 2 for fax, and bin 3 for
printing. These values can be modified in the Default Job Options menus for copy, fax, and
print.

NOTE: Use the product embedded Web server to assign output bins to users or groups of users.
For more information see Embedded Web server on page 183.

Select the operating mode in the printer driver
1.

Click the Start button, point to Settings, and then click Printers (for Windows 2000) or Printers
and Faxes (for Windows XP).
From your Vista computer click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

2.

Right-click the HP product icon, and then click Properties or Printing Preferences.

3.

Click the Device Settings tab.

4.

Perform one of the following actions:
For automatic configuration: under Installable Options, click Update Now in the Automatic
Configuration list.
-orFor manual configuration: under Installable Options, select the appropriate operation mode in the
Accessory Output Bin list.

5.

Click Apply to save the settings.

Select the operating mode in the printer driver (Mac OS X)
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1.

In the Apple menu, click System Preferences.

2.

In the System Preferences box, click Print and Fax.

3.

Click Set Up Printers. A Printer List displays.
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4.

Select the HP product, and then click Show Info on the Printers menu.

5.

Select the Installable Options panel.

6.

In the Accessory Output Bins list, select correct accessory.

7.

In the Mailbox Mode list, select the appropriate operational mode, and then click Apply
Changes.
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Economy settings
Sleep and wake
Set the sleep delay
Use the sleep-delay feature to select the time interval the product remains inactive before entering sleep
mode. The default is one hour.
1.

Scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Sleep Delay.

4.

Touch the sleep-delay setting that you want and then touch Save.

Set the wake time
Use the wake time feature to wake the product at a set time each day.
1.

Scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Wake Time.

4.

Touch the day of the week for the wake time.

5.

Touch Custom.

6.

Touch Save.

7.

Touch the appropriate options to set the correct hour, minute, and AM/PM setting.

8.

If you want to wake the product at the same time each day, on the Apply to all days screen, touch
Yes. If you want to set the time for individual days, touch No, and repeat the procedure for each
day.

Set the sleep time
Use the sleep time feature to program the product to enter sleep mode at a set time each day.
1.

Scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Sleep Time.

4.

Touch the day of the week for the sleep time setting.

5.

Touch Custom.

6.

Touch Save.
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7.

Touch the appropriate options to set the correct hour, minute, and AM/PM setting.

8.

If you want the product to enter sleep mode at the same time each day, on the Apply to all
days screen, touch Yes. If you want to set the time for individual days, touch No, and repeat the
procedure for each day.

Set economy modes from the EWS

ENWW

1.

From a Web browser, open the EWS. See Embedded Web server on page 183.

2.

Click Settings and then Wake Time.

3.

Set the wake time for each day of the week.

4.

Set the sleep delay for the product.

5.

Click Apply.
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Use the stapler
The automatic stapler is only available with the optional HP 3-bin Stapler/Stacker (CC517A) or HP
booklet Maker/Finisher Accessory (CC516A).
Print jobs can be stapled with a diagonal staple in either top corner, with two horizontal staples at the
top of the page, or with two vertical staples at either side of the page.
●

Paper weight can range from 60 to 220 g/m2 (16 to 148 lbs.). Heavier paper might have a stapling
limit of fewer than 50 sheets.

●

The optional stapler/stacker can staple jobs of up to 50 sheets of 75 g/m2 (20 lb) paper. It can stack
up to 1,000 sheets of paper, or 30 stapled jobs, whichever is less.

●

The optional booklet maker can also staple jobs of up to 50 sheets of 75 g/m2 (20 lb) paper. It can
staple and fold up to 15 pages into a booklet. It can stack up to 1,000 sheets of paper, (or 30 stapled
jobs) or up to 25 saddle-stitched booklets.

●

If the job consists of only one sheet, or if it consists of more than 50 sheets, the product delivers
the job to the bin, but does not staple the job.

●

The stapler supports paper only. Do not try to staple other types of print media, such as envelopes,
transparencies, or labels.

NOTE: For information on loading letterhead, pre-printed, and pre-punched paper, see Load
letterhead, pre-printed, or pre-punched paper on page 108.
When you want the product to staple or fold a document, select the correct option in the software. You
can usually select the stapler in your program or printer driver, although some options might be available
only in the printer driver. Where and how you make selections depends on your program or printer driver.
If you cannot select the stapler or booklet maker finisher in the program or printer driver, select it at the
product control panel.
The stapler accepts print jobs if it is out of staples, but it does not staple the pages. The product can be
configured to stop printing if the staple cartridge is empty.

Supported paper sizes for stapling
In order to staple a print job, you must be a supported paper size and orientation.
Corner, angled staples are supported with the following paper sizes: A4, A4 Rotated, Letter, Letter
Rotated, Legal, A3, 11 x 17, and B4 (JIS).
Two staples at the top or side of the print job are supported with the following paper sizes: A4, Letter,
A3, 11 x 17, and B4 (JIS).
Saddle-stitch stapling with the booklet maker can be carried out with these sizes: A4 Rotated, Letter
Rotated, Legal, A3, 11 x 17, and B4 (JIS).
As shown in the graphic below, the paper must also be loaded into the paper trays with the correct
orientation.
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If the correct paper size or orientation is not used, the print job will print, but it will not be stapled.
NOTE: For information about loading and stapling print or copy jobs on letterhead, pre-printed, or prepunched paper, see 3-bin stapler/stacker features on page 118
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Staple print jobs
NOTE:

For staple job capacity see 3-bin stapler/stacker features on page 118

Select the stapler at the control panel for printed jobs
1.

Touch Administration and then touch Device Behavior.

2.

Touch MBM-3 Bin Stapler or Multifunc Finisher.

3.

Touch Staples.

4.

Touch the option that you want to use: One Left Angled, One Right Angled, Two Left, Two Right,
and Two Top.

NOTE: Selecting the stapler at the printer control panel changes the default setting. It is possible that
all print jobs will be stapled. However, settings that are changed in the printer driver override settings
that are changed at the control panel.
Select the stapler in the printer driver for printed jobs (Windows)
NOTE:

The following procedure changes the default setting to staple all print jobs.

1.

Open the printer driver. See Change printer-driver settings for Windows on page 67.

2.

On the Output tab, click the drop-down list under Staple, and select a staple option.

Select the stapler in the printer driver for printed jobs (Mac)
Select the stapler by creating a new preset in the printer driver.
1.

Open the printer driver. See Change printer-driver settings for Macintosh on page 74.

2.

Create the new preset.

Configure the device to stop or continue when the staple cartridge is empty
You can specify whether the product stops printing when the staple cartridge is empty or if it continues
printing but does not staple the jobs.
1.

Touch Administration and then touch Device Behavior.

2.

Touch MBM-3 Bin Stapler or Multifunc Finisher.

3.

Touch Staples Out.

4.

Touch the option that you want to use:
●

Select Stop to stop all printing until the staple cartridge is replaced.

●

Select Continue to continue printing jobs without stapling them.
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Job storage features for print jobs
You can save a print job to the product hard disk without printing it. You can then print the job at any
time at the control panel. The following job-storage features are available for print jobs:
●

Proof and hold jobs: This feature provides a quick and easy way to print and proof one copy of
a job and then print the additional copies.

●

Personal jobs: When you send a private job to the device, the job does not print until you provide
the required personal identification number (PIN) at the control panel.

●

QuickCopy jobs: You can print the requested number of copies of a job and then store a copy of
the job on the device hard disk. Storing the job allows you to print additional copies of the job later.

●

Stored jobs: You can store a job such as a personnel form, time sheet, or calendar on the device
and allow other users to print the job at any time. Stored jobs also can be protected by a PIN.

Follow the instructions in this section to gain access to the job storage features at the computer. See
the specific section for the type of job that you want to create.
CAUTION:

If you turn off the device, all QuickCopy, proof and hold, and personal jobs are deleted.

Gain access to the job storage features
For Windows
1.

On the File menu, click Print.

2.

Click Properties, and then click the Job Storage tab.

3.

Select the job storage mode that you want.

For Macintosh
In newer drivers: Select Job Storage in the pull-down menu in the Print dialog box. In older drivers,
select Printer Specific Options.

Use the proof and hold feature
The proof and hold feature provides a quick and easy way to print and proof one copy of a job and then
to print the additional copies.
To permanently store the job and prevent the device from deleting it when space is needed for something
else, select the Stored Job option in the driver.

Create a proof and hold job
CAUTION: If the device needs additional space to store newer proof and hold jobs, the device deletes
other stored proof and hold jobs, starting with the oldest job. To permanently store a job and prevent
the device from deleting it when space is needed, select the Stored Job option in the driver instead of
the Proof and Hold option.
In the driver, select the Proof and Hold option and type a user name and job name.
The device prints one copy of the job for you to proof.
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Print the remaining copies of a proof and hold job
At the device control panel, use the following procedure to print the remaining copies of a job held on
the hard disk.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to print.

5.

Select the number of copies on the numeric keypad.

6.

Touch Retrieve Stored Job

to print the document.

Delete a proof and hold job
When you send a proof and hold job, the device automatically deletes your previous proof and hold job.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to delete.

5.

Touch Delete.

6.

Touch Yes.
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Use the personal job feature
Use the personal job feature to specify that a job is not printed until you release it. Your job will be stored
on the product and nothing will be printed until you request the job from the product's control panel.
Once the job is printed, it will be automatically removed from the product's job storage. Personal jobs
can be stored with or without a 4-digit personal identification number (PIN). To make the job private, a
PIN must be used.

Print a personal job
You can print a personal job at the control panel after the job has been sent to the product.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the personal job.

4.

Scroll to and touch the personal job that you want to print.

5.

If a PIN is required, touch the PIN field.

6.

Use the numeric keypad to type the PIN, and then touch OK.

7.

Select the number of copies on the numeric keypad to change the number of copies to print.

8.

Touch Retrieve Stored Job

to print the document.

Delete a personal job
A personal job is automatically deleted from the device hard disk after you release it for printing. If you
want to delete the job without printing it, use this procedure.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the personal job.

4.

Scroll to and touch the personal job that you want to delete.
NOTE:
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A personal job will have a lock symbol

next to it.

5.

Touch the PIN field.

6.

Use the numeric keypad to type the PIN, and then touch OK.

7.

Touch Delete.

8.

Touch Yes.
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Use the QuickCopy feature
The QuickCopy feature prints the requested number of copies of a job and stores a copy on the device
hard disk. Additional copies of the job can be printed later. This feature can be turned off in the printer
driver.
The default number of different QuickCopy jobs that can be stored on the device is 32. At the control
panel, you can set a different default number. See Navigate the Administration menu on page 17.

Create a QuickCopy job
CAUTION: If the device needs additional space to store newer QuickCopy jobs, the device deletes
other stored QuickCopy jobs, starting with the oldest job. To permanently store a job and prevent the
device from deleting it when space is needed, select the Job Storage option in the driver instead of the
QuickCopy option.
In the driver, select the QuickCopy option, and then type a user name and a job name.
When you send the job to print, the device prints the number of copies that you set in the driver. To print
more quick copies at the device control panel, see Print additional copies of a QuickCopy job
on page 132.

Print additional copies of a QuickCopy job
This procedure describes how to print additional copies of a job stored on the device hard disk at the
control panel.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to print.

5.

Select the number of copies on the numeric keypad to change the number of copies to print.

6.

Touch Retrieve Stored Job

to print the document.

Delete a QuickCopy job
Delete a QuickCopy job at the device control panel when you no longer need it. If the device requires
additional space to store new QuickCopy jobs, the device automatically deletes other stored QuickCopy
jobs, starting with the oldest job.
NOTE:

Stored QuickCopy jobs can be deleted at the control panel or in HP Web Jetadmin.

1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the job.

4.

Scroll to and touch the job that you want to delete.

5.

Touch Delete.

6.

Touch Yes.
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Use the stored job feature for copy jobs
You also can create a stored copy job at the control panel that can be printed at a later time.

Create a stored copy job
1.

Place the original document face-down on the glass or face-up in the ADF.

2.

From the Home screen, touch Job Storage.

3.

Touch Create.

4.

To create a Job Name, touch the New Job button to open the keyboard.

5.

Type the name of the folder on the touch screen keyboard.

6.

Select Job Name from the drop-down menu.

7.

Type the job name on the touch screen keyboard.

8.

If it is a private job, select PIN to print. Enter the PIN in the popup box.

9.

Touch OK.

10. After all the options are set, touch Start to scan the document and save the file.
For information about printing the job, see Print a stored job on page 133

Print a stored job
At the control panel, you can print a job that is stored on the device hard disk.
1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the stored job.

4.

Scroll to and touch the stored job that you want to print.

5.

Touch Retrieve Stored Job

6.

Select the number of copies on the numeric keypad to change the number of copies to print.

7.

Touch Retrieve Stored Job

If the file has lock symbol
job feature on page 131.

to print the document.

to print the document.

next to it, the job is a private job and requires a PIN. See Use the personal

Delete a stored job
Jobs stored on the device hard disk can be deleted at the control panel.
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1.

From the Home screen, touch Job Storage.

2.

Touch the Retrieve tab.

3.

Scroll to and touch the job storage folder that holds the stored job.

4.

Scroll to and touch the stored job that you want to delete.
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5.

Touch Delete.

6.

Touch Yes.

If the file has lock symbol
on page 131.

next to it, the job requires a PIN to delete it. See Use the personal job feature
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Print photos or marketing material
You can use the HP Color LaserJet CM6030 or HP Color LaserJet CM6040 to print high-quality color
photos, marketing and sales material, or other color documents on glossy paper. To maximize the quality
of this output you must do the following:
●

Choose the appropriate paper

●

Configure the paper tray correctly

●

Choose the correct settings in the print driver

Supported glossy paper
HP glossy paper product

Product code

Product size

Control panel and print
driver settings

HP Color Laser Presentation
Paper, Soft Gloss

Q6541A

Letter

HP soft gloss 120 g

HP Color Laser Professional
Paper, Soft Gloss

Q6542A

A4

HP soft gloss 120 g

HP Color Laser Brochure
Paper, Glossy

Q6611A, Q6610A

Letter

HP glossy 160 g

HP Color Laser Superior
Paper, Glossy

Q6616A

A4

HP glossy 160 g

HP Color Laser Photo Paper,
Glossy

Q6607A, Q6608A

Letter

HP glossy 220 g

HP Color Laser Photo Paper,
Glossy

Q6614A

A4

HP glossy 220 g

HP Color Laser Photo Paper,
Glossy 4x6

Q8842A

101.6 x 152.4 mm (4 x 6 in)

HP glossy 220 g

HP Color Laser Photo Paper,
Glossy 10 cm x 15 cm

Q8843A

101.6 x 152.4 mm (4 x 6 in)

HP glossy 220 g

CAUTION: HP Color Laser Presentation Paper, Glossy (Q2546A) is not supported with this product.
Using this type of paper can cause a fuser jam that might require the replacement of the fuser. Two
recommended alternatives are HP Color LaserJet Presentation Paper, Soft Gloss (Q6541A) and
HP Color LaserJet Brochure Paper, Glossy (Q6611A, Q6610A).

Configure the paper tray
Configure the paper tray for the correct paper type.
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1.

Load the paper into Tray 2, 3, 4, or 5.

2.

After you close the tray, the control panel prompts you to configure the paper size and type.

3.

If the correct size and type is displayed, touch OK to accept the detected size and type, or
Modify to choose a different paper size and type.
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4.

When the paper size prompt appears, touch the correct size, and then touch Save.

5.

When the paper type prompt appears, touch the correct type. See the table above to determine
the correct paper type.

Configure the driver settings
Carry out the following steps to print to glossy paper from your graphics software program.
1.

Select Print from the File menu of your software program.

2.

Select the HP Color LaserJet CM6030 or HP Color LaserJet CM6040, and then click Properties
or Printing Preferences.

3.

From the Paper type drop-down list, select the same paper type that you configured on the product
control panel.

4.

Click OK to save the settings and OK to print. The print job will automatically be printed from the
tray that has been configured for glossy paper, optimizing print quality for that type.
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Print weatherproof maps and outdoor signs
You can use the HP Color LaserJet CM6030 or HP Color LaserJet CM6040 to print durable, waterproof
maps, signs, or menus by using HP Tough Paper. HP Tough Paper is a waterproof, tear-proof, satin
finish paper that retains rich, vibrant print color and clarity even when exposed to heavy usage or
weather. This avoids the expensive and time-consuming laminating that is required with plain papers.
To maximize the quality of this output you must do the following:
●

Choose the appropriate paper

●

Configure the paper tray correctly

●

Choose the correct settings in the print driver

Supported tough paper
HP paper name

Product code

Product size

Control panel and print
driver settings

HP LaserJet Tough Paper

Q1298A

Letter

HP Tough Paper

HP LaserJet Tough Paper

Q1298B

A4

HP Tough Paper

Configure the paper tray
Configure the paper tray for the correct paper type.
1.

Load the paper into Tray 2, 3, 4, or 5.

2.

After you close the tray, the control panel prompts you to configure the paper size and type.

3.

If the correct size is displayed, touch OK to accept the detected size, or Modify to choose a different
paper size and type.

4.

When the paper size prompt appears, touch the correct size, and then touch Save. When the paper
type prompt appears, touch the correct type. See the table above to determine the correct paper
type.

Configure the driver settings
Carry out the following steps to print to tough paper from your graphics software program.
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1.

Select Print from the File menu of your software program.

2.

Select the HP Color LaserJet CM6030 and CM6040 MFP Series, and then click Properties or
Printing Preferences.

3.

From the Paper type drop-down list, select the same paper type that you configured on the product
control panel.

4.

Click OK to save the settings and OK to print. The print job will automatically be printed from the
tray that has been configured for tough paper.
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Set the duplex alignment
For duplexed documents such as brochures, set the registration for the tray before printing to ensure
the pages align.
1.

From the control panel, touch Administration and then touch Print Quality.

2.

Touch Set Registration, and then touch the tray you are adjusting.

3.

Touch Test Page and then touch Print.

4.

Follow the steps on the page that prints.
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Cancel a print job
You can stop a print request by using the control panel or by using the software program. For instructions
about how to stop a print request from a computer on a network, see the online Help for the specific
network software.
NOTE:

It can take some time for all printing to clear after you have canceled a print job.

Stop the current print job from the control panel
▲

Press Stop on the control panel.

Stop the current print job from the software program
A dialog box will appear briefly on the screen, giving you the option to cancel the print job.
If several requests have been sent to the device through your software, they might be waiting in a print
queue (for example, in Windows Print Manager). See the software documentation for specific
instructions about canceling a print request from the computer.
If a print job is waiting in a print queue (computer memory) or print spooler (Windows), delete the print
job there.
Click Start, click Settings, and then click Printers or Printers and Faxes . Double-click the device
icon to open the print spooler. Select the print job that you want to cancel, and then press Delete. If the
print job is not cancelled, you might need to shut down and restart the computer. If the job is not in the
print spooler, use the Job Status menu from control panel to cancel the job.
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Use features in the Windows printer driver
Open the printer driver
How do I

Steps to perform

Open the printer driver

On the File menu in the software program, click Print. Select
the printer, and then click Properties or Preferences.

Get help for any printing option

Click the ? symbol in the upper-right corner of the printer driver,
and then click any item in the printer driver. A pop-up message
displays that provides information about the item. Or, click
Help to open the online Help.

Use printing shortcuts
To perform the following tasks, open the printer driver and click the Printing Shortcuts tab.
NOTE:

In previous HP printer drivers, this feature was called Quick Sets.

How do I

Steps to perform

Use a printing shortcut

Select one of the shortcuts, and then click OK to print the job
with the predefined settings.

Create a custom printing shortcut

a) Select an existing shortcut as a base. b) Select the print
options for the new shortcut. c) Click Save As, type a name for
the shortcut, and click OK.

Set paper and quality options
To perform the following tasks, open the printer driver and click the Paper/Quality tab.
How do I

Steps to perform

Select a page size

Select a size from the Paper size drop-down list.

Select a custom page size

a) Click Custom. The Custom Paper Size dialog box opens.
b) Type a name for the custom size, specify the dimensions,
and click OK.

Select a paper source

Select a tray from the Paper source drop-down list.

Select a paper type

Select a type from the Paper type drop-down list.

Print covers on different paper

a) In the Special pages area, click Covers or Print pages on
different paper, and then click Settings. b) Select an option
to print a blank or preprinted front cover, back cover, or both.
Or, select an option to print the first or last page on different
paper. c) Select options from the Paper source and Paper
type drop-down lists, and then click Add. d) Click OK.

Print the first or last page on different paper

Adjust the resolution of printed images
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In the Print Quality area, select an option from the first dropdown list. See the printer-driver online Help for information
about each of the available options.
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Set document effects
To perform the following tasks, open the printer driver and click the Effects tab.
How do I

Steps to perform

Scale a page to fit on a selected paper size

Click Print document on, and then select a size from the dropdown list.

Scale a page to be a percent of the actual size

Click % of actual size, and then type the percent or adjust the
slider bar.

Print a watermark

a) Select a watermark from the Watermarks drop-down list.
b) To print the watermark on the first page only, click First page
only. Otherwise, the watermark is printed on each page.

Add or edit watermarks

a) In the Watermarks area, click Edit. The Watermark
Details dialog box opens. b) Specify the settings for the
watermark, and then click OK.

NOTE: The printer driver must be stored on your computer
for this to work.

Set document finishing options
To perform the following tasks, open the printer driver and click the Finishing tab.
How do I

Steps to perform

Print on both sides (Duplex)

Click Print on both sides. If you will bind the document along
the top edge, click Flip pages up.

Print a booklet

a) Click Print on both sides. b) In the Booklet layout dropdown list, click Left binding or Right binding. The Pages per
sheet option automatically changes to 2 pages per sheet.

Print multiple pages per sheet

a) Select the number of pages per sheet from the Pages per
sheet drop-down list. b) Select the correct options for Print
page borders, Page order, and Orientation.

Select page orientation

a) In the Orientation area, click Portrait or Landscape. b) To
print the page image upside down, click Rotate by 180
degrees.

Set product output options
To perform the following tasks, open the printer driver and click the Output tab.
NOTE:

The options that are available on this tab depend on the finishing device that you are using.

How do I

Steps to perform

Select staple options

Select a stapling option from the Staple drop-down list.

Select an output bin

Select an output bin from the Bin drop-down list.

Set job storage options
To perform the following tasks, open the printer driver and click the Job Storage tab.
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How do I

Steps to perform

Print one copy for proof before printing all the copies

In the Job Storage Mode area, click Proof and Hold. The
product prints the first copy only. A message appears on the
product control panel that prompts you to print the rest of the
copies.

Temporarily store a private job on the product and print it later

a) In the Job Storage Mode area, click Personal Job. b) In
the Make Job Private area, enter a 4-digit personal
identification number (PIN) (optional).

Temporarily store a job on the product

In the Job Storage Mode area, click Quick Copy. One copy
of the job is printed immediately, but you can print more copies
from the product control panel.

NOTE:

These jobs are deleted if the product is turned off.

Permanently store a job on the product

In the Job Storage Mode area, click Stored Job.

Make a permanently stored job private so that anyone who
tries to print it must provide a PIN

a) In the Job Storage Mode area, click Stored Job. b) In the
Make Job Private area, click PIN to print, and then enter a 4digit personal identification number (PIN).

Receive notification when someone prints a stored job

In the Job Notification Options area, click Display Job ID
when printing.

Set the user name for a stored job

In the User Name area, click User name to use the Windows
default user name. To provide a different user name, click
Custom and type the name.

Specify a name for the stored job

a) In the Job Name area, click Automatic to use the default
job name. To specify a job name, click Custom and type the
name. b) Select an option from the If job name exists dropdown list. Select Use Job Name + (1-99) to add a number to
the end of the existing name, or select Replace Existing
File to overwrite a job that already has that name.

Set color options
To perform the following tasks, open the printer driver and click the Color tab.
How do I

Steps to perform

Manually adjust color settings

a) In the Color Options area, click Manual, and then click
Settings. b) You can adjust the general settings for Edge
Control, and settings for text, graphics, and photographs. See
the online Help in the driver for information about each option.

Turn off color printing and use only shades of gray.

In the Color Options area, click Grayscale.

Change the way that colors are rendered

In the Color Themes area, select an option from the dropdown list. See the online Help in the driver for information about
each option.

Obtain support and product-status information
To perform the following tasks, open the printer driver and click the Services tab.
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How do I

Steps to perform

Obtain support information for the product and order supplies
online

In the Internet Services drop-down list, select a support
option, and click Go!

Check the status of the product, including the level of supplies

Click the Device and Supplies Status icon. The Device
Status page of the HP embedded Web server opens.

Set advanced printing options
To perform the following tasks, open the printer driver and click the Advanced tab.
How do I

Steps to perform

Select advanced printing options

In any of the sections, click a current setting to activate a dropdown list so you can change the setting.

Change the number of copies that are printed

Open the Paper/Output section, and then enter the number of
copies to print. If you select 2 or more copies, you can select
the option to collate the pages.

NOTE: If the software program that you are using does not
provide a way to print a particular number of copies, you can
change the number of copies in the driver.
Changing this setting affects the number of copies for all print
jobs. After your job has printed, restore this setting to the
original value.
Print colored text as black rather than as shades of gray

a) Open the Document Options section, and then open the
Printer Features section. b) In the Print All Text as Black
drop-down list, select Enabled.

Load letterhead or preprinted paper the same way for every
job, whether printing on one or both sides of the page

a) Open the Document Options section, and then open the
Printer Features section. b) In the Alternative Letterhead
Mode drop-down list, select On. c) At the product, load the
paper the same way you would for printing on both sides.

Change the order in which pages are printed

a) Open the Document Options section, and then open the
Layout Options section. b) In the Page Order drop-down list,
select Front to Back to print the pages in the same order as
they are in the document, or select Back to Front to print the
pages in the reverse order.
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Manage color
Setting color options to Automatic typically produces the best possible print quality for the most common
printing requirements. However, for some documents, setting the color options manually can enhance
the way the document appears. Examples of these documents include marketing brochures that contain
many images or documents that are printed on a paper type that is not listed in the printer driver.
Use the printer driver to adjust color settings. For more information, see Set color options
on page 143 for Windows and Set the color options on page 80 for Macintosh.

Automatic or manual color adjustment
The Automatic color adjustment option optimizes the neutral gray color treatment, halftones, and edge
enhancements that are used for each element in a document.
NOTE:

Automatic is the default setting and is recommended for printing most color documents.

The Manual color adjustment option allows you to adjust the neutral gray color treatment, halftones,
and edge enhancements for text, graphics, and photographs.

Manual color options
You can manually adjust color options for Edge Control, Halftones, and Neutral Grays.
Edge Control
The Edge Control setting determines how edges are rendered. Edge control has three components:
adaptive halftoning, Resolution Enhancement technology (REt), and trapping. Adaptive halftoning
increases the edge sharpness. Trapping reduces the effect of incorrect color alignment by slightly
overlapping the edges of adjacent objects. The color REt option smoothes the edges.
NOTE: If you notice white gaps between objects, or if you notice areas that have a slight shadow of
cyan, magenta, or yellow at the edge, choose an edge-control setting that increases the trapping level.
Four levels of edge control are available:
●

Maximum is the most aggressive trapping setting. Adaptive halftoning and color REt settings are
on.

●

Normal is the default trapping setting. Trapping is at a medium level. Adaptive halftoning and color
REt settings are on.

●

Light sets trapping at a minimal level. Adaptive halftoning and color REt settings are on.

●

Off turns off trapping, adaptive halftoning, and color REt.

Halftone options
Halftone options affect the resolution and clarity of your color output. You can select halftone settings
for text, graphics, and photographs independently. The two halftone options are Smooth and Detail.
●

The Smooth option provides better results for large, solid-filled print areas. It also enhances
photographs by smoothing out fine color gradations. Choose this option when uniform and smooth
area fills are top priority.

●

The Detail option is useful for text and graphics that require sharp distinctions among lines or
colors, or for images that contain a pattern or a high level of detail. Choose this option when sharp
edges and details are top priority.
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NOTE: Some software programs convert text or graphics to bitmap images. In these cases, setting
the color options for photographs also affects how text and graphics appear.
Neutral Grays
The Neutral Grays setting determines the method used for creating gray colors that are used in text,
graphics, and photographs.
Two values are available for the Neutral Grays setting:
●

Black Only generates neutral colors (grays and black) using only black toner. This guarantees
neutral colors without a color cast.

●

4-Color generates neutral colors (grays and black) by combining all four toner colors. This method
produces smoother gradients and transitions to non-neutral colors, and it produces the darkest
black.

Print in grayscale
Select the Print in Grayscale or Print Color as Gray option from the printer driver to print a document
in black and white.

Restrict color use
This product includes a Restrict Color setting. A network administrator can use the setting to restrict
user access to the color printing in order to conserve color toner. If you are unable to print in color, see
your network administrator.

Restrict color printing and copying from the control panel
1.

Scroll to and touch Administration and then touch Management.

2.

Touch Restrict Color Use.

3.

Touch Color printing access or Color copying access.

4.

Select one of the following options:

5.

●

Enable Color (default). This setting allows color-printing capabilities for all users.

●

Color If Allowed. The setting allows the network administrator to allow color use for select
users and/or applications. Use the embedded Web server to designate which users and/or
applications can print in color (Color printing access only).

●

Disable Color. This setting denies color-printing capabilities to all users.

Touch Save.

For more information about restricting and reporting color usage, go to www.hp.com/go/coloraccess.

RGB Color (Color Themes)
You can change RGB Color settings from the printer-driver. For more information on accessing the
printer driver, see Set color options on page 143 for Windows and Set the color options on page 80 for
Macintosh.
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Five values are available for the RGB Color setting:
●

Select Default (sRGB) for most printing needs. This setting instructs the product to interpret RGB
color as sRGB, which is the accepted standard of Microsoft and the World Wide Web Consortium
(W3C).

●

Select Image optimization (sRGB) to enhance documents in which the content is mainly bitmap
images, such as .GIF or .JPEG files. This setting instructs the product to use the best color matching
for rendering sRGB, bitmap images. This setting has no effect on text or vector-based graphics.
Using glossy paper in combination with this setting provides the maximum enhancement.

●

Select AdobeRGB for documents that use the AdobeRGB color space rather than sRGB. For
example, some digital cameras capture images in AdobeRBG, and documents that are produced
with Adobe PhotoShop use the AdobeRGB color space. When printing from a professional software
program that uses AdobeRGB, it is important that you turn off the color management in the software
program and allow the product software to manage the color space.

●

Select Custom Profile when you want to increase the color saturation in the midtones. Less
colorful objects are rendered more colorfully. You can download custom profiles from www.hp.com/
go/cljcm6030mfp_software or www.hp.com/go/cljcm6040mfp_software.
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Match colors
The process of matching product output color to your computer screen is quite complex because printers
and computer monitors use different methods of producing color. Monitors display colors by light pixels
using an RGB (red, green, blue) color process, but printers print colors using a CMYK (cyan, magenta,
yellow, and black) process.
Several factors can influence your ability to match printed colors to those on your monitor. These factors
include:
●

Paper

●

Printer colorants (inks or toners for example)

●

Printing process (inkjet, press, or laser technology for example)

●

Overhead lighting

●

Personal differences in perception of color

●

Software programs

●

Printer drivers

●

Computer operating system

●

Monitors and monitor settings

●

Video cards and drivers

●

Operating environment (humidity for example)

Keep the above factors in mind when colors on your screen do not perfectly match your printed colors.
For most users, the best method for matching colors on your screen to your product is to print sRGB
colors.

Sample book color matching
The process for matching product output to preprinted sample books and standard color references is
complex. In general, you can obtain a reasonably good match to a sample book if the inks used to create
the sample book are cyan, magenta, yellow, and black. These are usually referred to as process color
sample books.
Some sample books are created from spot colors. Spot colors are specially created colorants. Many of
these spot colors are outside of the range of the product. Most spot color sample books have companion
process sample books that provide CMYK approximations to the spot color.
Most process sample books will state which process standards were used to print the sample book. In
most cases they will be SWOP, EURO, or DIC. To get optimal color matching to the process sample
book, select the corresponding ink emulation from the product menu. If you cannot identify the process
standard, use SWOP ink emulation.

Printing color samples
To use the color samples, select the color sample that is the closest match to the desired color. Use the
sample’s color value in your software program to describe the object you wish to match. Colors may
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vary depending on paper type and the software program used. For more details on how to use the color
samples, go to www.hp.com/go/cljcm6030mfp_software or www.hp.com/go/cljcm6040mfp_software.
Use the following procedure to print color samples at the product using the control panel:
1.

Touch Administration and then touch Information.

2.

Touch Sample pages/fonts and then touch CMYK samples or RGB samples to print the samples.

PANTONE® color matching
PANTONE has multiple color matching systems. PANTONE MATCHING SYSTEM® is very popular
and uses solid inks to generate a wide range of color hues and tints. See www.hp.com/go/
cljcm6030mfp_software or www.hp.com/go/cljcm6040mfp_software for details on how to use
PANTONE Colors with this product.
NOTE: PANTONE Colors generated might not match PANTONE-identified standards. Consult current
PANTONE Publications for accurate color.
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Advanced color use
HP ImageREt 4800
HP ImageREt 4800 print technology is a system of innovative technologies developed exclusively by
HP to deliver superior print quality. The HP ImageREt system sets itself apart from the industry by
integrating technology advancements and optimizing each element of the print system. Several
categories of HP ImageREt have been developed for a variety of user needs.
The system uses key color-laser technologies, including image enhancements, smart supplies, and
high-resolution imaging, to provide superior images for general office documents and marketing
collateral. Optimized for printing on HP color laser high-gloss papers, HP Image REt 4800 provides
superior results on all supported paper, and under a variety of environmental conditions.

Paper selection
For the best color and image quality, it is important to select the appropriate paper type from the product
menu or from the front panel.

sRGB
Standard red-green-blue (sRGB) is a worldwide color standard originally developed by HP and Microsoft
as a common color language for monitors, input devices (scanners, digital cameras), and output devices
(products, printers, plotters). It is the default color space used for HP products, Microsoft operating
systems, the Web, and most office software sold today. sRGB is representative of the typical Windows
computer monitor today and the convergence standard for high-definition television.
NOTE: Factors such as the type of monitor you use and the room’s lighting can affect the appearance
of colors on your screen.
The latest versions of Adobe PhotoShop, CorelDRAW™, Microsoft Office, and many other software
programs use sRGB to communicate color. Most importantly, as the default color space in Microsoft
operating systems, sRGB has gained broad adoption as a means to exchange color information between
software programs and devices using a common definition that assures typical users will experience
greatly improved color matching. sRGB improves your ability to match colors between the product, the
computer monitor, and other input devices (scanner, digital camera) automatically, without the need to
become a color expert.

Print in four colors — CMYK
Cyan, magenta, yellow, and black (CMYK) are the inks used by a printing press. The process is often
called four-color printing. CMYK data files are typically used by and originate from graphic arts (printing
and publishing) environments. The product will accept CMYK colors through the PS printer driver. The
product color-rendering of CMYK is designed to provide rich, saturated colors for text and graphics.

CMYK ink set emulation (HP postscript level 3 emulation)
The product color rendering of CMYK can be made to emulate several standard offset press ink sets.
In some situations, the CMYK color values in an image or document might not be suited to the product.
For example, a document might be optimized for another product. For best results, the CMYK values
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should be adapted to the HP Color LaserJet CM6030 or HP Color LaserJet CM6040. Select the
appropriate color input profile from the printer driver.
●

Default CMYK+. HP CMYK+ technology produces optimal printing results for most printing jobs.

●

Specification for Web Offset Publications (SWOP). Common ink standard in the United States
and other countries/regions.

●

Euroscale. Common ink standard in Europe and other countries/regions.

●

Dainippon Ink and Chemical (DIC). Common ink standard in Japan and other countries/regions.

●

Custom profile. Select this option to use a custom input profile to accurately control color output,
for example, to emulate another HP color LaserJet product. To download color profiles, go to
www.hp.com and search for "CM6030 mfp color profile" or "CM6040 mfp color profile".
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Use the Copy screen
From the Home screen, touch Copy to view the Copy screen. Only the first six copy features are
immediately visible. In order to view additional copy features, touch More Options.

Set the default copy options
You can use the administration menu to establish default settings that apply to all copy jobs. If necessary,
you can override most settings for an individual job. After that job is complete, the product returns to the
default settings.
1.

From the Home screen, scroll to and touch Administration.

2.

Touch Default Job Options, and then touch Default Copy Options.

3.

Several options are available. You can configure defaults for all options, or for only some options.
For information about each option, see Adjust the copy settings on page 155. The built-in Help
system also provides an explanation of each option. Touch the Help button
in the upper-right
corner of the screen.

4.

To exit the administration menu, touch the Home button

in the upper-left corner of the screen.

Copy from the scanner glass
Use the scanner glass to make as many as 999 copies of small, lightweight media (less than 60 g/m2
or 16 lb) or heavy media (more than 105 g/m2 or 28 lb). This includes media such as receipts, newspaper
clippings, photographs, old documents, worn documents, and books.
Place original documents face-down on the glass. Align the corner of the original with the upper-left
corner of the glass.
To make copies by using the default copy options, use the numeric keypad on the control panel to select
the number of copies, and press Start. To use customized settings, touch Copy. Specify the settings,
and then press Start. For more information about using customized settings, see Adjust the copy settings
on page 155.

Copy from the document feeder
Use the document feeder to make as many as 999 copies of a document that has up to 50 pages
(depending on the thickness of the pages). Place the document into the document feeder with the pages
facing up.
To make copies by using the default copy options, use the numeric keypad on the control panel to select
the number of copies, and press Start. To use customized settings, touch Copy. Specify the settings,
and then press Start. For more information about using customized settings, see Adjust the copy settings
on page 155.
Before starting another copy job, retrieve the original document from the document-feeder output bin
that is under the document feeder input tray, and retrieve the copies from the appropriate output bin.
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Adjust the copy settings
The product offers several features so you can optimize copied output. These features are all available
on the Copy screen.
The Copy screen consists of several pages. From the first page, touch More Options to go to the next
page. Then touch the up or down arrow buttons to scroll to other pages.
button in the upperFor details about how to use an option, touch the option, and then touch the help
right corner of the screen. The following table provides an overview of the copy options.
NOTE: Depending on how the system administrator has configured the product, some of these options
might not appear. The options in the table are listed in the order in which they can appear.
Option name

Description

Sides

Use this feature to indicate whether the original document is printed on one or both sides, and
whether the copies should be printed on one or both sides.

Reduce/Enlarge

Use this feature to reduce or enlarge the copied image on the page.

Color/Black

Use this feature to choose black printing or color printing.

Staple/Collate or Collate

If the optional HP Stapler/Stacker/Separator is attached, the Staple/Collate option is available.
Use this feature to set up options for stapling and assembling the pages in sets of copies.
If the optional HP Stapler/Stacker/Separator is not attached, the Collate option is available. Use
this feature to assemble each set of copied pages in the same order as the original document.
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Paper Selection

Use this feature to select the tray that holds the size and type of paper that you want to use.

Image Adjustment

Use this feature to improve the overall quality of the copy. For example, you can adjust the
darkness and sharpness, and you can use the Background Cleanup setting to remove faint
images from the background or to remove a light background color.

Content Orientation

Use this feature to specify the way the content of the original page is placed on the page: portrait
or landscape.

Output Bin

Use this feature to select an output bin for the copies.

Optimize Text/Picture

Use this feature to optimize the output for a particular type of content. You can optimize the
output for text or printed pictures, or you can manually adjust the values.

Pages per Sheet

Use this feature to copy multiple pages onto one sheet of paper.

Original Size

Use this feature to describe the page size of the original document.

Book Copy

Use this feature to scan and print pages from a book.

Booklet Format

Use this feature to copy two or more pages onto one sheet of paper so you can fold the sheets
in the center to form a booklet.

Edge-To-Edge

Use this feature to avoid shadows that can appear along the edges of copies when the original
document is printed close to the edges. Combine this feature with the Reduce/Enlarge feature
to ensure that the entire page is printed on the copies.

Job Build

Use this feature to combine several sets of original documents into one copy job. Also use this
feature to copy an original document that has more pages than the document feeder can
accommodate at one time.
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Copy two-sided documents
Two-sided documents can be copied manually or automatically.

Copying two-sided documents manually
Copies resulting from this procedure are printed on one side, and need to be hand-collated.
1.

Load the documents to be copied into the document feeder input tray with the first page facing up,
and with the top of the page leading into the document feeder.

2.

Touch Start Copy. The odd-numbered pages are copied and printed.

3.

Remove the stack from the document feeder output tray and reload the stack with the last page
facing up, and with the top of the page leading into the document feeder.

4.

Touch Start Copy. The even-numbered pages are copied and printed.

5.

Collate the odd- and even-numbered printed copies.

Copy two-sided documents automatically
The default copy setting is one-sided to one-sided. Use the following procedures to change the setting
so you can copy from or to documents that are two-sided.
Make two-sided copies from one-sided documents
1.

Load the documents to be copied into the document feeder with the first page facing up, and with
the top of the page leading.

2.

On the control panel, touch Copy.

3.

Touch Sides.

4.

Touch 1-sided original, 2-sided output.

5.

Touch OK.

6.

Touch Start Copy.

Make two-sided copies from two-sided documents
1.

Load the documents to be copied into the document feeder with the first page facing up, and with
the top of the page leading.

2.

On the control panel, touch Copy.

3.

Touch Sides.
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4.

Touch 2-sided original, 2-sided output.

5.

Touch OK.

6.

Touch Start Copy.

Make one-sided copies from two-sided documents
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1.

Load the documents to be copied into the document feeder with the first page facing up, and with
the top of the page leading.

2.

On the control panel, touch Copy.

3.

Touch Sides.

4.

Touch 2-sided original, 1-sided output.

5.

Touch OK.

6.

Touch Start Copy.
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Copy mixed-size originals
You can copy original documents that are printed on different sizes of paper as long as the sheets of
paper have one common dimension. For example, you could combine letter and legal sizes, or you could
combine A4 and A5 sizes.
1.

Arrange the sheets in the original document so they all have the same width.

2.

Place the sheets face-up into the document feeder, and adjust both paper guides against the
document.

3.

From the Home screen, touch Copy.

4.

Touch Original Size.
NOTE: If this option is not on the first screen, touch More Options until the option appears.

5.

Select Mixed Ltr/Lgl, and then touch OK.

6.

Touch Start Copy.
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Change the copy-collation setting
You can set the device to automatically collate multiple copies into sets. For example, if you are making
two copies of three pages and the automatic collation is on, the pages print in this order: 1,2,3,1,2,3. If
automatic collation is off, the pages print in this order: 1,1,2,2,3,3.
To use the automatic collation, the original document size must fit into the memory. If it does not, the
device makes only one copy and a message appears notifying you of the change. If that happens, use
one of the following methods to finish the job:
●

Split the job into smaller jobs that contain fewer pages.

●

Make only one copy of the document at a time.

●

Turn off the automatic collation.

The collation setting you select is in effect for all copies until you change the setting. The default setting
for automatic copy collation is On.
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1.

On the control panel, touch Copy.

2.

Touch Staple/Collate or Collate.

3.

Touch Off.

4.

Touch OK.
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Copy photos and books
Copy a photo
NOTE:

Photos should be copied from the flatbed scanner, not from the document feeder.

1.

Lift the lid and place the photo on the flatbed scanner with the picture-side down and the upperleft corner of the photo in the upper-left corner of the glass.

2.

Gently close the lid.

3.

Touch Copy.

4.

Touch Optimize Text/Picture and select Photograph.

5.

Touch Start Copy.

Copy a book
1.

Place the book face down on the glass with the top edge toward the rear of the glass. Align the
along the top edge of the glass.
book spine with the book icon

2.

Touch Copy.

3.

Scroll to and touch Book Copy .

4.

Touch Book Copy On and then touch OK.

5.

Select the number of copies to make and adjust other settings as needed.

6.

Touch Start Copy, or press the Start button on the control panel.

7.

The following 3 options are available when Start Copy is touched:
●

Copy both pages copies the images on both the left and right side of the spine

●

Skip left page copies the image on the right side of the spine only

●

Skip right page copies the image on the left side of the spine only

8.

Touch Scan.

9.

After the last page is scanned, touch Finish.
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Combine copy jobs by using Job Build
Use this feature to combine several sets of original documents into one copy job. Also use this feature
to copy an original document that has more pages than the document feeder can accommodate at one
time.
1.

Touch Copy.

2.

Scroll to and touch Job Build.

3.

Touch Job Build On.

4.

Touch OK.

5.

If necessary, select the desired copy options.

6.

Touch Start Copy. After each page is scanned, the control panel prompts you for more pages.

7.

If the job contains more pages, load the next page, and then touch Scan.
The product temporarily saves all the scanned images. The product will begin printing copies when
it has enough information to begin. Touch Finish to finish printing the copies.

NOTE: In Job Build, if you scan the first page of a document by using the document feeder, then you
must scan all of the pages in that document by using the document feeder. If you scan the first page of
a document by using the scanner glass, then you must scan all of the pages in that document by using
the scanner glass.

ENWW

Combine copy jobs by using Job Build 161

Cancel a copy job
1.

Touch the Stop button on the control panel and then touch the job from the list.

2.

Touch Cancel Job and then touch OK.

NOTE: If you cancel a copy job, clear the document from the flatbed scanner or from the automatic
document feeder.
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Configure e-mail settings
The product offers color-scanning and digital-sending capabilities. By using the control panel, you can
scan black-and-white or color documents and send them to an e-mail address as an e-mail attachment.
To use digital sending, the product must be connected to a local area network (LAN).
NOTE:

The e-mail icon is not shown on the control panel if e-mail is not configured.

Before you can send a document to e-mail, you must configure the product.
NOTE: The instructions that follow are for configuring the product at the control panel. You can also
perform these procedures by using the embedded Web server. For more information, see
Embedded Web server on page 183.

Supported protocols
The HP Color LaserJet CM6030 and HP Color LaserJet CM6040 MFP models support Simple Mail
Transfer Protocol (SMTP) and Lightweight Directory Access Protocol (LDAP).
SMTP
●

SMTP is a set of rules that define the interaction between programs that send and receive e-mail.
In order for the device to send documents to e-mail, it must be connected to a LAN that has access
to an e-mail server that supports SMTP. The SMTP server must also have Internet access.

●

If you are using a LAN connection, contact your system administrator to obtain the IP address or
host name for your SMTP server. If you are connecting through a DSL or cable connection, contact
the internet service provider to obtain the SMTP server IP address.

●

LDAP is used to gain access to a database of information. When the device uses LDAP, it searches
a global list of e-mail addresses. As you begin to type the e-mail address, LDAP uses an autocomplete feature that supplies a list of e-mail addresses that match the characters you type. As
you type additional characters, the list of matching e-mail addresses becomes smaller.

●

The device supports LDAP, but a connection to an LDAP server is not required in order for the
device to be able to send to e-mail.

LDAP

NOTE: If you need to change the LDAP settings, you must change them by using the embedded
Web server. For more information, see Embedded Web server on page 183, or see the Embedded
Web Server User Guide on the product Administrator CD.

Configure e-mail server settings
Find the SMTP gateway
1.

From the Home screen, touch Administration

2.

Touch Initial Setup.

3.

Touch E-mail Setup, and then touch Find Send Gateways.

4.

Touch Find.
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Configure the SMTP gateway address
1.

From the Home screen, touch Administration.

2.

Touch Initial Setup.

3.

Touch E-mail Setup, and then touch SMTP Gateway.

4.

Type the SMTP gateway address, either as an IP address or as a fully qualified domain name. If
you do not know the IP address or domain name, contact the network administrator.

5.

Touch Save.

Test the SMTP settings
1.

From the Home screen, touch Administration.

2.

Touch Initial Setup.

3.

Touch E-mail Setup, and then touch Test.
If the configuration is correct, Gateways OK appears on the control-panel display.

If the first test was successful, send an e-mail to yourself by using the digital-send feature. If you receive
the e-mail, you have successfully configured the digital-sending feature.
If you do not receive the e-mail, use these actions to resolve issues with the digital-sending software:
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●

Check the SMTP and address to make sure that you typed them correctly.

●

Print a configuration page. Verify that the SMTP gateway address is correct.

●

Make sure that the network is operating correctly. Send an e-mail to yourself from a computer. If
you receive the e-mail, the network is operating correctly. If you do not receive the e-mail, contact
your network administrator or Internet service provider (ISP).
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Use the Send E-mail screen
Use the touchscreen to navigate through the options on the Send E-mail screen.

1

Send E-mail button

Touching this button scans the document and sends an e-mail file to the provided e-mail
addresses.

2

Home button

Touching this button opens the Home screen.

3

From: field

Touch this field to open the keyboard, and then type your e-mail address. If the system
administrator has configured the device to do so, this field might automatically insert a default
address.

4

To: field

Touch this field to open the keyboard, and then type the e-mail addresses of those whom you
want to receive the scanned document.

5

Subject: field

Touch this field to open the keyboard, and then type a subject title.

6

More Options button

Touch this button to change certain e-mail settings for the current scan job.

7

Scroll bar

Use the scroll bar to view and set up the CC:, BCC:, Message, and File Name fields. Touch any
of those fields to open the keyboard and add the necessary information.

8

Address book buttons

Touch these buttons to use the address book to populate the To:, CC:, or BCC: fields. For more
information, see Use the local address book on page 169.

9

Help button

Touch this button for control-panel help. For more information, see Use the control panel
on page 14.

10

Error/warning button

This button appears only when there is an error or warning in the status line area. Touch it to open
a pop-up screen that will help you resolve the error or warning.
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Perform basic e-mail functions
The product e-mail feature offers the following benefits:
●

Sends documents to multiple e-mail addresses, saving time and delivery costs.

●

Delivers files in black-and-white or in color. Files can be sent in different file formats that the
recipient can manipulate.

With e-mail, documents are scanned into the product memory and sent to an e-mail address or multiple
addresses as an e-mail attachment. Digital documents can be sent in several graphics formats, such
as .TFF and .JPG, which allows recipients to manipulate the document file in various programs to meet
their specific needs. Documents arrive in near-original quality, and then can be printed, stored, or
forwarded.
In order to use the e-mail feature, the product needs to be connected to a valid SMTP local area network
that includes Internet access.

Load documents
You can scan a document by using either the glass or the ADF. The glass and ADF can accommodate
Letter-, Executive-, A4-, and A5-size originals. The ADF can also accommodate Legal-size originals.
Smaller originals, receipts, irregular and worn documents, stapled documents, previously folded
documents, and photographs should be scanned by using the glass. Multiple-page documents can be
scanned easily by using the ADF.

Send documents
The product scans both black-and-white and color originals. You can use default settings or change the
scanning preferences and file formats. The following are the default settings:
●

Color

●

PDF (requires the recipient to have an Adobe Acrobat viewer to view the e-mail attachment)

For information about changing the settings for the current job, see Change e-mail settings for the current
job on page 170.

Send a document
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1.

Place the document face-down on the scanner glass or face-up in the ADF.

2.

From the Home screen, touch E-mail.

3.

If prompted, type your user name and password.

4.

Complete the From:, To:, and Subject: fields. Scroll down and complete the CC:, and BCC: fields
if appropriate. Your user name or other default information might appear in the From: field. If so,
you might not be able to change it.

5.

(Optional) Touch More Options to change the settings for the document that you are sending (for
example, the document’s original size). If you are sending a two-sided document, you should select
Sides and an option with a two-sided original.

6.

Press Start to begin sending.

7.

When you are finished, remove the original document from the scanner glass or ADF.
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Use the auto-complete function
When you type characters into the To:, CC:, or From: fields on the Send E-mail screen, the autocomplete function is activated. As you type the required address or name by using the keyboard screen,
the device automatically searches the address book list and completes the address or name by using
the first match. You can then select that name by touching Enter, or continue typing the name until autocomplete finds the correct entry. If you type a character that does not match any entry in the list, the
auto-complete text is removed from the display to indicate that you are typing an address that is not in
the address book.

Use the address book
You can send e-mail to a list of recipients by using the address book feature of the product. See your
system administrator for information about configuring address lists.
NOTE: You can also use the embedded Web server (EWS) to create and manage the e-mail address
book. The EWS e-mail address book can be used to add, edit, or delete single e-mail addresses or email distribution lists. For more information, see Embedded Web server on page 183.

Create a recipient list
1.

From the Home screen, touch E-mail.

2.

Complete one of the following steps:
●

Touch To: to open the keyboard screen, and then type the recipients' e-mail addresses.
Separate multiple e-mail addresses with a semicolon or by touching Enter on the touchscreen.

●

Use the address book.
a.

On the Send E-mail screen, touch the address book button

b.

Navigate the entries in the address book by using the scroll bar. Hold down the arrow to
scroll quickly through the list.

c.

Highlight the name to select a recipient, and then touch the arrow button

to open the address book.

.

You can also select a distribution list by touching the drop-down list at the top of the
screen and then touching All, or add a recipient from a local list by touching Local in the
drop-down list. Highlight the appropriate names, and then touch the arrow button
to
add the name to your list of recipients.
You can remove a recipient from your list by scrolling to highlight the recipient, and then
touching the remove button
in the middle of the screen.
3.

The names in the recipient list are placed in the text line of the keyboard screen. If you want, you
can add a recipient that is not found in the address book by typing the e-mail address on the
keyboard. After you are satisfied with your recipient list, touch OK.

4.

Touch OK.

5.

Finish typing information in the CC: and Subject: fields on the Send E-mail screen, if necessary.
You can check the list of recipients by touching the down arrow in the To: text line.

6.

Press Start.
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Use the local address book
Use the local address book to store frequently-used e-mail addresses. The local address book can be
shared between devices that use the same server to gain access to the HP Digital Sending software.
You can use the address book when you type e-mail addresses in the From:, To:, CC:, or BCC: fields.
You can also add or delete addresses in the address book.
To open the address book, touch the address book button

.

Add e-mail addresses to the local address book
1.

Touch Local.

2.

Touch the add button

3.

(Optional) Touch the Name field, and in the keyboard that appears type a name for the new entry.
Touch OK.

.

The name is the alias for the e-mail address. If you do not type an alias name, the alias will be the
e-mail address itself.
4.

Touch the Address field, and in the keyboard that appears type the e-mail address for the new
entry. Touch OK.

Delete e-mail addresses from the local address book
You can delete e-mail addresses that you no longer use.
NOTE: To change an e-mail address, you must first delete the address and then add the corrected
address as a new address in the local address book.
1.

Touch Local.

2.

Touch the e-mail address that you want to delete.

3.

Touch the remove button

in the lower right corner.

The following confirmation message appears: Do you want to delete the selected address(es)?
4.
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Touch Yes to delete the e-mail address(es) or touch No to return to the Address Book screen.
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Change e-mail settings for the current job
Use the More Options button to change the following e-mail settings for the current print job:
Button

Description

Document File Type

Touch this button to change the type of file the device creates after scanning the document.

Output Quality

Touch this button to increase or decrease the print quality of the file being scanned. A higher quality
setting produces a larger file size.

Resolution

Touch this button to change the scan resolution. A higher resolution setting produces a larger file size.

Color/Black

Touch this button to determine whether you will scan the document in color or in black-and-white.

Original Sides

Touch this button to indicate if the original document is one-sided or two-sided.

Content Orientation

Touch this button to select either the portrait or landscape orientation for the original.

Original Size

Touch this button to select the size of the document: letter, A4, legal, or mixed letter/legal.

Optimize Text/
Picture

Touch this button to change the scanning procedure based on the type of document that you are
scanning.

Job Build

Touch this button to activate or deactivate the Job Build mode, which enables you to scan several small
scan jobs and send them as one file.

Image Adjustment

Touch this button to change the darkness and sharpness settings, or to clean up background clutter on
the original.
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Scan to a folder
If the system administrator has made the feature available, the device can scan a file and send it to a
folder on the network. Supported operating systems for folder destinations include Windows 2000,
Windows XP, and Windows Server 2003.
NOTE: You might be required to supply a user name and password in order to use this option, or to
send to certain folders. See your system administrator for more information.
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1.

Place the document face-down on the scanner glass or face-up in the ADF.

2.

From the Home screen, touch Network Folder.

3.

In the Quick Access Folders list, select the folder in which you want to save the document.

4.

Touch the File Name field to open the keyboard pop-up screen, and then type the file name.

5.

Touch Send to Network Folder.
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Scan to a workflow destination
NOTE:

This device feature is provided by the optional Digital Sending Software.

If the system administrator has enabled the workflow functionality, you can scan a document and send
it to a custom workflow destination. A workflow destination gives you the ability to send additional
information, along with the scanned document, to a specified network or file transfer protocol (FTP)
location. Prompts for specific information appear on the control-panel display. The system administrator
can also designate a printer as a workflow destination, which allows you to scan a document and then
send it directly to a network printer for printing.
1.

Place the document face-down on the scanner glass or face-up in the ADF.

2.

From the Home screen, touch Workflow.

3.

Select the destination to which you want to scan.

4.

In the Text Field field, type the data that you want to accompany the file, and then touch Send
Workflow.
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●

Analog fax

●

Digital fax
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Analog fax
When the analog fax accessory is installed, the product can function as a standalone fax machine.
The HP Color LaserJet CM6030f MFP or HP Color LaserJet CM6040f MFP models come with a fax
accessory already installed. For the HP Color LaserJet CM6030 MFP or HP Color LaserJet CM6040
MFP (base models), you can order this accessory as an option. See Part numbers on page 281 for
information about ordering the analog fax accessory. Specifications for the Analog Fax Accessory are
available in the HP LaserJet Analog Fax Accessory 300 User Guide. An electronic version of this guide
is located on the User CD that comes with the product. The Analog Fax Accessory 300 Fax Guide and
the Analog Fax Accessory 300 Send Fax Driver Guide are also located on the product User CD or at
www.hp.com/go/mfpfaxaccessory300.

Connect the fax accessory to a phone line
When connecting the fax accessory to a phone line, ensure that the phone line being used for the fax
accessory is a dedicated line that is not used by any other devices. Also, this line should be an analog
line because the fax will not function correctly if it is connected to some digital PBX systems. If you are
not sure whether you have an analog or digital phone line, contact your telecom provider.
NOTE: HP recommends using the phone cord that comes with the fax accessory to ensure that the
accessory functions correctly.
Follow these instructions to connect the fax accessory to a phone jack.
1.

Locate the phone cord that is included with the fax accessory kit. Connect one end of the phone
cord into the fax accessory phone jack that is on the formatter. Push the connector until it clicks.

CAUTION: Be sure to connect the phone line to the fax accessory port, which is located in the
center of the formatter. Do not connect the phone line to the HP Jetdirect port, which is nearer the
bottom of the formatter.
2.

Connect the other end of the phone cord into the phone jack on the wall. Push the connector until
it clicks or until it is securely seated. Because different types of connectors are used in different
countries/regions, the connector might not make an audible click.

Configure and use the fax features
Before you can use the fax features, you must configure them in the control-panel menus. For complete
information about configuring and using the fax accessory, and for information about troubleshooting
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problems with the fax accessory, see the HP LaserJet Analog Fax Accessory 300 User Guide. This
guide is provided with the fax accessory, and it is also available on the product User CD.
Use the Send Fax driver to send a fax from a computer without going to the product control panel. See
the HP LaserJet MFP Analog Fax Accessory 300 Send Fax Driver Guide for more information.
The HP LaserJet Analog Fax Accessory 300 User Guide and HP LaserJet MFP Analog Fax Accessory
300 Send Fax Driver Guide are both available on the product User CD.
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Digital fax
Digital faxing is available when you install the optional HP Digital Sending Software. For information
about ordering this software, go to www.hp.com/go/digitalsending
With digital faxing, the product does not need to be connected directly to a phone line. Instead, the
product can send a fax in one of three ways:
●

LAN fax sends faxes through a third-party fax provider.

●

Microsoft Windows 2000 fax is a fax modem and Digital Sender Module on a computer that allows
the computer to operate as a turnkey gateway fax.

●

Internet fax uses an Internet fax provider to process faxes, and the fax is delivered on a traditional
fax machine or sent to the user’s e-mail.

For complete information about using digital faxing, see the documentation that is provided with the
HP Digital Sending Software.
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●

Information pages

●

HP Easy Printer Care

●

Embedded Web server

●

Use HP Web Jetadmin software

●

Security features

●

Set the real-time clock

●

Manage supplies

●

Replace supplies

●

Clean the product

●

ADF maintenance kit

●

Calibrate the scanner

●

Upgrade the firmware
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Information pages
Information pages provide details about the device and its current configuration. The following table
provides the instructions for printing the information pages.
Page description

How to print the page from the product control panel

Menu map

1.

From the Home screen, touch Administration.

Shows the control-panel menus and
available settings.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Administration Menu Map.

5.

Touch Print.

The content of the menu map varies, depending on the options currently installed in
the device.
For a complete list of control panel menus and possible values, see Use the control
panel on page 14.
Configuration page

1.

From the Home screen, touch Administration.

Shows device settings and installed
accessories.

2.

Touch Information.

3.

Touch Configuration/Status Pages.

4.

Touch Configuration Page.

5.

Touch Print.

NOTE: If the device contains an HP Jetdirect print server or an optional hard disk
drive, additional configuration pages print that provide information about those
devices.
Supplies status page

1.

From the Home screen, touch Administration.

Shows print-cartridge toner levels.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Supplies Status Page.

5.

Touch Print.

NOTE: If you are using non-HP supplies, the supplies status page might not show
the remaining life for those supplies.
Usage page

1.

From the Home screen, touch Administration.

Shows a page count for each size of
paper printed, the number of one-sided
(simplexed) or two-sided (duplexed)
pages, and the average percentage of
coverage.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Usage Page.

5.

Touch Print.

1.

From the Home screen, touch Administration

2.

Touch Information

3.

Touch Configuration/status Pages

Color usage job log
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Page description

How to print the page from the product control panel
4.

Touch Color Usage Job Log

5.

Touch Print

File directory

1.

From the Home screen, touch Administration.

Contains information for any mass
storage devices, such as flash drives,
memory cards, or hard disks, that are
installed in the device.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch File Directory.

5.

Touch Print.

1.

From the Home screen, touch Administration.

Fax reports

Five reports show fax activity, fax calls, 2.
billing codes, blocked fax numbers, and
3.
speed-dial numbers.
NOTE: Fax reports are available only
on device models that have fax
capabilities.

4.

5.

Touch Information.
Touch Fax Reports.
Touch one of the following buttons to print the corresponding report:
◦

Fax Activity Log

◦

Fax Call Report

◦

Billing Codes Report

◦

Blocked Fax List

◦

Speed Dial List

Touch Print.

For more information, see the fax guide that came with the device.
Font lists

1.

From the Home screen, touch Administration.

Shows which fonts are currently
installed in the device.

2.

Touch Information.

3.

Touch Sample Pages/Fonts.

4.

Touch one of the following buttons to print the corresponding report:

5.

◦

Demonstration Page

◦

RGB Samples

◦

CMYK Samples

◦

PCL Font List

◦

PS Font List

Touch Print.

NOTE: The font lists also show which fonts reside on a hard disk accessory or
DIMM.
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HP Easy Printer Care
Open the HP Easy Printer Care software
Use one of the following methods to open the HP Easy Printer Care software:
●

On the Start menu, select Programs, select Hewlett-Packard, select HP Easy Printer Care, and
then click Start HP Easy Printer Care.

●

In the Windows system tray (in the lower-right corner of the desktop), double-click the HP Easy
Printer Care icon.

●

Double-click the desktop icon.

HP Easy Printer Care software sections
HP Easy Printer Care software can provide information about multiple HP products that are on your
network as well as any products that are directly connected to your computer. Some of the items that
are in the following table might not be available for every product.
The Help button (?) in the upper-right corner of each page provides more detailed information about the
options on that page.
Section

Options

Device List tab

●

Devices list: Shows the products that you can select.
NOTE: The product information appears either in list form or as icons,
depending on the setting for the View as option.

When you open the software, this is the
first page that appears.
NOTE: To return to this page from any
tab, click My HP Printers in the left side
of the window.

●

The information on this tab includes current alerts for the product.

●

If you click a product in the list, the HP Easy Printer Care opens the
Overview tab for that product.

Compatible Printers

Provides a list of all the HP products that support HP Easy Printer Care software.

Find Other Printers window
Add more products to the
My HP Printers list

Click the Find Other Printers link in the Devices list to open the Find Other
Printers window. The Find Other Printers window provides a utility that detects
other network printers so that you can add them to the My HP Printers list and then
monitor those products from your computer.

Overview tab

●

Device Status section: This section shows product-identification information
and the product status. It indicates product-alert conditions, such as an empty
print cartridge. After you correct a problem with the product, click the refresh
in the upper-right corner of the window to update the status.
button

●

Supplies Status section: Shows detailed supplies status, such as the
percentage of toner remaining in the print cartridge and the status of the paper
that is loaded in each tray.

●

Supplies Details link: Opens the supplies status page to view more detailed
information about product supplies, ordering information, and recycling
information.

Contains basic status information for the
device
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Section

Options

Support tab

●

Device Status section: This section shows product-identification information
and the product status. It indicates product-alert conditions, such as an empty
print cartridge. After you correct a problem with the product, click the refresh
in the upper-right corner of the window to update the status.
button

●

Device Management section: Provides links to information about HP Easy
Printer Care, to advanced product settings, and to product usage reports.

●

Troubleshooting and Help: Provides links to tools that you can use to resolve
problems, to online product support information, and to online HP experts.

Settings tab

●

About: Provides general information about this tab.

Configure product settings, adjust printquality settings, and find information
about specific product features

●

General: Provides information about the product, such as the model number,
serial number, and the settings for date and time, if they are available.

●

Information Pages: Provides links to print the information pages that are
available for the product.

●

Capabilities: Provides information about product features, such as duplexing,
the available memory, and the available printing personalities. Click Change
to adjust the settings.

●

Print Quality: Provides information about print-quality settings. Click
Change to adjust the settings.

●

Trays / Paper: Provides information about the trays and how they are
configured. Click Change to adjust the settings.

●

Restore Defaults: Provides a way to restore the product settings to the factory
defaults. Click Restore to restore the settings to the defaults.

Provides links to support information

NOTE: This tab is not available for
some products.

HP Proactive Support
NOTE: This item is available from the
Overview and Support tabs.

Supplies Ordering button

When enabled, HP Proactive Support routinely scans your printing system to identify
potential problems. Click the more info link to configure how frequently the scans
occur. This page also provides information about available updates for product
software, firmware, and HP printer drivers. You can accept or decline each
recommended update.
●

Ordering list: Shows the supplies that you can order for each product. To order
a certain item, click the Order check box for that item in the supplies list. You
can sort the list by product, or by the supplies that need to be ordered the
soonest. The list contains supplies information for every product that is in the
My HP Printers list.

●

Shop Online for Supplies button: Opens the HP SureSupply Web site in a
new browser window. If you have checked the Order check box for any items,
the information about those items can be transferred to the Web site, where
you will receive information on options for purchasing your selected supplies.

●

Print Shopping List button: Prints the information for the supplies that have
the Order check box selected.

Click the Supplies Ordering button on
any tab to open the Supplies Ordering
window, which provides access to online
supplies ordering.
NOTE: This item is available from the
Overview and Support tabs.

Alert Settings link
NOTE: This item is available from the
Overview and Support tabs.

Color Access Control
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Click Alert Settings to open the Alert Settings window, in which you can configure
alerts for each product.
●

Alerting is on or off: Activates or deactivates the alerts feature.

●

Printer Alerts: Select the option to receive alerts for critical errors only, or for
any error.

●

Job Alerts: For products that support it, you can receive alerts for specific print
jobs.

Use this feature to permit or restrict color printing.
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Section

Options

NOTE: This item is available only for
HP color products that support Color
Access Control.
NOTE: This item is available from the
Overview and Support tabs.
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Embedded Web server
Use the embedded Web server to view product and network status and to manage printing functions
from your computer instead of from the product control panel. The following are examples of what you
can do using the embedded Web server:
NOTE: When the printer is directly connected to a computer, use the HP Easy Printer Care to view
the printer status.
●

View product status information.

●

Set the type of media that is loaded in each tray.

●

Determine the remaining life for all supplies and order new ones.

●

View and change tray configurations.

●

View and change the product control-panel menu configuration.

●

View and print internal pages.

●

Receive notification of product and supplies events.

●

View and change network configuration.

To use the embedded Web server, you must have Microsoft Internet Explorer 5.01 or later or Netscape
6.2 or later for Windows, Mac OS, and Linux (Netscape only). Netscape Navigator 4.7 is required for
HP-UX 10 and HP-UX 11. The embedded Web server works when the product is connected to an IPbased network. The embedded Web server does not support IPX-based product connections. You do
not have to have Internet access to open and use the embedded Web server.
When the product is connected to the network, the embedded Web server is automatically available.
NOTE: For complete information about using the embedded Web server, see the Embedded Web
Server User Guide, which is on the product Administrator CD.

Open the embedded Web server by using a network connection
1.

In a supported Web browser on your computer, type the device IP address or host name in the
address/URL field. To find the IP address or host name, print a configuration page. See Information
pages on page 178.
NOTE:
future.

2.

After you open the URL, you can bookmark it so that you can return to it quickly in the

The embedded Web server has four tabs that contain settings and information about the device:
the Information tab, the Settings tab, the Networking tab, and the Digital Sending tab. Click the
tab that you want to view.
See Embedded Web server sections on page 184 for more information about each tab.
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Embedded Web server sections
Tab or section

Options

Information tab

●

Device Status: Shows the device status and shows the life remaining of HP supplies,
with 0% indicating that a supply is empty. The page also shows the type and size of
print paper set for each tray. To change the default settings, click Change
Settings.

●

Configuration Page: Shows the information found on the configuration page.

●

Supplies Status: Shows the life remaining of HP supplies, with 0 percent indicating
that a supply is empty. This page also provides supplies part numbers. To order new
supplies, click Shop for Supplies in the Other Links area on the left side of the
window.

●

Event log: Shows a list of all device events and errors.

●

Usage page: Shows a summary of the number of pages the device has printed,
grouped by size and type.

●

Device Information: Shows the device network name, address, and model
information. To change these entries, click Device Information on the Settings tab.

●

Control Panel: Shows messages from the device control panel, such as Ready or
Sleep mode on.

●

Print: Allows you to send print jobs to the device.

Settings tab

●

Configure Device: Allows you to configure device settings. This page contains the
traditional menus found on devices using a control-panel display.

Provides the ability to configure the
device from your computer

●

E-mail Server: Network only. Used in conjunction with the Alerts page to set up
incoming and outgoing e-mail, as well as to set e-mail alerts.

●

Alerts: Network only. Allows you to set up to receive e-mail alerts for various device
and supplies events.

●

AutoSend: Allows you to configure the device to send automated e-mails regarding
device configuration and supplies to specific e-mail addresses.

●

Security: Allows you to set a password that must be entered to gain access to the
Settings and Networking tabs. Enable and disable certain features of the
embedded Web server.

●

Authentication Manager: Allows you to determine which device functions will
require a user to provide log-in information in order to use those functions.

●

LDAP Authentication: Allows you to configure a Lightweight Directory Access
Protocol (LDAP) server to limit device access to certain users. The LDAP server will
require a user to provide log-in information in order to gain access to the device.

●

Edit Other Links: Allows you to add or customize a link to another Web site. This
link is displayed in the Other Links area on all embedded Web server pages.

●

Device Information: Allows you to name the device and assign an asset number to
it. Enter the name and e-mail address for the primary contact who will receive
information about the device.

●

Language: Allows you to determine the language in which to display the embedded
Web server information.

●

Date & Time: Allows time synchronization with a network time server.

●

Wake Time: Allows you to set or edit a wake time for the device.

Provides device, status, and
configuration information

184 Chapter 14 Manage and maintain the product

ENWW

Tab or section

Options
NOTE: The Settings tab can be password-protected. If this device is on a network,
always consult with the system administrator before changing settings on this tab.

Digital Sending tab

Use the pages on the Digital Sending tab to configure the digital-sending features.
NOTE: If the product is configured to use the optional HP Digital Sending Software, the
options on these tabs are not available. Instead, all digital-sending configuration is
performed by using the HP Digital Sending Software.

Fax tab
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●

General. Set up contact information for the system administrator.

●

Send to E-mail. Configure the e-mail settings for digital sending. You can specify
the SMTP server, the default "From" address, and the default subject. You can also
set the maximum file size that is allowed for attachments.

●

E-mail Address Book. The E-mail Address Book page enables you to add e-mail
addresses into the product one at a time, and to edit e-mail addresses that have
already been saved in the product. You can also use the Import/Export tab to load a
large list of frequently-used e-mail addresses on to the product all at once, rather
than adding them one at a time.

●

Import/Export. Use this tab to import or export .CSV files containing e-mail
addresses, fax numbers, or user records, so that they can be accessed on this
product. You can also export e-mail, fax, or user records from the device into a file
on your computer. You can then use this file as a data backup, or you can use it to
import the records onto another HP device.

●

Log. View the digital-sending activity log for the product. The log contains digitalsending job information, including any errors that occur.

●

Preferences. Configure digital-sending defaults such as the default page-size and
the default settings-reset delay. You can also configure these settings by using the
product control-panel menus.

The Fax tab contains options to configure and use the fax capabilities of the product. For
additional information about fax functions, see the Fax User Guide.
●

Use the Fax Settings screen to configure the send-to-fax features for the product.

●

The Fax Address Book page enables you to add fax numbers into the product one
at a time, and to edit fax numbers that have already been saved in the product. You
can also use the Import/Export feature on the Digital Sending tab to load a large list
of frequently-used fax numbers on to the device all at once, rather than adding them
one at a time.

●

Use the Fax Speed Dials screen to add, edit, or delete fax speed dial entries to and
from the product. You can use fax speed dials to store frequently used fax numbers
or lists of up to 100 fax numbers. Up to 100 speed dial entries can be configured.
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Tab or section

Options

Networking tab

Network administrators can use this tab to control network-related settings for the device
when it is connected to an IP-based network. This tab does not appear if the device is
directly connected to a computer, or if the device is connected to a network using anything
other than an HP Jetdirect print server.

Provides the ability to change
network settings from your
computer

NOTE:
Other links

The Networking tab can be password-protected.

●

HP Instant Support™: Connects you to the HP Web site to help you find solutions.
This service analyzes your device error log and configuration information to provide
diagnostic and support information specific to your device.

●

Shop for Supplies: Connects to the HP SureSupply Web site, where you will receive
information on options for purchasing original HP supplies, such as print cartridges
and paper.

●

Product Support: Connects to the support site for the device, from which you can
search for help regarding general topics.

Contains links that connect you to
the Internet

NOTE: You must have Internet access in order to use any of these links. If you use a
dial-up connection and did not connect when you first opened the embedded Web server,
you must connect before you can visit these Web sites. Connecting might require that you
close the embedded Web server and reopen it.
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Use HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. The intuitive browser interface simplifies cross-platform
management of a wide range of devices, including HP and non-HP devices. Management is proactive,
allowing network administrators the ability to resolve issues before users are affected. Download this
free, enhanced-management software at www.hp.com/go/webjetadmin_software.
To obtain plug-ins to HP Web Jetadmin, click plug-ins, and then click the download link that is next to
the name of the plug-in that you want. The HP Web Jetadmin software can automatically notify you
when new plug-ins are available. On the Product Update page, follow the directions to automatically
connect to the HP Web site.
If installed on a host server, HP Web Jetadmin is available to any client through a supported Web
browser, such as Microsoft Internet Explorer 6.0 for Windows or Netscape Navigator 7.1 for Linux.
Browse to the HP Web Jetadmin host.
NOTE:
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Browsers must be Java-enabled. Browsing from an Apple PC is not supported.
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Security features
Secure the embedded Web server
Assign a password for access to the embedded Web server so that unauthorized users cannot change
the product settings.
1.

Open the embedded Web server. See Embedded Web server on page 183.

2.

Click the Settings tab.

3.

On the left side of the window, click Security.

4.

Type the password next to New Password, and type it again next to Verify Password.

5.

Click Apply. Make note of the password and store it in a safe place.

Foreign Interface Harness (FIH)
The Foreign Interface Harness (FIH) provides a portal on the product. By using the FIH and third-party
equipment, you can track information about copies that are made on the product.

Requirements
●

Windows 2000 or Windows XP

●

Access to third-party accounting hardware solutions, such as Equitrac or Copitrak devices

Use the FIH
To use the FIH, you must download and install the FIH software. The software is available from
www.hp.com/go/cljcm6030mfp_software and www.hp.com/go/cljcm6040mfp_software. The software is
used to enable or disable the FIH portal. Use the software to set and change the administrator personal
identification number (PIN).
Administrators can use the PIN option to configure the FIH to prevent any unauthorized changes.
Changes can be made only with the correct PIN authentication.
NOTE: It is important to remember the PIN that is assigned to the FIH administration software. The
PIN is required to make any changes to the FIH.
Enable the FIH portal
1.

Double-click the FIH.EXE file. The Foreign Interface Harness dialog box appears.

2.

Click OK.

3.

Click Enable.

4.

If you have not entered a PIN before, click No. If you have entered a PIN before, click Yes. If you
click No, type and confirm the PIN, and then click OK. If you click Yes, type the PIN and click
OK.
NOTE: The PIN must be numeric.

5.

Click the appropriate button for the type of connection: Direct or Network. If Direct is selected,
type the product port. If Network is selected, type the IP address and port for the product.
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NOTE:

The IP address for the product can be found on the Configuration page.

If you typed an incorrect IP address, you will receive an error message. Otherwise, the portal is enabled.
Disable the FIH portal
1.

Double-click the FIH.EXE file. The Foreign Interface Harness dialog box appears.

2.

Click OK.

3.

Click Disable.

4.

Type the PIN and click OK.

5.

Click the appropriate button for the type of connection: Direct or Network. If Direct is selected,
type the product port and click OK. If Network is selected, type the IP address and port for the
product, and then click OK. The portal is disabled.

NOTE: If you lose the PIN number and the portal needs to be disabled, try using the default PIN that
is listed to disable it. For assistance, use the HP Instant Support service, which is available through the
embedded Web server or at www.hp.com/go/instantsupport. See Embedded Web server
on page 183.

Secure Disk Erase
To protect deleted data from unauthorized access on the product hard drive, use the Secure Disk Erase
feature. This feature can securely erase print and copy jobs from the hard drive.
Secure Disk Erase offers the following levels of disk security:
●

Non-Secure Fast Erase. This is a simple file-table erase function. Access to the file is removed,
but actual data is retained on the disk until it is overwritten by subsequent data-storage operations.
This is the fastest mode. Non-Secure Fast Erase is the default erase mode.

●

Secure Fast Erase. Access to the file is removed, and the data is overwritten with a fixed identical
character pattern. This is slower than Non-Secure Fast Erase, but all data is overwritten. Secure
Fast Erase meets the U.S. Department of Defense 5220-22.M requirements for the clearing of disk
media.

●

Secure Sanitizing Erase. This level is similar to the Secure Fast Erase mode. In addition, data is
repetitively overwritten by using an algorithm that prevents any residual data persistence. This
mode will impact performance. Secure Sanitizing Erase meets the U.S. Department of Defense
5220-22.M requirements for the sanitization of disk media.

Data affected
Data affected (covered) by the Secure Disk Erase feature includes temporary files that are created
during the print and copying process, stored jobs, proof and hold jobs, disk-based fonts, disk-based
macros (forms), stored fax files, address books, and HP and third-party applications.
NOTE: Stored jobs will be securely overwritten only when they have been deleted through the
Retrieve Job menu on the product after the appropriate erase mode has been set.
This feature will not impact data that is stored on flash-based product non-volatile RAM (NVRAM) that
is used to store default settings, page counts, and similar data. This feature does not affect data that is
stored on a system RAM disk (if one is used). This feature does not impact data that is stored on the
flash-based system boot RAM.
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Changing the Secure Disk Erase mode does not overwrite previous data on the disk, nor does it
immediately perform a full-disk sanitization. Changing the Secure Disk Erase mode changes how the
product cleans up temporary data for jobs after the erase mode has been changed.

Gain access to Secure Disk Erase
Use HP Web Jetadmin to gain access to and set the Secure Disk Erase feature.

Additional Information
For additional information about the HP Secure Disk Erase feature, see the HP support flyer or go to
www.hp.com/go/webjetadmin/.

DSS authentication
Optional Digital Sending Software (DSS) for the product is available for purchase separately. The
software provides an advanced sending program that contains an authentication process. This process
requires users to type a user identification and a password before they can use any of the DSS features
that require authentication.

Lock the control-panel menus
To prevent someone from changing the product configuration, you can lock the control-panel menus.
This prevents unauthorized users from changing the configuration settings such as the SMTP server.
The following procedure describes how to restrict access to the control-panel menus by using the
HP Web Jetadmin software. (See Use HP Web Jetadmin software on page 187.)
1.

Open the HP Web Jetadmin program.

2.

Open the DEVICE MANAGEMENT folder in the drop-down list in the Navigation panel. Navigate
to the DEVICE LISTS folder.

3.

Select the product.

4.

In the Device Tools drop-down list, select Configure.

5.

Select Security from the Configuration Categories list.

6.

Type a Device Password.

7.

In the Control Panel Access section, select Maximum Lock. This prevents unauthorized users
from gaining access to configuration settings.
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Set the real-time clock
Use the real-time clock feature to set the date and time settings. The date and time information is
attached to stored print, fax, and digital-send jobs, so you can identify the most recent versions of stored
print jobs.

Set the date format
1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Date Format.

5.

Touch the desired format.

6.

Touch Save.

Set the date
1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Date.

5.

Touch the appropriate options to set the correct month, date of the month, and the year.

6.

Touch Save.

Set the time format
1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Time Format.

5.

Touch the appropriate format.

6.

Touch Save.

Set the time
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1.

On the control panel, scroll to and touch Administration.

2.

Touch Time/Scheduling.

3.

Touch Date/Time.

4.

Touch Time.
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5.

Touch the appropriate options to set the correct hour, minute, and AM/PM setting.

6.

Touch Save.
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Manage supplies
Use genuine HP print cartridges for the best printing results.

Print-cartridge storage
Do not remove the print cartridge from its package until you are ready to use it.
CAUTION:
minutes.

To prevent damage to the print cartridge, do not expose it to light for more than a few

HP policy on non-HP print cartridges
Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.
CAUTION: Any damage caused by a non-HP print cartridge is not covered under the HP warranty
and service agreements.
To install a new HP print cartridge, see Change print cartridges on page 195. To recycle the used
cartridge, follow the instructions included with the new cartridge.

HP fraud hotline and Web site
Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the control-panel message says the cartridge
is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.
Your print cartridge might not be a genuine HP print cartridge if you notice the following:
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●

You are experiencing a high number of problems with the print cartridge.

●

The cartridge does not look like it usually does (for example, the orange pull tab is missing, or the
packaging differs from HP packaging).
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Replace supplies
When you use genuine HP supplies, the product automatically notifies you when supplies are nearly
depleted. The notification to order supplies allows ample time to order new supplies before they need
to be replaced. For more information about ordering supplies, see Supplies and accessories
on page 279

Locate supplies
Supplies are identified by their labeling and their blue plastic handles.
The following figure illustrates the location of each supply item.
Figure 14-1 Supply item locations
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1

Image drums

2

Print cartridges

3

Document feeder kit

4

Fuser

5

Transfer unit

6

Transfer roller

Supply replacement guidelines
To facilitate the replacement of supplies, keep the following guidelines in mind when setting up the
product.
●

Allow sufficient space in the front and on the right side of the product for removing supplies.

●

The product should be located on a flat, sturdy surface.

For instructions on installing supplies, see the installation guides provided with each supply item or see
more information at www.hp.com/go/cljcm6030mfp_software or www.hp.com/go/
cljcm6040mfp_software. When you connect, select Solve a Problem.
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CAUTION: Hewlett-Packard recommends the use of genuine HP products in this product. Use of nonHP products may cause problems requiring service that is not covered by the Hewlett-Packard extended
warranty or service agreements.

Approximate replacement intervals for supplies
The following table lists the estimated replacement intervals for supplies and the control panel messages
that prompt when to replace each item. Usage conditions and print patterns may cause results to vary.

1

Item

Printer message

Page count

Approximate time period

Print cartridges

Replace <color> Cartridge

17,000 pages1 for color

4 months for color

20,000 pages for black

5 months for black

Image drums

Replace <color> Drum

35,000 pages1

Image transfer kit

Replace Transfer Kit

150,000 pages2

37 months

Image fuser kit

Replace Fuser Kit

100,000 pages

25 months

Roller kit

Replace Roller Kit

100,000 pages

25 months

Stapler cartridge

Replace Stapler Cartridge

5000 staples

Booklet maker staple
cartridges

Replace Staple Cartridges 2
and 3

2,000 booklets

Document feeder kit

Replace Document Feeder
Kit

60,000 pages

50 months

Approximate average A4-/letter-size page count based on 2-page jobs printed from Tray 2, with 5% coverage of individual
colors.

2

Approximate life is based on 4,000 pages per month.

Change print cartridges
When a print cartridge approaches the end of its useful life, the control panel displays a message
recommending that you order a replacement. The product can continue to print using the current print
cartridge until the control panel displays a message instructing you to replace the cartridge.
The product uses four colors and has a different print cartridge for each color: black (K), magenta (M),
cyan (C), and yellow (Y).
Replace a print cartridge when the control panel displays a Replace <color> Cartridge message. The
control panel display will also indicate the color that should be replaced (if a genuine HP cartridge is
currently installed). Replacement instructions are included in the print-cartridge box.
CAUTION: If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water. Hot
water sets toner into fabric.
NOTE:
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Information about recycling used print cartridges is on the print-cartridge box.
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Replace print cartridges
1.

Grasp the grips on the sides of the front door and pull down to open.

2.

Grasp the handle of the used print cartridge and pull out to remove.

3.

Store the used print cartridge in a protective bag. Information about recycling used print cartridges
is on the print-cartridge box.

4.

Remove additional print cartridges in the same manner.
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5.

Remove the new print cartridge from its protective bag.

NOTE:
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Store the protective bag in a secure place for future use.

6.

Hold both sides of the cartridge and shake up and down 5-6 times.

7.

Align the print cartridge with its slot and insert the print cartridge until it clicks into place.

8.

Insert additional print cartridges in the same manner.
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9.

Grasp the grips on the sides of the front door and lift up to close.

To recycle the used print cartridge, follow the instructions included with the new print cartridge.

Change image drums
When an image drum approaches the end of its useful life, the control panel displays a message
recommending that you order a replacement. The product can continue to print using the current image
drum until the control panel displays a message instructing you to replace the image drum.
The product uses four colors and has a different image drums for each color: black (K), magenta (M),
cyan (C), and yellow (Y).
Replace an image drum when the control panel displays Replace <color> Drum message. The controlpanel display also indicates the color that should be replaced (if a genuine HP cartridge is currently
installed). Replacement instructions are included in the image drum box.
CAUTION: If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water. Hot
water sets toner into fabric.
NOTE:

Information about recycling used image drums is on the image drum box.
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Replace image drums
1.

Grasp the grips on the sides of the front door and pull down to open.

2.

With one hand, lift and slowly pull the used image drum out of the product, while supporting the
image drum with your other hand.

CAUTION: If reusing the same image drum, do not touch the green cylinder on the bottom of the
drum because it can damage the drum.
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3.

Store the used image drum in a protective bag. Information about recycling used image drums is
on the image drum box.

4.

Remove additional image drums in the same manner.
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5.

Remove the new image drum from its protective bag.

NOTE: Store protective bag in a secure place for future use.
NOTE: Do not shake the image drum.
CAUTION: Do not touch the green cylinder on the bottom of the image drum because it can
damage the drum.
6.

Align the image drum with the correct slot and insert the image drum until it clicks into place. The
gray protective cover on the bottom of the drum automatically slides off as the image drum is
inserted. You can discard this cover.

7.

Insert additional image drums in the same manner.

8.

Grasp the grips on the sides of the front door and lift up to close.
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To recycle the used image drum, follow the instructions included with the new image drum.

Install memory
You can install more memory for the product.
CAUTION: Static electricity can damage DIMMs. When handling DIMMs, either wear an antistatic
wrist strap, or frequently touch the surface of the DIMM antistatic package and then touch bare metal
on the product.

Install DDR memory DIMMs
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1.

Turn the product off.

2.

Disconnect all power and interface cables.
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3.

Locate the black formatter pressure release tabs on the formatter board in the rear of the product.

4.

Gently press the black tabs toward each other.

5.

Gently pull on the black tabs to pull the formatter board from the product. Place the formatter board
on a clean, flat, grounded surface.
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6.

To replace a DIMM that is currently installed, spread the latches apart on each side of the DIMM
slot, lift the DIMM up at an angle, and pull it out.
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7.

Remove the new DIMM from the antistatic package. Locate the alignment notch on the bottom
edge of the DIMM.

8.

Holding the DIMM by the edges, align the notch on the DIMM with the bar in the DIMM slot at an
angle and firmly press the DIMM into the slot until it is fully seated. When installed correctly, the
metal contacts are not visible.
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9.

Push down on the DIMM until both latches engage the DIMM.
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NOTE: If you have difficulty inserting the DIMM, make sure the notch on the bottom of the DIMM
is aligned with the bar in the slot. If the DIMM still does not go in, make sure you are using the
correct type of DIMM.
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10. Align the formatter board in the tracks at the bottom of the slot, and then slide the board back into
the product.
CAUTION:
the tracks.

To prevent damage to the formatter board, ensure the formatter board is aligned in

11. Reconnect the power cable and interface cables, and turn the product on.

12. To enable the new memory, go to Enable memory on page 204.

Enable memory
If you installed a memory DIMM, set the product driver to recognize the newly added memory.
Enable memory for Windows 2000 and XP
1.

On the Start menu, point to Settings, and click Printers or Printers and Faxes.

2.

Right-click the product and select Properties.

3.

On the Device Settings tab, click Printer Memory (in the Installable Options section).

4.

Select the total amount of memory that is now installed.

5.

Click OK.
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Install an HP Jetdirect or EIO print server card or EIO hard disk
The HP Color LaserJet CM6030 and CM6040 MFP Series are equipped with an embedded print server
port. If desired, you can install an additional I/O card in the available EIO slot.
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1.

Turn the product off.

2.

Disconnect all power and interface cables.
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3.

Locate an open EIO slot. Loosen and remove the two retaining screws holding the cover for the
EIO slot, and then remove the cover. You will not need these screws and the cover again. They
can be discarded.

4.

Firmly insert the HP Jetdirect print server card into the EIO slot.

5.

Insert and tighten the retaining screws that came with the print server card.
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6.

Reconnect the power cable and remaining interface cables, and turn the product on.

7.

Print a configuration page. In addition to a product configuration page and a Supplies Status page,
an HP Jetdirect configuration page that contains network configuration and status information
should also print.
If it does not print, turn the power to the device off and uninstall and reinstall the print server card
to ensure that it is completely seated in the slot.

8.

Perform one of these steps:
●

Choose the correct port. See the computer or operating system documentation for
instructions.

●

Reinstall the software, choosing the network installation this time.

Replace the staple cartridge
If the optional HP 3-bin Stapler/Stacker Accessory or HP Booklet Maker/Finisher Accessory runs out of
staples while it is stapling a print job, the product automatically stops, if set to stop when out. If the
product is set to continue when out, the product will continue to print without stapling.
NOTE: Only replace the staple cartridge unit when the stapler/stacker or booklet maker has run out
of staples. Removing the staple cartridge at other times can cause an error to occur.
NOTE: When the stapler/stacker or booklet maker runs out of staples, the stapler unit will return to its
default position automatically.
Replace the staple cartridge
1.
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Open the front door of the booklet maker or stapler/stacker.
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2.

Push up to on the staple cartridge to remove it from the booklet maker or stapler/stacker.

3.

Insert the replacement staple cartridge unit into the stapler unit.

4.

Push the staple cartridge unit into the stapler unit until it clicks into position.

5.

Close the front door.
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Replace saddle stitch staple cartridges in the booklet maker
1.

Open the front door of the booklet maker.

2.

Grasp the blue handle and pull the staple carriage out of the booklet maker.

3.

Grasp the small blue handle on the staple cartridge unit and pull it toward you, then swing the staple
cartridge unit into an upright position.

2
1

4.
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Grasp the edges of each staple cartridge and pull up firmly to remove the staple cartridges from
the staple cartridge unit.
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5.

Unpack the new cartridges and remove the plastic packing lock from each one.

6.

Hold the new cartridges so that the arrows on the cartridges align with the arrows on the staple
cartridge unit and insert them into the unit.

7.

Pull the handle of the staple cartridge unit toward you and rotate it downward to its original position.
Lock it into position by pushing in the handle.

1
2
8.

Push the staple carriage back into the booklet maker finisher.
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9.
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Close the front door of the booklet maker.
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Clean the product
To maintain print quality, clean the product thoroughly every time you replace the print cartridge and
whenever print-quality problems occur.
WARNING! Avoid touching the fusing area when cleaning the product. It can be hot.
CAUTION: To avoid permanent damage to the print cartridge, do not use ammonia-based cleaners
on or around the product except as directed.

Clean the outside of the product
●

Clean the outside of the product if it is visibly marked.

●

Use a soft, lint-free cloth dampened with water, or water and a mild detergent.

Clean the touchscreen
Clean the touchscreen whenever it is necessary to remove fingerprints or dust. Wipe the touchscreen
gently with a clean, water-dampened, lint-free cloth.
CAUTION: Use water only. Solvents or cleaners can damage the touchscreen. Do not pour or spray
water directly onto the touchscreen.

Clean the scanner glass
●

Clean the scanner glass only if dirt is visible, or if you are experiencing a decrease in copy quality,
such as streaking.

●

Clean the scanner glass by wiping it gently with a clean, slightly damp, lint-free cloth. Use an
ammonia-based surface cleaner only when a water-dampened cloth does not clean the scanner
glass.

CAUTION: Do not pour or spray liquids directly onto the scanner glass. Do not press hard on the glass
surface. (You could break the glass).

Cleaning the ADF delivery system
Clean the ADF only if it is visibly marked or dirty, or if you are experiencing a decrease in copy quality
(such as streaking).
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1.

Open the scanner lid.

2.

Locate the white, vinyl ADF backing.

3.

Clean the ADF backing by wiping them with a clean, damp, lint-free cloth. Use an ammonia-based
surface cleaner only when a water-dampened cloth does not clean the ADF components.

4.

Clean the scanner glass by wiping it gently with a clean, slightly damp, lint-free cloth. Use an
ammonia-based surface cleaner only when a water-dampened cloth does not clean the scanner
glass.

5.

Close the scanner lid.
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Clean the ADF rollers
You should clean the rollers in the ADF if you are experiencing misfeeds or if your originals show marks
as they exit the ADF.
CAUTION: Clean the rollers only if you experience misfeeds or marks on the originals, and you notice
dust on the rollers. Cleaning the rollers frequently could introduce dust into the device.
1.

Pull the release lever to open the ADF cover.

2.

Locate the rollers.

3.

Wipe the rollers with a clean, water-dampened, lint-free cloth.
CAUTION:

Do not pour water directly onto the rollers. Doing so might damage the device.

4.

Locate the separation pad.

5.

Wipe the pad with a clean, water-dampened, lint-free cloth.
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6.
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Close the ADF cover.
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ADF maintenance kit
After feeding 60,000 pages through the ADF, a Replace Document Feeder Kit message appears on
the control-panel display. This message appears approximately one month before the kit needs to be
replaced. Order a new kit when this message appears. See Part numbers on page 281 for information
about ordering a new ADF maintenance kit.
The ADF maintenance kit includes the following items:
●

One pick-up roller assembly

●

One separation pad

●

An instruction sheet

Follow the instructions that come with the kit to install it.
After replacing the kit, reset the ADF maintenance-kit count.
Reset the ADF maintenance-kit count
1.

On the control panel, scroll to and touch Administration.

2.

Touch Resets.

3.

Touch Reset Supplies.

4.

Touch ADF Maintenance Kit.

5.

Touch Yes.

6.

Touch Save.
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Calibrate the scanner
Calibrate the scanner to compensate for offsets in the scanner imaging system (carriage head) for ADF
and flatbed scans. Because of mechanical tolerances, the scanner's carriage head might not read the
position of the image accurately. During the calibration procedure, scanner offset values are calculated
and stored. The offset values are then used when producing scans so that the correct portion of the
document is captured.
Scanner calibration should be carried out only if you notice offset problems with the scanned images.
The scanner is calibrated before it leaves the factory. It needs to be calibrated again only rarely.
Before calibrating the scanner, print the calibration target.
1.

Place letter- or A4-size paper in tray 1, and adjust the side guides.

2.

On the control-panel Home screen, scroll to and touch Administration.

3.

Touch Troubleshooting.

4.

Touch Calibrate Scanner.

5.

Touch Calibrate to print the first pass of the calibration target.

6.

Place the first pass of the calibration target face-down in tray 1 so that the arrows are facing into
the product.

7.

Touch Start to print the second pass. The final calibration target must look like the following figure.

CAUTION: If the calibration target does not look like the figure shown here, the calibration
process will fail and the quality of scans will be degraded. The black areas must extend completely
to the short edges of the page. If they do not, use a black marker to extend the black areas to the
edge of the page. Ensure that the paper is loaded properly.
8.

Place the calibration target face-up into the ADF, and adjust the side guides.

9.

After the calibration target has passed through the ADF once, reposition it face down in the ADF
and touch Start.

10. Place the calibration target face-down on the scanner glass, touch Start, and scan the page. After
this pass, the calibration is complete.
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Upgrade the firmware
The product has remote firmware update (RFU) capability. Use the information in this section to upgrade
the product firmware.

Determine the current firmware version
1.

From the control panel Home screen, scroll to and touch Administration.

2.

Touch Information.

3.

Touch Configuration/status Pages.

4.

Touch Configuration Page.

5.

Touch Print.

The firmware datecode is listed on the Configuration page in the section called Device Information.
The firmware datecode has this format: YYYYMMDD XX.XXX.X. The first string of numbers is the date,
where YYYY represents the year, MM represents the month, and DD represents the date. For example,
a firmware datecode of that begins with
20061125
represents November 25, 2006.

Download new firmware from the HP Web site
To find the most recent firmware upgrade for the product, go to www.hp.com/go/
cljcm6030mfp_firmware or www.hp.com/go/cljcm6040mfp_firmware. This page provides instructions
for downloading the new firmware version.

Transfer the new firmware to the product
NOTE:

The product can receive an .RFU file update when it is in a "ready" state.

The elapsed time for an update depends on the I/O transfer time, as well as the time that it takes for the
product to re-initialize. The I/O transfer time depends on a number of things, including the speed of the
host computer that is sending the update. If the remote firmware update process is interrupted before
the firmware is downloaded (while Receiving Upgrade appears on the control-panel display), the
firmware file must be sent again. If power is lost during the flash DIMM update (while the Performing
Upgrade message appears on the control-panel display), the update is interrupted and the message
Resend Upgrade appears (in English only) on the control-panel display. In this case, you must send
the upgrade by using the parallel port. Finally, any jobs that are ahead of the RFU job in the queue are
completed before the update is processed.

Use FTP to upload the firmware through a browser
NOTE: The firmware update involves a change in the format of nonvolatile random-access memory
(NVRAM). Any menu settings that are changed from the default settings might return to default settings
and must be changed again if you want settings that are different from the defaults.
1.

Print a configuration page and note the TCP/IP address shown on the EIO Jetdirect page.

2.

Open a browser window.

3.

In the address line of the browser, type
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ftp://<ADDRESS>
, where <ADDRESS> is the address of the product. For example, if the TCP/IP address is
192.168.0.90, type
ftp://192.168.0.90
.
4.

Locate the downloaded .RFU file for the product.

5.

Drag and drop the .RFU file onto the PORT1 icon in the browser window.

NOTE: The product turns off and then on automatically to activate the update. When the update
process is complete, a Ready message displays on the product control panel.

Use FTP to upgrade the firmware on a network connection
NOTE: The firmware update involves a change in the format of nonvolatile random-access memory
(NVRAM). Any menu settings that are changed from the default settings might return to default settings
and must be changed again if you want settings that are different from the defaults.
1.

Take note of the IP address on the HP Jetdirect page. The HP Jetdirect page is the second page
that prints when you print the configuration page.
NOTE: Before upgrading the firmware, make sure that the product is not in Sleep mode. Also
make sure that any error messages are cleared from the control-panel display.

2.

Open an MS-DOS command prompt on your computer.

3.

Type: ftp TCP/IP ADDRESS>. For example, if the TCP/IP address is 192.168.0.90, type ftp
192.168.0.90.

4.

Go to the folder where the firmware file is stored.

5.

Press Enter on the keyboard.

6.

When prompted for the user name, press Enter.

7.

When prompted for the password, press Enter.

8.

Type bin at the command prompt.

9.

Press Enter. The message 200 Types set to I, Using binary mode to transfer files appears in
the command window.

10. Type put and then the file name (for example, if the file name is CM6040mfp.efn, type put
CM6040mfp.efn).
11. The download process begins and the firmware is updated on the product. This can take
approximately five minutes. Let the process finish without further interaction with the product or
computer.
NOTE:

The product automatically turns off and then on again after processing the upgrade.

12. At the command prompt, type: bye to exit the ftp command.
13. At the command prompt, type: exit to return to the Windows interface.
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Use HP Web Jetadmin to upgrade the firmware
This procedure requires that you install HP Web Jetadmin Version 7.0 or later on your computer. See
Use HP Web Jetadmin software on page 187. Complete the following steps to update a single device
through HP Web Jetadmin after downloading the .RFU file from the HP Web site.
1.

Start HP Web Jetadmin.

2.

Open the Device Management folder in the drop-down list in the Navigation panel. Navigate to
the Device Lists folder.

3.

Expand the Device Lists folder and select All Devices. Locate the product in the list of devices,
and then click to select it.
If you need to upgrade the firmware for multiple HP Color LaserJet CM6030 and CM6040 MFP
Series products, select all of them by pressing the Ctrl key as you click the name of each product.

4.

Locate the drop-down box for Device Tools in the upper-right corner of the window. Select Update
Printer Firmware from the action list.

5.

If the name of the .RFU file is not listed in the All Available Images box, click Browse in the
Upload New Firmware Image dialog box and navigate to the location of the .RFU file that you
downloaded from the Web at the start of this procedure. If the filename is listed, select it.

6.

Click Upload to move the .RFU file from your hard drive to the HP Web Jetadmin server. After the
upload is complete, the browser window refreshes.

7.

Select the .RFU file from the Printer Firmware Update drop-down menu.

8.

Click Update Firmware. HP Web Jetadmin sends the selected .RFU file to the product. The control
panel shows messages that indicate the progress of the upgrade. At the end of the upgrade
process, the control panel shows the Ready message.

Use MS-DOS commands to upgrade the firmware
To update the firmware by using a network connection, follow these instructions.
1.

From a command prompt or in an MS-DOS window, type the following:
copy /B FILENAME> \\COMPUTERNAME>\SHARENAME>
, where <FILENAME> is the name of the .RFU file (including the path), <COMPUTERNAME> is
the name of the computer from which the product is being shared, and <SHARENAME> is the
product share name. For example:
C:\>copy /b C:\9200fW.RFU \\YOUR_SERVER\YOUR_COMPUTER
.
NOTE: If the file name or path includes a space, you must enclose the file name or path in
quotation marks. For example, type:
C:\>copy /b "C:\MY DOCUMENTS\3500FW.RFU" \\YOUR_SERVER\YOUR_COMPUTER
.

2.

Press Enter on the keyboard. The control panel shows a message that indicates the progress of
the firmware upgrade. At the end of the upgrade process, the control panel shows the Ready
message . The message One File Copied appears on the computer screen.
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Use the HP Jetdirect firmware
The HP Jetdirect network interface in the product has firmware that can be upgraded separately from
the product firmware. This procedure requires that you install HP Web Jetadmin Version 7.0 or later on
your computer. See Use HP Web Jetadmin software on page 187. Complete the following steps to
update the HP Jetdirect firmware by using HP Web Jetadmin.
1.

Open the HP Web Jetadmin program.

2.

Open the Device Management folder in the drop-down list in the Navigation panel. Navigate to
the Device Lists folder.

3.

Select the device that you want to update.

4.

In the Device Tools drop-down list, select Jetdirect Firmware Update.

5.

Under Jetdirect firmware version the HP Jetdirect model number and current firmware version
are listed. Make a note of these.

6.

Go to www.hp.com/go/wja_firmware.

7.

Scroll down to the list of HP Jetdirect model numbers and find the model number you wrote down.

8.

Look at the current firmware version for the model, and see if it is later than the version you wrote
down. If it is, right-click on the firmware link, and follow the instructions on the Web page to
download the new firmware file. The file must be saved into the <drive>:\PROGRAM FILES
\HP WEB JETADMIN\DOC\PLUGINS\HPWJA\FIRMWARE\JETDIRECT folder on the computer
that is running the HP Web Jetadmin software.

9.

In HP Web Jetadmin, return to the main device list and select the digital sender again.

10. In the Device Tools drop-down list, select Jetdirect Firmware Update again.
11. On the HP Jetdirect firmware page, the new firmware version is listed under Jetdirect Firmware
Available on HP Web Jetadmin. Click the Update Firmware Now button to update the Jetdirect
firmware.
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Solving general problems
If the product is not responding properly, complete the steps in the following checklist, in order. If the
product does not pass a step, follow the corresponding troubleshooting suggestions. If a step resolves
the problem, you can stop without performing the other steps on the checklist.

Troubleshooting checklist
1.

2.

Make sure the product Ready light is on. If no lights are on, complete these steps:
a.

Check the power-cable connections.

b.

Check that the power switch is on.

c.

Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip and
its voltage is not within specifications, plug the product directly into the wall. If it is already
plugged into the wall, try a different outlet.

d.

Remove any other products plugged into the same circuit.

e.

If none of these measures restores power, contact HP Customer Care.

Check the cabling.
a.

Check the cable connection between the product and the computer or network port. Make
sure that the connection is secure.

b.

Make sure that the cable itself is not faulty by using a different cable, if possible.

c.

Check the network connection. See Solve network printing problems on page 274.

3.

If the product is in the READY state, check to see if any message appear on the control-panel
display. If any error messages appear, see Control-panel messages on page 227.

4.

Ensure that the print paper that you are using meets specifications.

5.

Print a configuration page (see Information pages on page 178. An HP Jetdirect page also prints.)

6.

7.

a.

If the pages do not print, check that at least one tray contains print paper.

b.

If the page jams in the product, see Jams on page 228.

If the configuration page prints, check the following items.
a.

If the page prints correctly, then the product hardware is working. The problem is with the
computer you are using, with the printer driver, or with the program.

b.

If the page does not print correctly, the problem is with the product hardware. Contact
HP Customer Care.

Select one of the following options:
Windows: Click Start, click Settings, and then click Printers, or Printers and Faxes. Double click
HP Color LaserJet CM6030 or HP Color LaserJet CM6040.
-or-
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Mac OS X: Open Print Center, (or Printer Setup Utility for Mac OS X v. 10.3), and double-click
the line for the HP Color LaserJet CM6030 or HP Color LaserJet CM6040.
8.

Verify that you have installed the HP Color LaserJet CM6030 or HP Color LaserJet CM6040 series
printer driver. Check the program to make sure that you are using an HP Color LaserJet
CM6030 or HP Color LaserJet CM6040 series printer driver.

9.

Print a short document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print) complete these steps:
a.

Try printing the job from another computer that has the product software installed.

b.

If you connected the product to the network, connect the product directly to a computer with
a USB cable. Redirect the product to the correct port, or reinstall the software, selecting the
new connection type that you are using.

Restore factory settings
Use the Resets menu to restore factory settings.
1.

Scroll to and touch Administration and then touch Resets.

2.

Touch Restore Factory Settings and then touch Restore.

For more information, see Resets menu on page 59.

Factors that affect product performance
Several factors affect the time it takes to print a job:
●

Maximum printer speed, measured in pages per minute (ppm)

●

The use of special paper (such as transparencies, heavy paper, and custom-size paper)

●

Printer processing and download time

●

The complexity and size of graphics

●

The speed of the computer you are using

●

The USB connection

●

The printer I/O configuration

●

The amount of printer memory installed

●

The network operating system and configuration (if applicable)

●

Printer personality (HP JetReady, PCL, or PS)

NOTE: Although additional printer memory can resolve memory problems, improve how the printer
handles complex graphics, and improve download times, it will not increase maximum printer speed
(ppm).
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Control-panel message types
Four types of control-panel messages can indicate the status of or problems with the device.
Message type

Description

Status messages

Status messages reflect the current state of the device. They inform you of normal device operation
and require no interaction to clear them. They change as the state of the device changes. Whenever
the device is ready, not busy, and has no pending warning messages, the status message Ready
appears if the device is online.

Warning messages

Warning messages inform you of data and print errors. These messages typically alternate with the
Ready or status messages and remain until you touch OK. Some warning messages are clearable.
If Clearable Warnings is set to Job on the device Device Behavior menu, the next print job clears
these messages.

Error messages

Error messages communicate that some action must be performed, such as adding paper or clearing
a jam.
Some error messages are auto-continuable. If Auto-Continue is set on the menus, the device will
continue normal operation after an auto-continuable error message appears for 10 seconds.
NOTE: Pressing any button during the 10-second auto-continuable error message overrides the
auto-continue feature, and the button function takes precedence. For example, pressing the Stop
button pauses printing and offers the option to cancel the print job.

Critical-error messages

Critical error messages inform you of a device failure. Some of these messages can be cleared by
turning the device off and then on. These messages are not affected by the Auto-Continue setting.
If a critical error persists, service is required.

226 Chapter 15 Solve problems

ENWW

Control-panel messages
The product provides robust control panel messaging. When a message appears on the control panel,
follow the on-screen instructions to resolve the issue. If the product displays an “Error” or “Attention”
message, and no steps are shown to resolve the issue, turn the product off then on. Contact HP support
if you continue to experience issues with the product.
To get additional information for warnings that appear in the status line, touch the Warning button
.
For additional information on a variety of topics, touch the Help button
the home screen.
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Jams
Common causes of jams
The product is jammed.
Cause

Solution

The paper does not meet specifications.

Use only paper that meets HP specifications. See Supported
paper and print media sizes on page 97.

A component is installed incorrectly.

Verify that the transfer belt and transfer roller are correctly
installed.

You are using paper that has already passed through a product
or copier.

Do not use paper that has been previously printed on or copied.

An input tray is loaded incorrectly.

Remove any excess paper from the input tray. Make sure that
the stack is below the maximum stack height mark in the tray.
See Load paper and print media on page 103.

The paper is skewed.

The input-tray guides are not adjusted correctly. Adjust them
so they hold the stack firmly in place without bending it.

The paper is binding or sticking together.

Remove the paper, flex it, rotate it 180°, or flip it over. Reload
the paper into the input tray.

When printing on lightweight paper or on jobs with heavy toner
coverage, paper is wrapping on the fuser causing Fuser Delay
Jam or Fuser Wrap Jam messages.

Set the LIGHT MEDIA optimize mode on the Print Quality
menu to ON.

The paper is removed before it settles into the output bin.

Reset the product. Wait until the page completely settles in the
output bin before removing it.

During two-sided printing, you removed the paper before the
second side of the document was printed.

Reset the product and print the document again. Wait until the
page completely settles in the output bin before removing it.

The paper is in poor condition.

Replace the paper.

The internal tray rollers are not picking up the paper.

If the paper is heavier than 220 g/m2 (58 lb), it might not be
picked from the tray.
The rollers are worn. Replace the rollers.

The paper has rough or jagged edges.

Replace the paper.

The paper is perforated or embossed.

Perforated or embossed paper does not separate easily. Feed
single sheets from Tray 1.

Device supply items have reached the end of their useful life.

Check the product control panel for messages prompting you
to replace supplies, or print a supplies status page to verify the
remaining life of the supplies. See Information pages
on page 178.

Paper was not stored correctly.

Replace the paper in the trays. Paper should be stored in the
original packaging in a controlled environment.

Not all product packing material was removed.

Verify that the packing tape, cardboard, and plastic shipping
locks have been removed from the product.

If the product still continues to jam, contact HP Customer Support or your authorized HP service
provider.
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Jam locations
Use this illustration to identify locations of jams. In addition, this product provides instructions on the
control panel to direct you to the location of jammed paper and how to clear it.
NOTE: All areas of the product that might need to be opened to clear jams are equipped with green
handles.
Figure 15-1 Jam locations

1

AREA 1: Output bin

2

AREA 2: Fuser area

3

AREA 3: Transfer area

4

AREA 4: Duplexing area

5

AREA 5: Tray 2 pickup area

6

AREA 6: Tray 1 area

7

AREA 7: Optional Trays 3, 4, and 5

8

AREA 8: Optional finishing device

9

AREA 9: ADF area

Clear jams
When a jam occurs, a message appears on the control-panel display that describes the location of the
jam. The following table lists the messages that can appear and provides links to the procedures for
clearing the jam.

ENWW

Jams 229

WARNING! To avoid electrical shock, remove any necklaces, bracelets, or other metal items before
reaching into the inside of the product.
Type of jam

Procedure

13.JJ.NT Jam below control panel

See AREA 1: Clear jams in the output bin on page 230.

13.JJ.NT Fuser Area Jam

See AREA 2: Clear jams in the fuser on page 232.

13.JJ.NT Fuser Wrap Jam
13.JJ.NT Transfer And Fuser Jam
13.JJ.NT Jam Inside Right Door

See Clear jams in the duplex area on page 236.

13.JJ.NT Jam In Tray 2

See AREA 5: Clear jams in Tray 2 and the internal paper path
on page 239.

13.JJ.NT Transfer Area Jam
13.JJ.NT Jam In Tray 1

See AREA 6: Clear jams in Tray 1 on page 242.

13.JJ.NT Jam In Tray 3

See AREA 7: Clear jams in optional Trays 3, 4, and 5
on page 245

13.JJ.NT Jam In Tray 4
13.JJ.NT Jam In Tray 5
13.JJ.NT Jam Inside Lower Right Door
13.JJ.NT Jam In Input Accessory
13.JJ.NT Jam In Left Accessory

See AREA 8: Clear jams in the optional finishing devices
on page 248.

Jam in document feeder

See AREA 9: Clear jams in the ADF on page 252.

AREA 1: Clear jams in the output bin
1.

If jammed paper is visible in the output bin, gently pull the paper to remove it.
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2.

Open the right door.

3.

If paper has jammed as it enters the output bin, gently pull the paper to remove it.

4.

Close the right door.
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AREA 2: Clear jams in the fuser
WARNING! The fuser can be hot while the product is in use. Wait for the fuser to cool before handling
it.
1.

Open the right door.

2.

Lift the green handle on the transfer-access panel and open the panel.

1
2

3.

If paper is visible entering the bottom of the fuser, gently pull downward to remove it.
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4.

Close the transfer-access panel.

5.

Open the fuser jam access door above the fuser and remove any paper that is visible. Then close
the fuser jam access door.

6.

Paper could also be jammed inside the fuser where it would not be visible. Remove the fuser to
check for jammed paper inside.
WARNING!
handling it.
a.

ENWW

The fuser can be hot while the product is in use. Wait for the fuser to cool before

Pull the two blue fuser handles forward.
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b.

Rotate the fuser-release levers down to open them.

c.

Grasp the fuser handles and pull straight out to remove the fuser.
CAUTION:

d.

The fuser weighs 5 kg (11 lbs). Be careful not to drop it.

Open the two fuser jam access doors by pushing and rotating the rear door backward, and
pulling and rotating the front door forward. If paper is jammed inside the fuser, gently pull it
straight up to remove it. If the paper tears, remove all paper fragments.
WARNING! Even if the body of the fuser has cooled, the rollers that are inside could still be
hot. Do not touch the fuser rollers until they have cooled.

2
1
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e.

Close both fuser jam-access doors and align the fuser with the arrows on the product. Push
the fuser completely into the printer.

f.

Rotate the fuser-release levers up to lock the fuser into place.

g.

Push the fuser handles back to close them.
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7.

Close the right door.

Clear jams in the duplex area
1.

Check for jammed paper inside the product. Open the right door.
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2.

If paper is jammed below the duplexing unit, gently pull the paper downward to remove it.

3.

If paper is jammed inside the right door, gently pull the paper to remove it.

Jams 237

4.

Lift the paper-feed cover on the inside of the right door. If jammed paper is present, gently pull the
paper straight out to remove it.

1
2

5.

Lift the green handle on the transfer-assembly and open the panel.

1
2

6.

Gently pull the paper out of the paper path.
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7.

Close the transfer-access panel.

8.

Close the right door.

AREA 5: Clear jams in Tray 2 and the internal paper path
1.

ENWW

Open the right door.
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2.

Lift the green handle on the transfer-access panel and open the panel.

1
2

3.

Gently pull the paper out of the paper path.

4.

Close the transfer-access panel.
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5.

Open Tray 2 and make sure that the paper is stacked correctly.

6.

Pull the tray completely out of the product by pulling and lifting it up slightly.

7.

Remove any paper from the feeder rollers inside the product.

8.

Reinsert Tray 2 by aligning the side rollers and pushing it back into the product.
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9.

Close the tray.

10. Close the right door.

AREA 6: Clear jams in Tray 1
NOTE: Even if jammed paper is visible in Tray 1, clear the jam from the inside of the product by opening
the right door.
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1.

Open the right door.
NOTE: When clearing jams of long paper (11 x 17, 12 x 18, and A3), it may be necessary to cut
or tear the jammed paper before opening the right door.

2.

ENWW

If paper is visible inside the right door, gently pull the paper downward to remove it.
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3.

If paper has entered the internal paper path, lift the green handle on the transfer-access panel and
open the panel.

1
2

4.

Gently pull the paper out of the paper path.

5.

Close the transfer-access panel.
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6.

Close the right door.

AREA 7: Clear jams in optional Trays 3, 4, and 5
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1.

Open the right door.

2.

If paper is visible in the paper-input area, gently pull the jammed paper up to remove it.
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3.

Close the right door.

4.

Open the lower right door.

5.

Gently pull the jammed paper to remove it.
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6.

Open the tray that is indicated in the control-panel message, and make sure that the paper is
stacked correctly.

7.

Close the tray.

8.

Close the lower right door.
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AREA 8: Clear jams in the optional finishing devices
Clear jams in the output-accessory bridge
1.

Lift the latch on the top cover of the output-accessory bridge and open the top cover.

2.

Gently pull the jammed paper to remove it.

3.

Close the top cover of the output-accessory bridge.
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Clear jams in the sorter area
1.

Lift the latch on the top cover of the finishing device, and open the top cover.
NOTE:

2.

Remove jammed paper from the output bin or from the inside of the finishing device.

3

ENWW

Opening the top cover releases pressure on the output-bin rollers.

2
1
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3.

Close the top cover of the finishing device.

4.

Lift the swing guide panel in the output bin. If you can see any jammed paper, gently pull it out.

Clear jams in the booklet maker
1.

If the paper is visible in the booklet output bin, gently pull the paper to remove it.

2.

Open the front door of the booklet maker.
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3.

Push the upper delivery guide to the right, and remove any jammed paper.

1

2
4.

Push the lower delivery guide to the right, and remove any jammed paper.

2
1
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5.

The positioning knob is the smaller, green dial on the right. Turn the positioning knob
counterclockwise.

6.

The jam-release knob is the larger, green dial on the left. Push in the jam-release knob, and then
turn it clockwise to move any jammed paper into the output bin.
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7.

Close the front door of the booklet maker.

AREA 9: Clear jams in the ADF
1.

Open the ADF cover.

2.

Remove any jammed media.

3.

Close the ADF cover.
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Clear staple jams
Clear staple jams in the main stapler
The HP 3-bin Stapler/Stacker and the HP Booklet maker/Finisher Accessory each have a main stapler,
which is located near the top of the finishing device.

ENWW

1.

Open the front door of the finishing device.

2.

To remove the staple cartridge, pull up on the green handle and pull out the staple cartridge.

3.

Lift up on the small lever at the back of the staple cartridge.

4.

Remove the damaged staples that protrude from the staple cartridge. Remove the entire sheet of
staples that the damaged staples were attached to.
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5.

Close the lever at the back of the staple cartridge. Be sure that it snaps into place.

6.

Reinsert the staple cartridge into the finishing device, and push down on the green handle until it
snaps into place.

7.

Close the front cover of the finishing device.

Clear staple jams in the booklet maker
The booklet maker has an additional saddle stitch stapler that is below the main stapler. The saddle
stitch stapler has two staple cartridges.
1.

Open the front door of the booklet maker.
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2.

Push the upper delivery guide to the right, and remove any jammed paper.

1

2
3.

Grasp the blue handle for the stapler carriage and pull it straight out.

4.

Grasp the handle of the blue staple cartridge unit and pull it toward you, then swing the staple
cartridge unit into an upright position.

2
1
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5.

Check each staple cartridge for jammed staples.
a.

On each staple cartridge, press down on the green plastic tabs while lifting the jam clearance
plate.
WARNING! Do not place your fingers or hands underneath the staple cartridge during this
procedure.

1
2

3
b.

Remove any jammed staples. Remove any damaged staples and the entire sheet of staples
that the damaged staples were attached to.

c.

Press down on the jam clearance plate to close it.
WARNING! Do not place your fingers or hands underneath the staple cartridge during this
procedure.

6.

Pull the staple cartridge unit forward, and swing it downward to the original position. Push in on the
handle to lock it into position.

1
2
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7.

Push the staple carriage back into the booklet maker.

8.

Close the front door of the booklet maker.

Jam recovery
This product provides jam recovery, a feature that reprints jammed pages. The following options are
available:
●

Auto — The product attempts to reprint jammed pages when sufficient memory is available.

●

Off — The product does not attempt to reprint jammed pages. Because no memory is used to store
the most recent pages, performance is optimal.
NOTE: When using this option, if the product runs out of paper and the job is being printed on
both sides, some pages can be lost.

●

On — The product always reprints jammed pages. Additional memory is allocated to store the last
few pages printed. This might cause overall performance to suffer.

Set the jam recovery feature

ENWW

1.

Touch Administration and then touch Device Behavior.

2.

Touch Warning/Error Behavior and then touch Jam Recovery.

3.

Touch an option and then touch Save.
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Paper-handling problems
Use only paper that meets the specifications outlined in the HP LaserJet Printer Family Print Media
Guide. This guide is available at www.hp.com/support/ljpaperguide.

Product feeds multiple sheets
Product feeds multiple sheets
Cause

Solution

The input tray is overfilled. Open the tray and verify that the
paper stack is below the maximum stack height mark.

Remove excess paper from the input tray.

Print paper is sticking together.

Remove paper, flex it, rotate it 180 degrees or flip it over, and
then reload it into the tray.
NOTE: Do not fan paper. Fanning can cause static electricity,
which can cause paper to stick together.

Paper does not meet the specifications for this product.

Use only paper that meets HP paper specifications for this
product.

Trays are not properly adjusted.

Make sure that the paper guides match the size of paper being
used.

Product feeds incorrect page size
Product feeds incorrect page size
Cause

Solution

The correct size paper is not loaded in the input tray.

Load the correct size paper in the input tray.

The correct size paper is not selected in the software program
or printer driver.

Confirm that the settings in the software program and printer
driver are appropriate, since the software program settings
override the printer driver and control panel settings, and the
printer driver settings override the control panel settings. For
more information, see Change printer-driver settings for
Windows on page 67 or Change printer-driver settings for
Macintosh on page 74.

The correct size paper for the tray is not selected in the product
control panel.

From the control panel, select the correct size paper for the
tray.

The paper size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the paper size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the paper guides are touching the paper.

Product pulls from incorrect tray
Product pulls from incorrect tray
Cause

Solution

You are using a driver for a different product.

Use a driver for this product.

The specified tray is empty.

Load paper in the specified tray.
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Product pulls from incorrect tray
Cause

Solution

The paper size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the paper size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the guides are touching the paper.

Paper does not feed automatically
Paper does not feed automatically
Cause

Solution

Manual feed is selected in the software program.

Load Tray 1 with paper, or, if the paper is loaded, press the
Start button.

The correct size paper is not loaded.

Load the correct size paper.

The input tray is empty.

Load paper into the input tray.

Paper from a previous jam has not been completely removed.

Open the product and remove any paper in the paper path.

The paper size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the paper size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the rear and width paper guides are touching the
paper.

The manual-feed prompt is set to ALWAYS. The product
always prompts for manual feed, even if the tray is loaded.

Open the tray, reload the media, and then close the tray.
Or, change the manual-feed prompt setting to UNLESS
LOADED, so that the product prompts for manual feed only
when the tray is empty.

The USE REQUESTED TRAY setting on the product is set to Load the requested tray.
EXCLUSIVELY, and the requested tray is empty. The product
Or, change the setting from EXCLUSIVELY to FIRST on the
will not use another tray.
CONFIGURE DEVICE menu. The product can use other trays
if no media is loaded in the specified tray.

Paper does not feed from Tray 2, 3, 4, or 5
Paper does not feed from Tray 2, 3, 4, or 5
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Cause

Solution

The correct size paper is not loaded.

Load the correct size paper.

The input tray is empty.

Load paper in the input tray.

The correct paper type for the input tray is not selected in the
product control panel.

From the product control panel, select the correct paper type
for the input tray.

Paper from a previous jam has not been completely removed.

Open the product and remove any paper in the paper path.
Closely inspect the fuser area for jams.

None of the optional trays appear as input tray options.

The optional trays only display as available if they are installed.
Verify that any optional trays are correctly installed. Verify that
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Paper does not feed from Tray 2, 3, 4, or 5
Cause

Solution
the printer driver has been configured to recognize the optional
trays.

An optional tray is incorrectly installed.

Print a configuration page to confirm that the optional tray is
installed. If not, verify that the tray is correctly attached to the
product.

The paper size is not configured correctly for the input tray.

Print a configuration page or use the control panel to determine
the paper size for which the tray is configured.

The guides in the tray are not against the paper.

Verify that the guides are touching the paper.

Transparencies or glossy paper will not feed
Transparencies or glossy paper will not feed
Cause

Solution

The correct paper type is not specified in the software or printer
driver.

Verify that the correct paper type is selected in the software or
printer driver.

The input tray is overfilled.

Remove excess paper from the input tray. Do not load more
than 200 sheets of glossy paper or glossy film, or more than
100 transparencies in Tray 2, 3, 4, or 5. Do not exceed the
maximum stack height marks for Tray 1.

Paper in another input tray is the same size as the
Make sure that the input tray containing the transparencies or
transparencies, and the product is defaulting to the other tray. glossy paper is selected in the software program or printer
driver. Use the product control panel to configure the tray to
the paper type loaded.
The tray containing the transparencies or glossy paper is not
configured correctly for type.

Make sure that the input tray containing the transparencies or
glossy paper is selected in the software program or printer
driver. Use the product control panel to configure the tray to
the paper type loaded.

Transparencies or glossy paper might not meet supported
paper specifications.

Use only paper that meets the HP paper specifications for this
product.

High-humidity environments may cause glossy paper not to
feed, or to feed too many sheets.

Print glossy paper from Tray 2, 3, 4, or 5 for best results.
Avoid printing glossy paper in high humidity conditions. When
printing glossy paper, removing the paper from the wrapper
and letting it rest for a few hours can improve feeding into the
product. However, letting paper rest in humid environments
may also cause blisters.

CAUTION: HP Color Laser Presentation Paper, Glossy (Q2546A) is not supported with this product.
Using this type of paper can cause a fuser jam that might require the replacement of the fuser. Two
recommended alternatives are HP Color LaserJet Presentation Paper, Soft Gloss (Q6541A) and
HP Color LaserJet Brochure Paper, Glossy (Q6611A, Q6610A). For a list of supported paper types, see
Supported paper types on page 100.
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Envelopes jam or will not feed in the product
Envelopes jam or will not feed in the product
Cause

Solution

Envelopes are loaded in an unsupported tray. Only Tray 1 can
feed envelopes.

Load envelopes into Tray 1.

Envelopes are curled or damaged.

Try using different envelopes. Store envelopes in a controlled
environment.

Envelopes are sealing because the moisture content is too
high.

Try using different envelopes. Store envelopes in a controlled
environment.

Envelope orientation is incorrect.

Verify that the envelope is loaded correctly.

This product does not support the envelopes being used.

Refer to the HP LaserJet Printer Family Print Media Guide.

Tray 1 is configured for a size other than envelopes.

Configure Tray 1 size for envelopes.

Output is curled or wrinkled
Output is curled or wrinkled

ENWW

Cause

Solution

Paper does not meet the specifications for this product.

Use only paper that meets the HP paper specifications for this
product.

Paper is damaged or in poor condition.

Remove paper from the input tray and load paper that is in
good condition.

Product speed needs to be reduced.

Set the PAPER CURL option in the Print Quality menu to
REDUCED to decrease full speed to 10 ppm (instead of 40
ppm) and 3/4 speed to 7.5 ppm (instead of 30 ppm).

Product is operating in an excessively humid environment.

Verify that the printing environment is within humidity
specifications.

You are printing large, solid-filled areas.

Large, solid-filled areas can cause excessive curl. Try using a
different pattern.

Paper used was not stored correctly and might have absorbed
moisture.

Remove paper and replace it with paper from a fresh,
unopened package.

Paper has poorly cut edges.

Remove paper, flex it, rotate it 180 degrees or turn it over, and
then reload it into the input tray. Do not fan paper. If the problem
persists, replace the paper.

The specific paper type was not configured for the tray or
selected in the software.

Configure the software for the paper (see the software
documentation). Configure the tray for the paper, see Load
paper and print media on page 103.

The paper has previously been used for a print job.

Do not re-use paper.
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Product will not duplex or duplexes incorrectly
Product will not duplex (print 2-sided jobs) or duplexes incorrectly
Cause

Solution

You are trying to duplex on unsupported paper.

Verify that the paper is supported for duplex printing.

The printer driver is not set up for duplex printing.

Set up the printer driver to enable duplex printing.

The first page is printing on the back of preprinted forms or
letterhead.

Load preprinted forms and letterhead in Tray 1 with the
letterhead or printed side down, with the top of the page toward
the back of the product. For Tray 2, 3, 4 and 5, load the paper
printed side up with the top of the page toward the back of the
product.

The product model does not support automatic 2-sided
printing.

The HP Color LaserJet CM6040 MFP does not support
automatic 2-sided printing.

The product configuration is not set for duplexing.

In Windows, run the automatic configuration feature:
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1.

Click the Start button, point to Settings, and then click
Printers (for Windows 2000) or Printers and Faxes (for
Windows XP).

2.

Right-click the HP product icon, and then click
Properties or Printing Preferences.

3.

Click the Device Settings tab.

4.

Under Installable Options, click Update Now in the
Automatic Configuration list.
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Understand lights on the formatter
Three LEDs on the formatter indicate that the product is functioning correctly.

1

2

1

Heartbeat LED

2

HP Jetdirect LEDs (This LED exists only if HP Jetdirect is installed.)

HP Jetdirect LEDs
The embedded HP Jetdirect print server has two LEDs. The yellow LED indicates network activity, and
the green LED indicates the link status. A blinking yellow LED indicates network traffic. If the green LED
is off, a link has failed.
For link failures, check all of the network cable connections. In addition, you can try to manually configure
the link settings on the embedded print server by using the product control-panel menus.
1.

Scroll to and touch Administration.

2.

Touch Initial Setup.

3.

Touch Networking and I/O.

4.

Touch Embedded Jetdirect or EIO <X> Jetdirect.

5.

Touch Link Speed.

6.

Select the appropriate link speed.

7.

Touch Save.

Heartbeat LED
The heartbeat LED indicates that the formatter is functioning correctly. While the product is initializing
after you turn it on, the LED blinks rapidly, and then turns off. When the product has finished the
initialization sequence, the heartbeat LED pulses on and off.
If the heartbeat LED is off, the formatter might have a problem. Contact an HP-authorized service or
support provider. See the HP support flyer, or go to www.hp.com/go/cljcm6030mfp_software or
www.hp.com/go/cljcm6040mfp_software.
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Correct print quality and copy quality problems
The following procedures help you define print quality problems and what to do to correct them. Often
print quality problems can be handled easily by making sure that the product is properly maintained,
using print media that meets HP specifications, or running a cleaning page.

Example print quality problems
Some print quality problems arise from use of inappropriate paper.
●

Use paper that meets HP paper specifications.

●

The surface of the paper is too rough. Use paper that meets HP paper specifications.

●

The printer driver setting or paper tray setting might be incorrect. Be sure that you have configured
the paper tray at the product control panel and have also selected the correct driver setting for the
paper that you are using.

●

The print mode might be set incorrectly, or the paper might not meet recommended specifications.

●

The transparencies you are using are not designed for proper toner adhesion. Use only
transparencies designed for HP Color LaserJet products.

●

The moisture content of the paper is uneven, too high, or too low. Use paper from a different source
or from an unopened ream of paper.

●

Some areas of the paper reject toner. Use paper from a different source or from an unopened ream
of paper.

●

The letterhead you are using is printed on rough paper. Use a smoother, xerographic paper. If this
solves your problem, consult with the printer of your letterhead to verify that the paper used meets
the specifications for this product.

●

Several optimize print modes can be used to address print quality issues. See Print Quality menu
on page 49.

Repetitive defects ruler
If defects repeat at regular intervals on the page, use this ruler to identify the cause of the defect. Place
the top of the ruler at the first defect. The marking that is beside the next occurrence of the defect
indicates which component needs to be replaced.
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(0)

(36mm)
(40mm)

(50mm)

(71mm)

(82mm)

(94mm)

(144mm)
(148mm)

36 mm

Developer roller in an image drum.
The print quality defect will be in one of the four image drums (image drum).

40 mm

Charge roller in an image drum.
The print quality defect will be spots or dots sometimes caused when feeding labels and will be in one of the four
image drums (image drum).

50 mm

Transfer 1 roller in the transfer unit (transfer kit).

71 mm

Transfer 2 roller in the roller kit (transfer kit).

82 mm

Tension in the transfer unit (transfer kit).

94 mm

Image drum.
The print quality defect will be in one of the four image drums (image drum).
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144 mm

Pressure roller in the fuser (fuser kit).

148 mm

Fusing roller in the fuser (fuser kit).

To identify if the image drum is the problem, insert an image drum from another HP Color LaserJet
CM6040 series, if one is available, before ordering a new image drum.
If the defect repeats at 94.0 mm (3.75 inch) intervals, try replacing the image drum before replacing the
fuser.

Print quality problems associated with the environment
If the product is operating in excessively humid or dry conditions, verify that the printing environment is
within specifications. See Environmental specifications on page 297. Several optimization modes can
also help with environmental conditions. See Use manual print modes on page 270.

Print quality problems associated with jams
●

Make sure that all paper is cleared from the paper path.

●

If the product recently jammed, print two to three pages to clean the product.

●

The paper does not pass through the fuser, causing image defects to appear on subsequent
documents. Print two to three pages to clean the product.

Optimize and improve image quality
The following procedures can be used to solve most image quality problems.
If following the procedures does not improve print quality, go to www.hp.com/go/
cljcm6030mfp_software or www.hp.com/go/cljcm6040mfp_software.

Use supported paper
Using unsupported paper or other media in the product can cause a wide variety of image quality
problems.

Calibrate the product
Calibration is a product function that optimizes print quality. If you experience any image-quality
problems, calibrate the product.
At the control panel;
1.

Touch Administration.

2.

Scroll and touch Print Quality.

3.

Scroll and touch Calibration/Cleaning .

4.

Touch Quick Calibration or Full Calibration.

5.

Touch Calibrate.
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Specify the correct paper type
When you send a print job to the product, specify the type of paper you are using.
1.

On the File menu in the software program, click Print.

2.

Select the product, and then click Properties or Preferences.
NOTE:

The steps can vary; this procedure is most common.

3.

Select the Paper/Quality tab.

4.

In the Paper Type drop-down box, select More... and then select the paper type that best matches
the paper that is loaded in the product.

Clean the fuser
Run the device cleaning page to keep the fuser free of toner and paper particles that can sometimes
accumulate. Accumulation of toner and particles can cause specks to appear on the front or back side
of your print jobs.
HP recommends that you use the cleaning page when there is a print quality issue.
A Cleaning message appears on the product control panel display while the cleaning is taking place.
In order for the cleaning page to work correctly, print the page on copier-grade paper (not bond, heavy,
or rough paper).
Create and use the cleaning page
1.

Scroll to and touch Administration.

2.

Scroll to and touch Print Quality

3.

Touch Calibration/cleaning.

4.

Touch Process cleaning page.

Respond to control panel error messages
If you see a 54.Error <XX> message in the event log, you might need to perform some maintenance
on the product in order to avoid more errors and solve print quality problems.
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1.

Open and then close the right door of the product to log a 54.Error <XX> as the latest event in the
event log.

2.

Scroll to and touch Administration.

3.

Scroll to and touch Troubleshooting.

4.

Scroll to and touch Event Log.
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5.

Touch Print.

6.

Find the most recent event in the log.
●

If the event is a 54.OE.01 Media Sensor event, you need to replace the registration second
transfer assembly. Contact HP Support at www.hp.com/go/cljcm6030mfp_software or
www.hp.com/go/cljcm6040mfp_software and provide them with this error code.

●

If the event is a 54.OE.02 Media Sensor event, you need to replace the product transfer kit.
Contact HP Support at www.hp.com/support/cljcm6040mfp or www.hp.com/support/
cljcm6030mfp and provide them with this error code.

●

If the event is a 54.OE.03 Media Sensor event, you need to clean the registration second
transfer assembly and the media sensor using the following procedure.

Clean the registration second transfer assembly
1.

Open the right door.

2.

Locate and remove the cleaning brush.

268 Chapter 15 Solve problems

ENWW

3.

Lift the green handle on the transfer-access panel and open the panel.

1
2
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4.

Clean the media sensor with the cleaning brush.

5.

Close the transfer access panel, and replace the cleaning brush in its holder.
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6.

Close the right door.

Use manual print modes
Try the following manual print modes to see if they solve the image quality problems. These options can
be found in the Optimize sub-menu under the control panel Print Quality menu. See Print Quality menu
on page 49.
●

Fuser Temp: If you are seeing a faint image of the page repeated at the bottom of the page or on
the following page, you should first make sure the Paper Type and Print Mode settings are correct
for the type of paper you are using. If you continue to see ghost images on your print jobs, set the
Fuser Temp feature to one of the Alternate settings . Try the Alternate 1 setting first and see if it
solves the problem. If you continue to see the problem, try Alternate 2 and then Alternate 3. With
the Alternate 2 and Alternate 3 settings you may see an extra delay between jobs.

●

Light Media: Set this feature to On if you are frequently seeing Fuser Delay Jam or Fuser Wrap
Jam messages, especially when printing on light-weight paper or on jobs with heavy toner
coverage.

●

Media Temp: Set this feature to Reduced if you are having problems with paper sticking together
in the output bin.

●

Environment: Enable this feature if the product is operating in a low temperature environment and
you are having problems with print quality such as blisters in the printed image.

●

Line Voltage: Enable this feature if the product is operating in a low voltage environment and you
are having problems with print quality such as blisters in the printed image.

●

Background: Turn this feature on if pages are printing with a shaded background. Using this
feature can reduce gloss levels.

●

Paper Curl: Set this feature to Reduced if excessive curling of paper in the output bin occurs. This
setting will reduce printing speed and increase the frequency of consumable replacement.

●

Pre-rotation: Turn this feature on if horizontal streaks appear on pages. Using this feature
increases the warm-up time for the device.

●

Tray 1: If you are seeing marks on the back side of the paper or extra toner on pages when printing
from Tray 1, set the mode to Alternate. When the mode is set to Alternate a cleaning cycle will be
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performed after each job that is printed from Tray 1. Using Alternate mode increase wear on all the
print cartridges.
●

Tracking Control: This setting should always be set to On.

●

Cleaning Frequency = Normal/Alternate: Set this feature to Alternate if you are seeing defects
in the printed output that repeat at 38 mm (1.5 inch) intervals. This feature increases the frequency
at which the C roller is cleaned. Setting this feature to Alternate might also reduce printing speed
and increase the frequency of consumable replacement.

●

D-Blade Bias = Normal/Alternate: Set this feature to Alternate if you are seeing short, white,
vertical lines in the printed output. The Alternate setting might also cause dark spots in the printed
output, so be sure to test this setting on a few print jobs.

●

Waste Bin = Normal/Alternate: Try setting this feature to Alternate if you are seeing lengthwise
toner streaks in your printed output, especially in jobs with low toner coverage.

●

Discharge Brush = Off/On: Enable this feature in low temperature and low humidity environments
if you are seeing specks of toner scattered on double-sided jobs using lightweight paper and longer
than ten pages.

Print-quality-troubleshooting pages
Use the built-in print-quality-troubleshooting pages to help diagnose and solve print-quality problems.
1.

Scroll to and touch Administration

2.

Scroll to and touch Troubleshooting.

3.

Touch PQ Troubleshooting.

4.

Touch Print.

The product returns to the Ready state after printing the print-quality-troubleshooting pages. Follow the
instructions on the pages that print out.
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Performance problems
Problem

Cause

Solution

Pages print but are totally blank.

The sealing tape might still be in the print
cartridges.

Verify that the sealing tape has been
completely removed from the print
cartridges.

The document might contain blank
pages.

Check the document that you are printing
to see if content appears on all of the
pages.

The product might be malfunctioning.

To check the product, print a
Configuration page.

Heavier media types can slow the print
job.

Print on a different type of media.

Complex pages can print slowly.

Proper fusing may require a slower print
speed to ensure the best print quality.

The RLT photo fix options under HP
real life technologies on the Paper/
Quality tab of the print driver can cause
slow printing.

De-select these options to improve print
speed.

The product might not be pulling media
correctly.

Make sure paper is loaded in the tray
correctly.

Pages print very slowly.

Pages did not print.

If the problem persists, you might need
to replace the pickup rollers and the
separation pad. See Customer support
on page 289.
The media is jamming in the device.

Clear the jam. See Jams on page 228.

The USB cable might be defective or
incorrectly connected.

●

Disconnect the USB cable at both
ends and reconnect it.

●

Try printing a job that has printed in
the past.

●

Try using a different USB cable.

Other devices are running on your
computer.
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The product might not share a USB port.
If you have an external hard drive or
network switchbox that is connected to
the same port as the product, the other
device might be interfering. To connect
and use the product, you must
disconnect the other device or you must
use two USB ports on the computer.
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Solve fax problems
For help solving fax problems, go to www.hp.com/go/mfpfaxaccessory300.
You can also refer to the Analog Fax Accessory 300 Fax Guide and the Analog Fax Accessory 300
Send Fax Driver Guide, which are included on the product User CD.

Solve e-mail problems
If you are unable to send e-mails by using the digital-send feature, you might need to reconfigure the
SMTP gateway address or the LDAP gateway address. Print a configuration page to find the current
SMTP and LDAP gateway addresses. See Information pages on page 178. Use the following
procedures to check if the SMTP and LDAP gateway addresses are valid.

Validate the SMTP gateway address
NOTE:
1.

This procedure is for Windows operating systems.

Open an MS-DOS command prompt: click Start, click Run, and then type
cmd
.

2.

Type
telnet
followed by the SMTP gateway address and then the number 25, which is the port over which the
product is communicating. For example, type
telnet 123.123.123.123 25
where "123.123.123.123" represents the SMTP gateway address.

3.

Press Enter. If the SMTP gateway address is not valid, the response contains the message
Could not open connection to the host on port 25: Connect Failed.

4.

If the SMTP gateway address is not valid, contact the network administrator.

Validate the LDAP gateway address
NOTE:
1.

This procedure is for Windows operating systems.

Open Windows Explorer. In the address bar, type
LDAP://
immediately followed by the LDAP gateway address. For example, type
LDAP://12.12.12.12
where "12.12.12.12" represents the LDAP gateway address.

ENWW

2.

Press Enter. If the LDAP gateway address is valid, the Find People dialog box opens.

3.

If the LDAP gateway address is not valid, contact the network administrator.
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Solve network connectivity problems
If the product is having problems communicating with the network, use the information in this section to
resolve the problem.

Solve network printing problems
NOTE:

HP recommends that you use the product CD to install and set up the product on a network.

●

Make sure that the network cable is securely seated into the product's RJ45 connector.

●

Make sure that the Link LED on the formatter is lit. See Understand lights on the formatter
on page 263.

●

Make sure that the I/O card is ready. Print a configuration page (see Information pages
on page 178). If an HP Jetdirect print server is installed, printing a configuration page also prints
a second page that shows the network settings and status.
NOTE: The HP Jetdirect print server supports various network protocols (TCP/IP, IPX/SPX,
Novell NetWare, AppleTalk, and DCL/LLC). Make sure that the correct protocols and network
parameters are set correctly.
On the HP Jetdirect configuration page, verify the following items for your protocol:
◦

Under HP Jetdirect Configuration, the status is "I/O Card Ready."

◦

Protocol status is "Ready."

◦

An IP address is listed.

◦

The configuration method (Config by:) is listed correctly. See the network administrator if you
are not sure which method is correct.

●

Try printing the job from another computer.

●

To verify that a product works with a computer, use a USB cable to connect it directly to a computer.
You will have to reinstall the printing software. Print a document from a program that has printed
correctly in the past. If this works, a problem with the network might exist.

●

Contact your network administrator for assistance.
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Verify communication over the network
If the HP Jetdirect configuration page shows an IP address for the product, use this procedure to verify
that you can communicate with the product over the network.
1.

Windows: Click Start, click Run, and then type
cmd
. An MS-DOS command prompt opens.
-orMac: Click Applications, click Utilities, and then open the Terminal application. The terminal
window opens.

2.

Type
ping
followed by the IP address. For example, type
ping XXX.XXX.XXX.XXX
where "XXX.XXX.XXX.XXX" is the IPv4 address that is shown on the HP Jetdirect configuration
page. If the product is communicating over the network, the response is a list of replies from the
product.

3.

Verify that the IP address is not a duplicate address on the network by using the address resolution
protocol (arp -a) command. At the prompt, type
arp -a
. Find the IP address in the list and compare its physical address to the hardware address that is
listed on the HP Jetdirect configuration page in the section called HP Jetdirect Configuration. If the
addresses match, all network communications are valid.

4.
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If you cannot verify that the product is communicating over the network, contact the network
administrator.
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Solve common Macintosh problems
This section lists problems that can occur when using Mac OS X.
Table 15-1 Problems with Mac OS X
The printer driver is not listed in the Print Center or Printer Setup Utility.
Cause

Solution

The product software might not have been installed or was installed
incorrectly.

Make sure that the product PPD is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj
, where <lang> is the two-letter language code for the language that
you are using. If necessary, reinstall the software. See the getting
started guide for instructions.

The Postscript Printer Description (PPD) file is corrupt.

Delete the PPD file from the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj
, where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The product name, IP address, or Rendezvous/Bonjour host name does not appear in the product list in the Print Center or Printer
Setup Utility.
Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The wrong connection type might be selected.

Make sure that USB, IP Printing, or Rendezvous/Bonjour is selected,
depending on the type of connection that exists between the product
and the computer.

The wrong product name, IP address, or Rendezvous/Bonjour host
name is being used.

Print a configuration page in order to check the product name, IP
address, or Rendezvous host name. Verify that the name, IP address,
or Rendezvous host name on the configuration page matches the
product name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

The interface cable might be defective or of poor quality.

Replace the interface cable. Make sure to use a high-quality cable.

The printer driver does not automatically set up your selected product in the Print Center or Printer Setup Utility.
Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The product software might not have been installed or was installed
incorrectly.

Make sure that the product PPD is in the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj
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Table 15-1 Problems with Mac OS X (continued)
The printer driver does not automatically set up your selected product in the Print Center or Printer Setup Utility.
Cause

Solution
, where <lang> is the two-letter language code for the language that
you are using. If necessary, reinstall the software. See the getting
started guide for instructions.

The Postscript Printer Description (PPD) file is corrupt.

Delete the PPD file from the following hard-drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj
, where <lang> is the two-letter language code for the language that
you are using. Reinstall the software. See the getting started guide
for instructions.

The interface cable might be defective or of poor quality.

Replace the interface cable. Make sure to use a high-quality cable.

A print job was not sent to the product that you wanted.
Cause

Solution

The print queue might be stopped.

Restart the print queue. Open print monitor and select Start Jobs.

The wrong product name or IP address is being used. Another
product with the same or similar name, IP address, or Rendezvous
host name might have received your print job.

Print a configuration page in order to check the product name, IP
address, or Rendezvous host name. Verify that the name, IP address,
or Rendezvous host name on the configuration page matches the
product name, IP address, or Rendezvous host name in the Print
Center or Printer Setup Utility.

An encapsulated PostScript (EPS) file does not print with the correct fonts.
Cause

Solution

This problem occurs with some programs.

●

Try downloading the fonts that are contained in the EPS file to
the product before printing.

●

Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.
Cause

Solution

This error occurs when the software for USB products is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.
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Table 15-1 Problems with Mac OS X (continued)
When connected with a USB cable, the product does not appear in the Print Center or Printer Setup Utility after the driver is selected.
Cause

Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting
●

Check that your Macintosh supports USB.

●

Verify that your Macintosh operating system is Mac OS X v10.1
or later.

●

Ensure that your Macintosh has the appropriate USB software
from Apple.

Hardware troubleshooting
●

Check that the product is turned on.

●

Verify that the USB cable is connected correctly.

●

Check that you are using the appropriate high-speed USB cable.

●

Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

●

Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain and connect the cable directly to the USB port on
the host computer.
NOTE:
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The iMac keyboard is a nonpowered USB hub.
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Order parts, accessories, and supplies
Several methods are available for ordering parts, supplies, and accessories.
●

Order directly from HP

●

Order through service or support providers

●

Order directly through the embedded Web server (for printers that are connected to a network)

●

Order directly through the HP Easy Printer Care software

Order directly from HP
You can obtain the following items directly from HP:
●

Replacement parts: To order replacement parts in the U.S., go to www.hp.com/go/hpparts/.
Outside the United States, order parts by contacting your local authorized HP service center.

●

Supplies and accessories: To order supplies in the U.S., go to www.hp.com/go/ljsupplies. To
order supplies and accessories worldwide, go to www.hp.com/ghp/buyonline.html.

Order through service or support providers
To order a part or accessory, contact an HP-authorized service or support provider.

Order directly through the embedded Web server (for printers that are
connected to a network)
Use the following steps to order printing supplies directly through the embedded Web server.
1.

In the Web browser on the computer, type the IP address or host name of the device. The status
window opens.

2.

In the Other links area, double-click Order Supplies. This provides a URL for a site from which
you can purchase consumables.

3.

Select the part numbers that you want to order, and follow the instructions on the screen.

Order directly through the HP Easy Printer Care software
HP Easy Printer Care software is a printer management tool designed to make printer configuration,
monitoring, supplies ordering, troubleshooting, and updating as simple and efficient as possible. For
more information about HP Easy Printer Care software, go to www.hp.com/easyprintercare.
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Part numbers
Ordering information and availability might change during the life of the product.

Accessories
Item

Description

Part number

HP 3-bin Stapler/Stacker Accessory

3-bin stapler/stacker with output
accessory bridge unit

CC517A

HP 3-bin Stapler/Stacker or HP Booklet
Maker/Finisher staple cartridge (upper
cartridge on HP Booklet Maker/Finisher)

5000-staple replacement cartridge

C8091A

HP Booklet Maker/Finisher Accessory

Booklet maker finisher with output
accessory bridge unit

CC516A

HP Booklet Maker/Finisher saddle-stitch
staple cartridge (lower cartridge)

2000-staple replacement cartridge
(quantity of 2)

CC383A

HP LaserJet analog fax accessory 300

Provides fax capability for the product.
This is included with the HP Color
LaserJet CM6040f MFP model.

Q3701A

Item

Description

Part number

HP Color LaserJet black print cartridge

19,500-page black cartridge

CB390A

HP Color LaserJet cyan print cartridge

21,000-page cyan cartridge

CB381A

HP Color LaserJet yellow print cartridge

21,000-page yellow cartridge

CB382A

HP Color LaserJet magenta print
cartridge

21,000-page magenta cartridge

CB383A

Item

Description

Part number

HP Color LaserJet black image drum

35,000-page black image drum

CB384A

HP Color LaserJet cyan image drum

35,000-page cyan image drum

CB385A

HP Color LaserJet yellow image drum

35,000-page yellow image drum

CB386A

Print cartridges

Image drums

HP Color LaserJet magenta image drum 35,000-page magenta image drum

CB387A

Maintenance kits
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Item

Description

Part number

Image fuser kit

110 volt

CB457A

Part numbers 281

Item

Description

Part number

Image fuser kit

220 volt

CB458A

Roller kit

CB459A

Transfer kit

CB463A

ADF roller kit

CE487A

Memory
Item

Description

Part number

200-pin DDR memory DIMM (dual inline
memory module)

128 MB

Q7557A

256 MB

Q7558A

Item

Description

Part number

Enhanced I/O (EIO) card

HP Jetdirect 635n IPv6/IPsec Print
Server

J7961G

USB cable

2-meter standard USB-compatible
device connector

C6518A

Boosts the ability of the product to handle
large or complex print jobs.

Cables and interfaces
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Hewlett-Packard limited warranty statement
HP PRODUCT

DURATION OF LIMITED WARRANTY

HP Color LaserJet CM6030 Series MFP

One-year limited warranty

HP Color LaserJet CM6040 Series MFP

One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace products
which prove to be defective. Replacement products may be either new or equivalent in performance to
new.
HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when properly
installed and used. If HP receives notice of such defects during the warranty period, HP will replace
software which does not execute its programming instructions due to such defects.
HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled
to a refund of the purchase price upon prompt return of the product.
HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.
Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration,
(b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse,
(d) operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.
HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.
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THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Print cartridge limited warranty statement
This HP product is warranted to be free from defects in materials and workmanship.
This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.
To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Color LaserJet Fuser Kit, Transfer Kit, and Roller Kit
Limited Warranty Statement
This HP product is warranted to be free from defects in materials and workmanship until the printer
provides a low-life indicator on the control panel.
This warranty does not apply to products that (a) have been refurbished, remanufactured or tampered
with in any way, (b) experience problems resulting from misuse, improper storage, or operation outside
of the published environmental specifications for the printer product or (c) exhibit wear from ordinary
use.
To obtain warranty service, please return the product to place of purchase (with a written description of
the problem) or contact HP customer support. At HP’s option, HP will either replace products that prove
to be defective or refund your purchase price.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Customer self repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.
Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Customer support
Get telephone support, free during your warranty period, for
your country/region

Country/region phone numbers are on the flyer that was in the
box with your product or at www.hp.com/support/.

Have the product name, serial number, date of purchase, and
problem description ready.
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Get 24-hour Internet support

www.hp.com/support/cljcm6030mfp or www.hp.com/support/
cljcm6040mfp

Get support for products used with a Macintosh computer

www.hp.com/go/macosx

Download software utilities, drivers, and electronic information

www.hp.com/go/cljcm6030mfp_software or www.hp.com/go/
cljcm6040mfp_software

Order supplies and paper

www.hp.com/go/suresupply

Order genuine HP parts or accessories

www.hp.com/buy/parts

Order additional HP service or maintenance agreements

www.hp.com/go/carepack
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Availability of support and service
Around the world, HP provides a variety of service and support options for purchase. Availability of these
programs will vary depending upon your location.
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HP maintenance agreements
HP has several types of maintenance agreements that meet a wide range of support needs.
Maintenance agreements are not part of the standard warranty. Support services may vary by area.
Check with your local HP dealer to determine the services available to you.

On-site service agreements
To provide you with the level of support best suited to your needs, HP has on-site service agreements
with three response times:

Priority onsite service
This agreement provides 4-hour service response to your site for calls made during normal HP business
hours.

Next-day onsite service
This agreement provides support by the next working day following a service request. Extended
coverage hours and extended travel beyond HP’s designated service zones are available on most onsite agreements (for additional charges).

Weekly (volume) on-site service
This agreement provides scheduled weekly on-site visits for organizations with many HP products. This
agreement is designated for sites using 25 or more workstation products, including printers, plotters,
computers, and disk drives.

ENWW

HP maintenance agreements 291

292 Appendix B Service and support

ENWW

C

ENWW

Product specifications

●

Physical specifications

●

Electrical specifications

●

Acoustic specifications

●

Environmental specifications

293

Physical specifications
Table C-1 Product dimensions

1

Product

Height

Depth

Width

Weight1

HP Color LaserJet CM6030 MFP

1194 mm (47 in)

635 mm (25 in)

704 mm (27.7 in)

140 kg (308 lb)

HP Color LaserJet CM6030f MFP

1194 mm (47 in)

635 mm (25 in)

704 mm (27.7 in)

145 kg (319 lb)

HP Color LaserJet CM6040 MFP

1194 mm (47 in)

635 mm (25 in)

704 mm (27.7 in)

140 kg (308 lb)

HP Color LaserJet CM6040f MFP

1194 mm (47 in)

635 mm (25 in)

704 mm (27.7 in)

145 kg (319 lb)

Without print cartridge

Table C-2 Product dimensions, with all doors and trays fully opened
Product

Height

Depth

Width

HP Color LaserJet CM6030 MFP

1524 mm (60 in)

1079.5 mm (42.5 in)

983 mm (38.7 in)

HP Color LaserJet CM6030f MFP

1524 mm (60 in)

1079.5 mm (42.5 in)

983 mm (38.7 in)

HP Color LaserJet CM6040 MFP

1524 mm (60 in)

1079.5 mm (42.5 in)

983 mm (38.7 in)

HP Color LaserJet CM6040f MFP

1524 mm (60 in)

1079.5 mm (42.5 in)

983 mm (38.7 in)
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Electrical specifications
WARNING! Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This can damage the product and void the product warranty.
Table C-3 Power requirements (HP Color LaserJet CM6030 and CM6040 MFP Series)
Specification

110-volt models

220-volt models

Power requirements

100 to 127 volts (± 10%)

220 to 240 volts (± 10%)

50/60 Hz (± 2 Hz)

50/60 Hz (± 2 Hz)

10.5 A

5.5 A

Rated current

Table C-4 Power consumption HP Color LaserJet CM6030 and CM6040 MFP Series (average, in watts)
Product model

Printing

Ready

Sleep

Off

HP Color LaserJet
CM6030 MFP

1265 W

251.7 W

26.3 W

0.72 W

HP Color LaserJet
CM6030f MFP

1265 W

251.7 W

26.5 W

0.72 W

HP Color LaserJet
CM6040 MFP

1265 W

251.7 W

26.3 W

0.72 W

HP Color LaserJet
CM6040f MFP

1265 W

251.7 W

21.5 W

0.72 W

Values subject to change. See www.hp.com/support/cljcm6030mfp or www.hp.com/support/
cljcm6040mfp for current information.
HP Color LaserJet CM6030 and CM6040 MFP Series printing and copying speeds are 40 ppm for Letter
and A4 sizes.
Default time from Ready mode to Sleep mode = 1 minutes.
Recovery time from Sleep mode = less than 20 seconds
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Acoustic specifications
Table C-5 Sound power and pressure level1 (HP Color LaserJet CM6030 and CM6040 MFP Series)

1

2

Sound power level

Declared per ISO 9296

Printing1

LWAd= 6.9 Bels (A) [69 dB(A)]

Copying2

LWAd= 7.3 Bels (A) [73 dB(A)]

Ready

LWAd= 5.8 Bels (A) [58 dB(A)]

Sound pressure level

Declared per ISO 9296

Printing1

LpAm=53 dB (A)

Copying2

LpAm=57 dB (A)

Ready

LpAm=40 dB (A)

Values subject to change. See www.hp.com/support/cljcm6030mfp or www.hp.com/support/cljcm6040mfp for current
information.
Configuration tested (HP Color LaserJet CM6030 and CM6040 MFP Series) Base model, simplex copying from ADF with A4
paper size.)
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Environmental condition

Recommended

Allowed

Storage/standby

Temperature (product and
print cartridge)

17° to 25°C (62.6° to 77°F)

10° to 30°C (50° to 86°F)

0° to 35°C (32° to 95°F)

Relative humidity

30% to 70% relative humidity
(RH)

10% to 80% RH

5% to 95%

Altitude

N/A

0 meters (0 feet) to 2500
meters (8000 feet)

N/A
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Compliance with FCC regulations
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.
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Declaration of Conformity
Declaration of Conformity
according to ISO/IEC 17050–1 and EN 17050–1
Manufacturer's Name:
Manufacturer's Address:

Hewlett-Packard Company
DoC#: BOISB-0601–01–rel.2.0
11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares that the product
Product Name:

HP Color LaserJet CM6030, CM6040 MFP series

Accessories

CB473A – 1x500-sheet input tray/stand
CB474A – 3x500-sheet input tray/stand
CC516A – Booklet Maker
CC517A - 3-Bin Stapler/Stacker
BOISB-0601-01
ALL

Regulatory Model Number:2)
Product Options:

Toner Cartridges/Drums: CB390A, CB381A, CB382A, CB383A, CB384A, CB385A, CB386A,
CB387A
conforms to the following Product Specifications:
Safety:

IEC 60950-1:2001 / EN60950-1: 2001 + A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC:

CISPR 22:2005 / EN 55022:2006 – Class A1)
EN 61000-3-2:2000 +A2
EN 61000-3-3:1995 + A1
EN 55024:1998+A1 + A2
FCC Title 47 CFR, Part 15 Class A / ICES-003, Issue 4
GB9254-1998, GB17625.1–2003

Supplementary Information:
The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, and
carries the CE-Marking accordingly.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.
2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name
or the product number(s).
Boise, Idaho , USA
February 1, 2008
For regulatory topics only:
European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe, Herrenberger Straße 140, D-71034 Böblingen, Germany, (FAX: +49-7031-14-3143) www.hp.com/go/
certificates
USA Contact:
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Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho 83707-0015, USA,
(Phone: 208-396-6000)
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Declaration of Conformity
Declaration of Conformity
according to ISO/IEC 17050–1 and EN 17050–1
Manufacturer's Name:
Manufacturer's Address:

Hewlett-Packard Company
DoC#: BOISB-0601–02–rel.2.0
11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares that the product
Product Name:

HP Color LaserJet CM6030f,CM6040f MFP series

Accessories

CB473A – 1x500-sheet input tray/stand
CB474A – 3x500-sheet input tray/stand
CC516A – Booklet Maker
CC517A - 3-Bin Stapler/Stacker
BOISB-0308-00 – Fax Module
BOISB-0601-02
ALL

Regulatory Model Number:2)
Product Options:

Toner Cartridges/Drums: CB390A, CB381A, CB382A, CB383A, CB384A, CB385A, CB386A,
CB387A
conforms to the following Product Specifications:
Safety:

IEC 60950-1:2001 / EN60950-1: 2001 + A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC:

CISPR 22:2005 / EN 55022:2006 – Class A1)
EN 61000-3-2:2000 +A2
EN 61000-3-3:1995 + A1
EN 55024:1998+A1 + A2
FCC Title 47 CFR, Part 15 Class A / ICES-003, Issue 4
GB9254-1998, GB17625.1–2003

Telecom

ES 203 021; FCC Title 47 CFR, Part 684)

Supplementary Information:
The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, and the
R&TTE Directive 1999/5/EC (Annex II), and carries the CE-Marking accordingly.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.
2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name
or the product number(s).
3) All worldwide modular approvals for analog fax accessory obtained by Hewlett-Packard under the regulatory model number BOISB-0601-02
incorporate the Multi-Tech Systems MT5634SMI Socket Modem Module.
4) Telecom approvals and standards appropriate for the target countries/regions have been applied to this product, in addition to those listed
above.
Boise, Idaho , USA
February 1, 2008
For regulatory topics only:
European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe, Herrenberger Straße 140, D-71034 Böblingen, Germany, (FAX: +49-7031-14-3143) www.hp.com/go/
certificates
USA Contact:

Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho 83707-0015, USA,
(Phone: 208-396-6000)
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Environmental product stewardship program
Protecting the environment
Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready and Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product, see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:
www.hp.com/go/energystar

Toner consumption
EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use
This product’s optional automatic duplex feature (two-sided printing) and N-up printing (multiple pages
printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet
Partners. Multilingual program information and instructions are included in every new HP LaserJet print
cartridge and supplies package. You help reduce the toll on the environment further when you return
multiple cartridges together rather than separately.
HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use, and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Please note that the cartridge will not be returned to you. Thank you for being
environmentally responsible!
NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges, or warranty
returns. For information about recycling your HP inkjet cartridges, please go to www.hp.com/recycle.
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Return and recycling instructions
United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.
Multiple returns (more than one cartridge)
1.

Package each HP LaserJet print cartridge in its original box and bag.

2.

Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3.

Use a single pre-paid shipping label.

OR
1.

Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2.

Use a single pre-paid shipping label.

Single returns
1.

Package the HP LaserJet print cartridge in its original bag and box.

2.

Place the shipping label on the front of the box.

Shipping
For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit www.ups.com. If you are returning via USPS label, give the package
to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For more information, or to
order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call 1-800-340-2445.
Requested UPS pickup will be charged normal pickup rates. Information subject to change without
notice.

Non-U.S. returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit www.hp.com/
recycle. Select your country/region for information on how to return your HP LaserJet printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product contains a battery that may require special handling at end-of-life.
The battery contained in this product includes:
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Type

Carbon monofluoride lithium battery

Weight

0.8 grams

Location

Formatter board

User removable

No

This product contains mercury in the fluorescent lamp of the control panel liquid crystal display that
might require special handling at end-of-life.
For recycling information you can visit www.hp.com/go/recycle or contact your local authorities or the
Electronics Industry Alliance (www.eiae.org).

Disposal of waste equipment by users in private households in the
European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.
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For more information
To obtain information about these environmental topics:
●

Product environmental profile sheet for this and many related HP products

●

HP’s commitment to the environment

●

HP’s environmental management system

●

HP’s end-of-life product return and recycling program

●

Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Certificate of volatility
This is a statement regarding the volatility of customer data stored in memory. It also outlines how to
erase secure data from the device.

Types of memory
Volatile memory
The MFP utilizes volatile memory (64MB on the board and 256MB installed, for a total of 320MB) to
store customer data during the printing and copying process. When the MFP is powered off, this volatile
memory is erased.

Non-volatile memory
The MFP utilizes non-volatile memory (EEPROM) to store system control data and user preference
settings. No customer print or copy data is stored in non-volatile memory. This non-volatile memory can
be cleared and restored to factory defaults by performing a Cold Reset or Restore Factory Defaults from
the control panel.

Hard-disk-drive memory
The MFP contains an internal hard disk drive (40GB or larger) that may retain data after the MFP is
powered off. The MFP also may contain additional optional compact flash storage, or an external EIO
hard disk. Data stored in these devices may be from incoming/outgoing fax or email files, stored copy
or print jobs, fax or email address books, or third-party solutions. Some of this data can be erased from
the control panel of the MFP, but most must be erased using the Secure Storage Erase features
available within HP Web Jetadmin. Secure Storage Erase features comply with U.S. Department of
Defense (DOD) specification 5220–22.M.
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Safety statements
Laser safety
The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.
WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class A requirements.
« Conforme à la classe A des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord statement (Japan)

EMI statement (Korea)
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EMI statement (Taiwan)

General telecom statement
The HP Color LaserJet CM6030f MFP and CM6040f MFP models have the HP LaserJet Analog Fax
Accessory 300 already installed to provide communication to the public switch telephone network
(PSTN) for fax functionality. See the HP LaserJet Analog Fax Accessory 300 User Guide for all
regulatory approval information and regulatory notices associated with the fax functionality and that
device.

Laser statement for Finland
Luokan 1 laserlaite
Klass 1 Laser Apparat
HP LaserJet CM6030, CM6040, CM6030f, CM6040f, laserkirjoitin on käyttäjän kannalta turvallinen
luokan 1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (1994) mukaisesti.
VAROITUS !
Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.
VARNING !
Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.
HUOLTO
HP LaserJet CM6030, CM6040, CM6030f, CM6040f - kirjoittimen sisällä ei ole käyttäjän huollettavissa
olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö.
Tällaiseksi huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai
muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan
suorittaa ilman erikoistyökaluja.
VARO !
Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.
VARNING !
Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
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Substances Table (China)
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Index

Symbols/Numerics
3-bin mailbox
capacity 5
selecting 117
specifications, physical 293
3-bin stapler/stacker
features 117
500-sheet trays
models including 2
specifications, physical 293
A
accessories
3-bin stapler/stacker 117
booklet-maker finisher 117
optional output 117
ordering 280
part numbers 281
accounting hardware 188
acoustic specifications 296
activity log, fax 179
address books, e-mail
adding addresses 169
auto-complete function 168
clearing 59
deleting addresses 169
importing 185
LDAP support 164
recipient lists 168
recipient lists, creating 168
address, printer
Macintosh,
troubleshooting 276
ADF
capacity 5
clean delivery system 212
maintenance kit 216
make copies from 154
sizes supported 167
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ADF output bin
capacity 5
selecting 117
Administration menu, control
panel 17
advanced printing options
Windows 144
agreements, maintenance 291
alerts, e-mail 76
alternative letterhead mode 144
anticounterfeit supplies 193
AppleTalk settings 33
Attention light
locating 14
automatic media sensing 114
automatic two-sided printing path
copying documents 156
B
billing codes report, fax 179
bins
capacities 5
locating 8
selecting 117
blank pages, troubleshooting 272
blocked fax list, printing 179
Bonjour Settings 76
booklet maker
configuring 121
features 117
use 119
walkaround 119
books
copying 160
BOOTP 91
both sides, copying 156
both sides, printing on
Macintosh settings 76
browser requirements
embedded Web server 183

buttons, control panel
locating 14
touchscreen 16
C
cabinet/stand
specifications, physical 293
cable, USB
part number 282
cables
USB, troubleshooting 272
calibrate scanner 217
calibrating scanner 53
call report, fax 179
Canadian DOC regulations 308
cancel
copy jobs 162
print 140
cancel a print request 140
capacity
3-bin mailbox 5
ADF 5
output bins 5
stapler/stacker 5
cartridges
management menu 29
non-HP 193
ordering through embedded
Web server 186
recycling 303
replace 194
storage 193
warranty 286
cartridges, print
Macintosh status 80
part numbers 281
clean
about 212, 214
ADF delivery system 212
ADF rollers 214

Index 311

fuser 267
glass 212
outside of product 212
touchscreen 212
clean page, printing 267
clock
set 191
collating copies 159
color
adjusting 146
advanced use 151
CMYK ink set emulation 151
edge control 146
four-color printing 151
halftone options 146
HP ImageREt 4800 151
manage 145
match 149
neutral grays 147
Pantone® matching 150
print color samples 149
print in grayscale 147
printed vs. monitor 149
restrict use 147
sample book matching 149
sRGB 151
using 145
color options 143
Color tab settings 80
colored text
print as black 144
configuration page
Information menu 18
Macintosh 76
printing 178
configurations, models 2
configure
trays 114
connect product 84
connectivity
network utilities 94
USB 84
connectivity features 5
contracts, maintenance 291
control panel
Administration menu 17
buttons 14
clean touchscreen 212
copy-screen 154
e-mail screen 166

312 Index

E-mail Setup menu 41
Fax Setup menu 38
help 16
Home screen 15
Information menu 18
Initial Setup menu 31
layout 14
lights 14
locating 8
locking menus 190
Management menu 29
messages, types of 226
Resets menu 59
Send Setup menu 41
Service menu 60
settings 66, 74
Time/Scheduling menu 27
touchscreen buttons 16
controlling print jobs 115
copies, number of
Windows 144
Copitrak devices 188
copy
cancel 162
control-panel navigation 154
copy screen 154
from document feeder 154
from glass 154
Job Mode 161
multiple originals 161
photos and books 160
set options 154
settings 155
two-sided documents 156
copying
books 160
collating 159
features 6
quality, troubleshooting 264
speed specifications 4
counterfeit supplies 193
cover pages 77, 141
covers, locating 8
custom-size paper settings
Macintosh 77
customer support
embedded Web server
links 186
HP Printer Utility pages 76

maintenance agreements 291
online 289
D
Data light
locating 14
date, set 191
date, setting 27
Declaration of Conformity 301,
302
default job options menu 20
default settings
Resets menu 59
defects, repeating 264
delay, sleep 124
density
settings 76
Device Behavior menu 42
device discovery 89
device status
Macintosh Services tab 80
DHCP 91
diagnostics
networks 34
digital faxing 176
digital sending
about 164, 167
address books 168, 169
configure e-mail 164
control-panel settings 166
embedded Web server
settings 185
folders 171
job settings 170
LDAP support 164
loading documents 167
recipient lists 168
sending documents 167
Setup menu 41
SMTP support 164
validating gateway
addresses 273
workflow 172
Digital Sending tab, embedded
Web server 185
DIMMs (dual inline memory
modules)
installing 201
part numbers 282
Disk Erase feature 189
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DLC/LLC settings 33
document feeder
copying two-sided
documents 156
document feeder kit,
replacing 216
double-sided copying 156
double-sided printing
Macintosh settings 76
dpi, settings 76
drivers
Macintosh settings 77
Macintosh,
troubleshooting 276
presets (Macintosh) 77
settings 66, 67, 74
shortcuts (Windows) 141
supported 63
universal 64
Windows, opening 141
duplex
copying documents 156
duplex printing
Windows 142
duplex printing accessory
locating 8
specifications, physical 293
duplexer
Macintosh settings 76
duty cycle 4
E
e-mail alerts 76
Easy Printer Care 180
economy settings
sleep and wake 124
EIO cards
installing 205
part number 282
electrical specifications 295
embedded Web server
assigning a password 188
Digital Sending tab 185
features 183
energy specifications 295
Enhanced I/O card
part number 282
envelope feeder
specifications, physical 293
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envelopes
jams 261
loading in tray 1 103
environment, specifications 297
Environmental Product
Stewardship Program 303
EPS files, troubleshooting 277
Equitrac devices 188
erasing hard disk 189
Error button, control panel
touchscreen 16
error messages
control panel 227
e-mail alerts 76
types of 226
Ethernet cards 5
European Union, waste
disposal 305
EWS
features 183
Explorer, versions supported
embedded Web server 183
extended warranty 291
e-mail
about 164, 167
address books 168, 169
auto-complete function 168
configure 164
control-panel settings 166
embedded Web server
settings 185
job settings 170
LDAP support 164
loading documents 167
problem solving 273
recipient lists 168
scan 164
sending documents 167
SMTP support 164
validating gateway
addresses 273
E-mail Setup menu 41
F
fax accessory
analog fax 174
configure features 174
connecting phone line 174
digital fax 176

printing schedule 28
solve problems 273
Fax Activity Log
clearing 59
fax reports, printing 18, 179
Fax Setup menu 38
faxing
analog 174
faxing, digital 176
features 2, 4
file directory, printing 179
File Upload, Macintosh 76
Finnish laser safety
statement 309
Firmware Update, Macintosh 76
firmware, upgrading 218
first page
use different paper 77
folders
sending to 171
fonts
EPS files, troubleshooting 277
included 4
list, printing 19, 179
Upload Macintosh 76
Foreign Interface Harness
(FIH) 10, 188
formatter cover, locating 8
formatter lights 263
fraud hotline 193
FTP, sending to 172
fuser
clean 267
G
gateways
configure 164
configuring 165
testing 165
validating addresses 273
glass
clean 212
sizes supported 167
graphical display, control
panel 14
grayscale printing 147
H
hard disk
erasing

189

Index 313

heartbeat LED 263
held jobs 129
Help button, control panel
touchscreen 16
help, control panel 16
Home button, control panel
touchscreen 16
Home screen, control panel 15
HP Customer Care 289
HP Easy Printer Care
description 69
downloading 69
opening 180
options 180
supported browsers 69
supported operating
systems 69
using 180
HP fraud hotline 193
HP Jetdirect print server
firmware updates 221
installing 205
lights 263
models including 2
settings 31
HP Jetdirect print servers
installing 205
HP Printer Utility 75, 76
HP Printer Utility, Macintosh 75
HP Universal Print Driver 64
HP Web Jetadmin
firmware updates 220
HP-UX software 71
humidity requirements 297
I
I/O configuration
network configuration 90
settings 31
image drums
part numbers 281
replace 198
image fuser kit, 110 volt
part number 281
image fuser kit, 220 volt
part number 282
Information menu 18
information pages 178
Information tab, embedded Web
server 184

314 Index

Initial Setup menu 31
installers, Windows 94
installing
EIO cards 205
interface ports
included 5
locating 10
Internet Explorer, versions
supported
embedded Web server 183
Internet fax 176
Internet protocol (IP) 90
IP address
BOOTP 91
changing 92
input 92
Macintosh,
troubleshooting 276
overview 90
IP addressing 89
IPX/SPX setting 33
J
jam-access lever, locating 8
jams
clearing 229
common causes of 228
envelopes 261
recovery 257
Japanese VCCI statement 308
Jetadmin
firmware updates 220
Jetadmin, HP Web 69, 187
Jetdirect print server
firmware updates 221
installing 205
lights 263
models including 2
settings 31
Job Aids 7
Job Mode, copying 161
job storage
accessing 129
features 129
Macintosh settings 80
personal 131
proof and hold 129
QuickCopy 132
settings 29

jobs
Macintosh settings 76
K
keys, control panel
locating 14
touchscreen 16
Korean EMI statement 308
L
LAN fax 176
LAN-connector 5
landscape orientation
setting, Windows 142
languages, printer 4
laser safety statements 308, 309
LDAP servers
connect to 164
embedded Web server
settings 185
validating gateway
addresses 273
letterhead
load 108
letterhead paper, loading 144
lights
control panel 14
formatter 263
link speed settings 36
Linux software 71
load media
configuring 103
loading
documents, sizes
supported 167
scanner glass 167
sizes supported 167
tray 1 103
trays 2, 3, 4 104
Lock Resources, Macintosh 76
locking
control panel menus 190
M
Macintosh
AppleTalk settings 33
driver settings 74, 77
drivers, troubleshooting 276
HP Printer Utility 75
problems,
troubleshooting 276
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removing software 74
resize documents 77
software 75
software components 94
staple options 79
support 289
supported operating
systems 74
USB card,
troubleshooting 277
Macintosh driver settings
custom-size paper 77
Job Storage 80
Services tab 80
watermarks 78
mailbox, 3-bin
capacity 5
selecting 117
specifications, physical 293
maintenance agreements 291
maintenance kit 281
manage
EPC 180
EWS 183
information pages 178
supplies 193
Management menu 29
Material Safety Data Sheet
(MSDS) 305
Media 95
media
custom-size, Macintosh
settings 77
first page 77
loading tray 2 107
loading tray 2, 3, and 4 106
loading tray 2, 3, or 4 104
pages per sheet 78
stapler support 126
supported sizes 97
memory
enabling 204
features 4
included 2, 75
part numbers 282
Menu button 14
menu map
Information menu 18
printing 178
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menus, control panel
Administration 17
E-mail Setup 41
Fax Setup 38
Information 18
Initial Setup 31
locking 190
Management 29
Resets 59
Send Setup 41
Service 60
Time/Scheduling 27
messages
e-mail alerts 76
types of 226
models 2
monthly duty cycle 4
multiple pages per sheet
Windows 142

print servers included 2
protocol configuration page,
printing 37
protocols supported 89
security 34
SMTP servers 164
subnet mask 92
subnets 91
TCP/IP 90
TCP/IP parameters 92
TCP/IP settings 31
testing SMTP settings 165
Transmission Control Protocol
(TCP) 90
troubleshooting printing 274
validating gateway
addresses 273
noise specifications 296
non-HP supplies 193

N
n-up printing
Windows 142
Netscape Navigator, versions
supported
embedded Web server 183
network
connection 85
Network Folder, scan to 171
Networking tab, embedded Web
server 186
networks
AppleTalk settings 33
configuring 90
configuring gateway
addresses 165
connectivity features 5
default gateway 93
device discovery 89
DHCP 91
diagnostics 34
DLC/LLC settings 33
gateways 91
HP Web Jetadmin 187
installing EIO cards 205
Internet Protocol (IP) 90
IP address 89, 90, 92
IPX/SPX settings 33
link speed settings 36
Macintosh settings 76

O
on/off switch, locating 8
online help, control panel 16
online support 289
operating environment
specifications 297
operating systems supported 62,
74
optional output accessories 117
ordering
part numbers for 281
supplies and accessories 280
supplies through embedded
Web server 186
orientation
setting, Windows 142
outdoor signs
printing 137
output bins
accessories 117
capacities 5
locating 8
selecting 117
selecting, Windows 142
standard 117
output quality
troubleshooting 264
P
page order, changing 144
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pages
blank 272
not printing 272
printing slowly 272
pages per minute 4
pages per sheet
Windows 142
paper
covers, using different
paper 141
custom size, selecting 141
custom-size, Macintosh
settings 77
first and last pages, using
different paper 141
first page 77
load 103
pages per sheet 78
selecting 116
source 115
stapler support 126
supported sizes 97
type 100, 116
type and size 116
type, selecting 141
paper jams
ADF 252
parallel port
locating 10
part numbers
accessories 281
image drums 281
memory 282
print cartridges 281
parts
order 281
pausing a print request 140
PCL drivers
universal 64
personal jobs 131
phone line, connecting fax
accessory 174
photos
copying 160
improving print quality 141
loading 167
printing 135
removing red eye 141
physical specifications 293
PINs, personal jobs 131

316 Index

portrait orientation
setting, Windows 142
ports
included 5
locating 10
troubleshooting
Macintosh 277
PostScript Printer Description
(PPD) files
included 75
power
specifications 295
troubleshooting 224
power switch, locating 8
PPDs
included 75
pre-printed paper
load 108
pre-punched paper
load 108
presets (Macintosh) 77
print cartridge
managing 193
print cartridges
Macintosh status 80
management menu 29
non-HP 193
ordering through embedded
Web server 186
part numbers 281
recycling 303
replacing 195
storage 193
warranty 286
print drivers
Windows 141
print features
paper quality options 141
print media
loading in tray 1 103
supported sizes 97
print on both sides
Windows 142
print paper
for color printing 151
types 100
print quality
menu 49
troubleshooting 264

print server card
installing 205
print tasks 139
printer languages 4
printing
outdoor signs 137
output bin, selecting 117
speed specifications 4
troubleshooting 272
weatherproof maps 137
printing from tray 2, 3, or 4 104
priority onsite service 291
priority, settings 66, 74
private jobs
cancel 140
Windows 142
problem-solving
e-mail alerts 76
Error button, control panel
touchscreen 16
e-mail 273
jams 228
messages, types of 226
networks 34
paper handling 258
processor speed 4
product info 1
product status
HP Easy Printer Care 180
proof and hold
Windows 142
proof and hold jobs 129
protocol configuration page,
printing 37
protocols, network 89
PS Emulation drivers 63
Q
quality
troubleshooting 264
Quick Reference Job Aids 7
Quick Sets 141
R
Ready light
locating 14
real-time clock 191
recipient lists 168
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recycling
HP printing supplies returns and
environmental program 304
red eye, removing 141
regulatory statements
Declaration of
Conformity 301, 302
environmental product
stewardship program 303
remote firmware update
(RFU) 218
removing Macintosh software 74
repeating defects,
troubleshooting 264
replace
image drums 198
memory 201
supplies 194
reset button 14
Resets menu, control panel 59
resize documents
Macintosh 77
Windows 142
resolution
settings 76
specifications 4
troubleshooting quality 264
Resolution Enhancement
technology (REt) 76
resolution, adjusting 141
restore factory settings 225
REt (Resolution Enhancement
technology) 76
retention, job
accessing 129
features 129
personal 131
proof and hold 129
QuickCopy 132
rollers
clean ADF 214
ruler, repetitive defect 264
S
safety statements 308, 309
scale documents
Macintosh 77
Windows 142
scanner calibration 53, 217
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scanner glass
clean 212
scanning
speed specifications 4
scanning to e-mail
about 164, 167
address books 168, 169
configure 164
control-panel settings 166
embedded Web server
settings 185
job settings 170
LDAP support 164
loading documents 167
recipient lists 168
sending documents 167
settings 164
SMTP support 164
validating addresses 273
scanning to folder 171
scanning to workflow 172
Secure Disk Erase 189
security
EWS 188
Foreign Interface Harness
(FIH) 188
locking control panel
menus 190
secure disk erase 189
settings 34
security features 6
Send Setup menu 41
Send to Folder 171
Send to Workflow 172
sending to e-mail
about 164, 167
address books 168, 169
embedded Web server
settings 185
job settings 170
LDAP support 164
loading documents 167
recipient lists 168
sending documents 167
settings 166
SMTP support 164
validating gateway
addresses 273
separator page
Windows 142

serial number
locate 10
service
agreements 291
Service menu, control panel 60
Services tab
Macintosh 80
settings
driver presets (Macintosh) 77
drivers 67, 74
priority 66, 74
restore factory 225
Settings tab, embedded Web
server 184
shortcuts 141
Sleep button 14
Sleep mode
settings 27, 29
sleep settings
delay 124
power specifications 295
wake time 124
SMTP servers
configuring gateway
address 165
connect to 164
testing 165
validating gateway
addresses 273
software
embedded Web server 69
HP Easy Printer Care 69,
180
HP Printer Utility 75
HP Web Jetadmin 69
Macintosh 75, 94
settings 66, 74
supported operating
systems 62, 74
uninstalling Macintosh 74
Windows 62, 94
Solaris software 71
space requirements 293
special media
guidelines 102
special paper
guidelines 102
specifications
acoustic 296
electrical 295
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features 4
operating environment 297
physical 293
speed dial list, printing 179
speed specifications 4
standard output bin
capacity 5
locating 8
selecting 117
staple cartridges
empty, stop or continue
settings 128
staple options
Macintosh 79
Windows 142
stapler
empty, stop or continue
settings 128
jams, clearing 253
paper sizes supported 126
using 128
stapler options
stapler/stacker 118
stapler/stacker
capacity 5
configuring 121
selecting 117
specifications, physical 293
staples
loading 207, 209
stapling jobs 128
Start button 14
Start button, control panel
touchscreen 16
status
embedded Web server 184
Home screen, control
panel 15
HP Easy Printer Care 180
HP Printer Utility,
Macintosh 76
Macintosh services tab 80
messages, types of 226
Status button 14
Stop button 14
Stop button, control panel
touchscreen 16
stopping a print request 140
storage cabinet
specifications, physical 293
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storage, job
accessing 129
features 129
Macintosh settings 76, 80
personal 131
proof and hold 129
QuickCopy 132
settings 29
store jobs
Windows 142
storing
print cartridges 193
subnet mask 91, 92
subnets 91
supplies
counterfeit 193
locating 194
management menu 29
non-HP 193
ordering 280
ordering through embedded
Web server 186
part numbers 281
recycling 303
replace 194
replacement intervals 195
replacing 194
Resets menu 59
status page, printing 178
status, viewing with embedded
Web server 184
status, viewing with HP Printer
Utility 76
supplies 193
supplies, status
HP Easy Printer Care 180
supply-status, Services tab
Macintosh 80
Windows 143
support
embedded Web server
links 186
HP Printer Utility pages 76
maintenance agreements 291
online 143, 289
supported media 97
supported utilities
for Macintosh 76
system requirements
embedded Web server 183

T
Taiwan EMI statement 309
TCP/IP
configuring 90
TCP/IP settings 31
TCP/IPv4 92
TCP/IPv6 93
technical support
maintenance agreements 291
online 289
temperature requirements 297
tests
networks 34
time, set 191
time, setting 27
Time/Scheduling menu, control
panel 27
timeout settings 31
toner
density setting 76
toner cartridges. See print
cartridges
top cover
locating 8
touchscreen, clean 212
Transmission Control Protocol
(TCP) 90
tray 1
locating 8
tray 2, 3, 4, 5
load 104
trays
automatic media sensing 114
configure 114
double-sided printing 79
included 2
load 103
Macintosh settings 76
select paper 115
specifications, physical 293
trays, status
HP Easy Printer Care 180
troubleshooting
blank pages 272
checklist 224
control panel messages 227
duplexing 262
EPS files 277
gateway addresses 273
jams 228
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Macintosh problems 276
menu 53
network printing 274
pages not printing 272
pages printing slowly 272
paper handling problems 258
quality 264
repeating defects 264
transparencies 260
USB cables 272
TrueType fonts included 4
two-sided copying 156
two-sided printing
Macintosh settings 76
Windows 142
typefaces
included 4
U
uninstalling Macintosh
software 74
universal print driver 64
UNIX software 71
upgrading firmware 218
usage page, printing 178
USB configuration 84
USB connection 84
USB port
troubleshooting 272
troubleshooting
Macintosh 277

Web browser requirements
embedded Web server 183
Web Jetadmin
firmware updates 220
Web sites
customer support 289
fraud reports 193
HP Web Jetadmin,
downloading 187
Macintosh customer
support 289
Material Safety Data Sheet
(MSDS) 305
ordering supplies 280
universal print driver 64
Windows
driver settings 67
drivers supported 63
software components 94
supported operating
systems 62
universal print driver 64
Windows 2000 fax 176
workflow, send to 172

V
validating gateway
addresses 273
voltage specifications 295
W
wake time, setting 27, 124
Warning button, control panel
touchscreen 16
warranty
Customer self repair 288
extended 291
print cartridges 286
product 284
watermarks
Windows 142
weatherproof maps
printing 137
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